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OVERVIEW

Welcome

A sincere welcome to this module, AIN2601. Jim Rohn said the following:

“Learning is the beginning of wealth. Learning is the beginning of health. 
Learning is the beginning of spirituality. Searching and learning is where the 

miracle process all begins.”

We trust that you will fi nd studying the material for this module interesting and 
stimulating, and that you gain new knowledge, insights and practical skills that will 
benefi t your career and future studies.

We recognise the increasing impact of computer technology on the day-to-day 
business activities of accountants. The two modules (AIN1501 & AIN2601) combine 
theoretical knowledge and practical understanding of information systems in a 
business environment, especially the accounting environment.

Information technology is constantly changing, and it is your responsibility as a 
student to ensure – after the successful completion of this module – that you keep 
abreast of the latest developments in the relevant fi elds.

Knowledge is only meaningful if it is relevant and up to date. As Jack Nicholson 
once said:

“The minute that you’re not learning I believe you’re dead.”

Before tackling your studies, you need to note the following important information:

General objectives of this module
This module is primarily intended for students who are interested in qualifying as registered 
chartered accountants (SAICA) or management accountants (CIMA). This module will enable 
students to develop the necessary competencies prescribed by these professional bodies.

This module provides you with knowledge about the fundamental data and transaction 
processing principles needed to understand operating and accounting information systems 
(AISs).

The module will also equip you – in your capacity as user, designer and evaluator – with 
the skills to apply your theoretical knowledge of accounting information systems in a 
practical business context.

Pre-requisites
It is assumed that students have the following knowledge and understanding:

 •  They have reading and comprehension skills to enable them to read questions and case 
studies, comprehend the content thereof, and follow a logical thought process. Further, 
students must be capable of applying basic principles they have been exposed to in 
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the tutorial matter to questions or elementary case studies and formulate an opinion 
or recommendation, or draw a conclusion from this application.

 •  Students have knowledge of basic accounting concepts, principles and procedures 
as indicated by successful completion of the prerequisite module stipulated in the 
admission requirements.

 •  Knowledge of data processing and accounting information systems is essential, as 
indicated by successful completion of the prerequisite modules, as stated in the 
admission requirements.

 •  The ability to use peripheral computer devices such as a mouse, keyboard and printer 
is necessary.

 •  You should be able to demonstrate basic practical computer skills such as the installation 
of software, use of the internet and fi le management.

Computer access prerequisites
Students who register for this module must

 •  have access to the internet for at least 20 hours
 •  have access to a computer for at least 90 hours
 •  be allowed to install Pastel Partner educational software on the above-mentioned computer; 

and the computer must also adhere to the Pastel Partner hardware requirements for 
the operating system loaded on the computer

 •  have access to either a virtual or a physical printer (Cutepdf – free virtual printer software 
is recommended and available at www.cutepdf.com)

 •  have access to Microsoft Excel 2003, Microsoft Excel 2007 or Microsoft Excel 2010 or 
Open Offi ce Calc (Microsoft Excel Starter is not acceptable)

 •  have access to either WinZip or 7-Zip (7-Zip – free data compression software is 
recommended and available at www.7-zip.org)

Structure of this study guide and the module
The module is divided into two study guides with four distinctive parts, each containing 
one or more topics. Topics are the main study areas in the parts, and each topic is further 
subdivided into study units. You will fi nd the learning outcomes, which you are required to 
achieve for each topic in this study guide, stated at the beginning of each topic.

The parts of the module are set out below.

Part 1: Data management and utilisation

Explain the various concepts relating to the management and utilisation of data.

(Topic 1)

Part 1 builds on the foundation laid in AIN1501 (Accounting information systems) regarding 
the computerised information system process. It introduces you to the database environment, 
including different database models, database management systems and relational database 
terminology. This part concludes with a brief discussion of the application of databases in 
the accounting, auditing and general business environment.
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Part 2: Spreadsheets

Develop and create spreadsheets to solve problems in a business and accounting context.

(Topic 2)

This part equips you with skills to develop and create spreadsheets in order to solve 
problems in a business and accounting context using appropriate formats, formulas and 
functions. You will also gain an understanding of the risks and controls associated with 
spreadsheets.

Part 3: Transaction processing

Explain and apply fi nancial reporting structures and accounting software applications to 
accounting transaction processing cycles.

(Topics 3–6)

Topic 3 in part 3 explains accounting transaction-processing cycles in an information system 
environment. Topic 4 introduces you to the chart of accounts and staffi ng level requirements 
needed for fi nancial reporting. Topic 5 fi rstly focuses on the evaluation and selection of 
appropriate accounting information system, and secondly, on accounting information system 
security risks and controls. In the last topic (topic 6) in part 3, Pastel Partner accounting 
software is utilised to process transactions and retrieve fi nancial information.

Part 4: Management reporting systems

Explain management reporting systems.

(Topic 7)

Topic 7 elaborates on the importance of access to accurate and timely information and 
briefl y explains the role of management information systems and business intelligence 
software in the organisation’s fi nancial reporting and decision-making process. This topic 
concludes with an introduction to Extensible Business Reporting Language (XBRL) as a 
way to enhance reporting.
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Content: AIN2601 (diagram 1)
Diagram 1 below is a schematic representation of the content of the AIN2601 module.

AIN2601
Practical accounting data processing

Study guide 1 Study guide 2

Part 1

Data 
management and 

utilisation

Part 2

Spreadsheets

Part 4

Management 
reporting systems

Part 3

Transaction 
processing

Topic 1 

1 Data 
managment 
and 
utilisation

Topic 2  

2 Spreadsheets

Topic 4 

7 Management 
reporting 
systems

Topics 3 

3 Accounting 
cycles 

4 Financial 
reporting 
infrastructure

5 Accounting 
informtion 
system 
applications 

6 Pastel Partner  
accounting 
information 
system

Study material and resources
Prescribed study material

The prescribed study material for this module is as follows:

 •  AIN2601 – study guide 1 and study guide 2
 •  Masterskill: Pastel Partner manual and educational software
 •  tutorial letters issued during the semester

myUnisa resources

Please make use of myUnisa (https://my.unisa.ac.za) as it contains further resources to 
help you master this module. The following resources are available on myUnisa:

 •  these two study guides – AIN2601
 •  tutorial letters issued during the semester
 •  previous examination papers
 •  a discussion forum where problem areas are discussed
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 •  announcements
 •  other resources

Supplementary literature/additional reading

You can use the bibliography at the end of each of the two study guides for additional 
resources it you wish to read more about specifi c topics.

Assignments
The assignments, with the necessary instructions, are contained in Tutorial Letter 101. 
Please note that your assignment questions should be submitted for marking before or 
on the due dates.

It is in your own interest to answer and submit as many assignments as possible because

 •  they form an integral and vital part of your studies
 •  you will not be admitted to the examination without submitting the compulsory assignment 

01
 •  they will help you to prepare for the examination
 •  as indicated in Tutorial Letter 101, assignments are taken into account when calculating 

your year mark; the higher your year mark, the better chance you have of doing well 
in this module

Critical success factors
Our aim in designing these two study guides was to afford you the best possible opportunity 
to master the knowledge, skills and values required by the discipline and the demands 
of accounting practice. To discover what other support we offer you, please read Tutorial 
Letter 101, which you should have received by now.

To ensure that you are successful in your studies, we would advise you to do the following:

 •  Start as soon as possible. We have found that students who start early have time to 
refl ect on their studies and formulate their own informed opinions.

 •  Use your time sensibly.
 •  Work systematically through the contents of the study guides, Pastel Partner manual 

and other tutorial letters
 •  Set realistic goals.
 •  Believe in yourself.

We designed this module using the South African Qualifi cations Authority (SAQA) guidelines 
with regard to the notional hours (time you will need to work through the course material 
successfully). The average student will need at least 120 hours to read, practice and study 
all study material, do your assignments and prepare for and write the examination. We 
prepared a guideline time allocation table for you on the next page.

Research has shown that students who complete their assignments diligently, are more 
likely to pass the examinations than those who do the minimum.

You will not pass this module successfully if you only try to memorise detail. We suggest 
that you allow yourself enough time to read through the study material, use different 
techniques to summarise the contents, spend time refl ecting on the issues and principles 
involved and practise the required practical parts of this module on a computer.
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Very important
You must have access to a computer. The required practical skills can only be acquired 
by practically doing the work on a computer and not by simply reading the manuals.

Using the study guide
When commencing your studies, we recommend that you prepare a schedule that allocates 
time to each study unit, leaving suffi cient time for revision closer to the examination. The 
study programme provided below serves as guideline for your study programme for the 
semester.

When studying a new topic, we recommend that you

 •  read the learning outcomes and introductory paragraph of the topic in the study guide 
to familiarise yourself with the aim(s) of the topic

 •  study the topic in detail using the study guide as the primary reference to your study 
material

 •  prepare summaries of key concepts, defi nitions and important information in your study 
material

 •  complete the practical computer activities on a computer
 •  evaluate yourself continuously by working through the self-assessment activities provided 

in the study guide, Pastel Partner manual and tutorial letters.

Study programme guideline

Part Topic 
no. Topic Hours

1 1 Data management and utilisation 10
2 2 Spreadsheets 25

3

3 Accounting cycles 12
4 Financial reporting infrastructure 2
5 Accounting information system applications 2
6 Pastel Partner accounting information system 40

4 7 Management reporting systems 2
Assignments 25
Examination 2
Total number of hours 120

Teaching strategy
The focus of our teaching role is to facilitate your learning experiences towards achieving the 
specifi c learning outcomes. Furthermore, these learning experiences have been designed 
to enable you to master the learning content at a predetermined competence level.

Meaning of words
Throughout this module we communicate learning outcomes and self-assessment criteria 
phrased in terms of what you should be able to do. This process involves the use of action 
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words, which are typically verbs or phrases containing verbs, describing what the student 
is expected to do in the learning activity. Our objective is to ensure that the words we use 
to indicate a requirement clearly state what you have to do, and you should also ensure 
that you clearly understand the requirements conveyed by the range of words we will use 
in the study material for this module.

We list below (in alphabetical order) examples of some of the action words you will encounter 
in this module, together with their meanings for the purposes of this module.

Action word Description

Apply Demonstrate knowledge and understanding by using information in a 
practical sense; use where relevant or appropriate. Use in a practical 
way.

Calculate Ascertain by mathematical procedure/exact reckoning.

Compare Examine in order to observe resemblances, relationships and differences.

Complete Finish/add what is required.

Defi ne State precisely the meaning/scope/total character; make clear (especially 
the outline); give a concise description of the distinguishing features.

Describe Give clearly the distinguishing details or essential characteristics.

Determine Decide; come to a conclusion/make a decision by means of reasoning.

Discuss Examine/consider the opposing arguments (for or against a view).

Draft Prepare a preliminary version.

Evaluate Make judgements on the basis of given criteria.

Examine Investigate carefully/in detail.

Explain Set out the meaning; clarify the meaning, provide supporting evidence; 
argue the truth.

Identify Establish by consideration, select, recognise.

List Record/document/itemise names or things belonging to a class.

Mention/
name/state

Specify by name; cite names, characteristics, items, elements or facts.

Motivate Cite facts/reasons as support for a viewpoint or argument and draw a 
conclusion.

Organise Arrange in an orderly structure/sequence; place into classes/groups 
according to certain criteria.

Prepare Make ready/complete; make something ready on the basisbased on 
of previous study.

Record Put in writing; set down for reference and retention.

Summarise Give a condensed version; state the key aspects.
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Conclusion
We trust that the above information will help you to approach your AIN2601 studies 
methodically and with greater understanding.

AIN2601 is not simply one of those modules you pass, tick off as part of your degree 
requirements and continue – these are skills you can use for life. Knowing Pastel and 
Excel well will give you a competitive advantage in the marketplace.

Enjoy your studies and remember the words of Vince Lombardi:

“The price of success is hard work, dedication to the job at hand, and the 
determination that whether we win or lose, we have applied the best of ourselves 

to the task at hand.”

We trust that you will enjoy the AIN2601 journey with us. We wish you every success with 
your studies.

Kind regards

Your AIN2601 lecturers
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Very important note

You should not dispose of your study guide and other study material such as tutorial 
letters once you have passed this module. You may need to refer back to it in your next 
studies, as the principles covered in this module will not be repeated in future modules! 
In modules following this one, it will be assumed that you have achieved all the learning 
outcomes specifi ed in the study guides.

Module purpose
This module is primarily intended for people who are interested in qualifying as registered 
chartered accountants (SAICA) or management accountants (CIMA). This module will enable 
students to develop the necessary competencies prescribed by these professional bodies.

The purpose of the module is to provide you with knowledge about the fundamental data 
and transaction processing principles you need to understand operating and accounting 
information systems (AISs).

The module will also equip you – in your capacity as user, designer and evaluator – with 
the skills to apply your theoretical knowledge of accounting information systems in a 
practical business context.

Part 1: Data management and utilisation
Part 2: Spreadsheets
Part 3: Transaction processing
Part 4: Management reporting systems
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P A R T  1 
Data management and utilisation

PURPOSE

The aim of this part is to fi rstly, build on the foundation laid in the AIN1501 module 
regarding the computerised information system process. Secondly, the database 
environment, including different database models, database management systems 
and relational database terminology will be explained. This part concludes with a brief 
discussion of the utilisation of databases in accounting and auditing.

Study guide 1 Study guide 2

Part 1

Data 
management and 

utilisation

Part 2

Spreadsheets

Part 4

Management 
reporting systems

Part 3

Transaction 
processing

Topic 

1 Data 
managment 
and 
utilisation

Topic 

2 Spreadsheets

Topic

7 Management 
reporting 
systems

Topics 

3 Accounting 
cycles 

4 Financial 
reporting 
infrastructure

5 Accounting 
informtion 
system 
applications 

6 Pastel Partner  
accounting 
information 
system
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To p i c  1 
Data management and utilisation

LEARNING OUTCOMES

After studying this topic, you should be able to

 –  distinguish between the different methods of data input, data processing and information 
output

 –  name and describe each of the elements of the database environment
 –  list the functions of a database management system
 –  defi ne and describe each of the components of a database management system
 –  differentiate between various database models
 –  defi ne relational database terminology and identify each item on a simple database 

representation
 –  list the advantages and disadvantages of using a database environment for data storage 

and processing
 –  identify factors to consider when choosing an appropriate database management 

system and database
 –  name and briefl y explain some basic database applications

Topic 

1 Data managment 
and utilisation
SU 1: Data and the 

computerised 
information 
system process

SU 2: The database 
environment

SU 3: Utilising 
databases

Topic 

2 Spreadsheets

Topic

7 Management 
reporting 
systems

Topics 

3 Accounting 
cycles 

4 Financial 
reporting 
infrastructure

5 Accounting 
informtion 
system 
applications 

6 Pastel Partner  
accounting 
information 
system

Study guide 1 Study guide 2

Part 1

Data 
management and utilisation

Part 2

Spreadsheets

Part 4

Management 
reporting systems

Part 3

Transaction 
processing
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1S T U D Y  U N I T 1

1Data and the computerised information 
system process

1In this study unit

2

1 Introduction
For an organisation to be competitive, data must be collected, processed into useful 
information, stored and used in decision making. Many organisations have realised that 
timely access to appropriate, accurate data and information is the key to success or failure. 
A lack of access and/or timely access reduces the organisation’s ability to make timely 
and effective decisions. In this study unit, we will fi rst gain an understanding of the role of 
data in an organisation. We will then look at the types of data input, processing and output 
and typical processing systems. We will also learn about some of the methods used to 
process data into information.

2 Data in an organisation

      

Review the computerised information system (CIS) process as explained 
to you during your AIN1501 studies.
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FIGURE 1.1: COMPUTERISED INFORMATION SYSTEM PROCESS

Source: AIN1501 study guide

Refer to fi gure 1.1 throughout the following discussion:

Organisations continuously collect and enter (input) data (b) into the CIS, process data (c) 
and store data and information (d) about their customers, suppliers, inventory, competitors, 
employees, fi nances, business operations, to name only a few. Data is generated during 
different activities (a) in the organisation. For example, each time a customer completes an 
order form, the organisation produces an inventory item, a potential employee completes 
a job application form, data is generated.

Bear in mind that organisations (and individuals) usually make better informed decisions 
(f) if they have access to more data and valuable information.

       

As you can remember from your AIN1501 studies, the characteristics of valuable 
information are accessible, accurate, complete, economical, fl exible, relevant, 
reliable, secure, simple, timely and verifi able. Refer back to your AIN1501 studies 
or to study unit 19 and ensure you understand these important characteristics 
of information.

Input of data (also called data entry) (b), processing of data (c), output (e) and storage of 
data and information (d) will now be discussed in more detail.

3 Input of data
Data captured on manual documents (hard copy) as well as data entered in the CIS 
and not yet processed is called raw data.

Raw data has little or no value for the organisation in the decision-making process. Raw 
data becomes valuable when processed (c) into information (e) and an organisation then 
uses this information for decision making (f). For example, having a list of all the sales in 
a specifi c branch (raw data) is not useful in itself, but when this raw data is processed into 
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information, for example, total sales for a month compared to other months and branches 
in the organisation, this information now has become useful and valuable.

Because information is obtained by processing raw data, it is essential that the raw 
data captured in the CIS should be accurate, complete, reliable and verifi able.

The quality of information is directly linked to the quality of raw data entered – in other 
words, inaccurate data will lead to inaccurate information and incomplete data will lead to 
incomplete information, which in turn will result in ineffective decisions. The principle of 
“garbage-in-garbage-out” is especially true in a CIS. Many organisations have embarked on 
expensive data cleaning (correcting and completing data) projects because they understand 
the impact of inadequate data on information and decision making.

NOTE

Note the difference between the terms “information” and “data”. Make sure you use 
the correct term.

Information = processed data

Many medium and small organisations still use paper source documents (eg invoices, 
application forms, etc) to collect data. Most large organisations, however, have moved 
to electronic source documents by capturing data directly through computer data entry 
screens or by using barcode scanners. In topic 6 (Pastel) you will practise using computer 
data entry screens to capture invoices and other source documents.

A source document is the fi rst documented record of an activity that took place.

Data can be entered (input) into a CIS either through batch input or through online input. 
For both these types of input, the data captured will be stored in the CIS transaction fi le. 
Transaction fi les are explained in study unit 2

3.1 Batch input
Data is fi rst captured on paper (hard copy) or electronic (soft copy) source documents. 
The electronic source documents referred to are documents created outside of the 
organisation’s CISs. For example, the organisation receives an electronic fi le from one of 
its trading partners containing a batch of electronic source documents.

Batch input involves similar source documents being grouped together (batch) and 
then entered in the CIS periodically, say, daily, weekly or monthly.

The organisation’s processes will determine the frequency of capturing the data – for 
example, employee data may only be captured once a month before the payroll run, supplier 
invoices may be captured twice a week and goods received notes may be captured daily.

Batch input is used where a huge number of similar source documents must be captured 
and up-to-date data and information are only required on the same frequency as the 
frequency of data capturing.

Batch input will require additional batch controls and procedures to be implemented in 
the organisation’s control environment. You will learn more about these controls and 
procedures in auditing.
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The advantage of using batch input is that economies of scale (increased productivity 
and lower hardware costs) can be achieved because the data is captured at one point 
and data capturing is not dispersed throughout the organisation. The main disadvantage 
of using batch input is that the CIS is not up to date with the latest data and information.

 3.2 Online input
Online input involves data being immediately captured into the CIS at the point 
where the activity occurs.

Many supermarkets use barcode scanners and terminals for online inputting when 
customers buy inventory items by scanning (capturing) the inventory item at the point of 
sale (pay point).

Because data is captured directly and immediately, any corrections to the data must also 
be made immediately in order for the data capturing process to be completed. Taking the 
above example of a supermarket pay point, you may have experienced the barcode of an 
item not being recognised by the CIS (error), and the person at the till having to enter the 
correct barcode (correction) in order to complete the transaction.

The main advantage of using online input is that the data in the CIS is always up to date. 
A disadvantage, however, is that online inputting is more costly because hardware is 
required to capture the data at each point where the activity to be captured takes place.

4 Processing data

4.1 Processing methods
For raw data to become information, it must be processed (c) (ie data processing). The 
different methods that can be use to process data into information include the following:

(a)  Classifying data

Data is arranged into different groups (categories) using some of the data’s specifi c 
characteristics, for example, classifying the data according to cash or credit sales or 
according to the source document (ie orders, tax invoices, etc).

(b)  Performing calculations

Arithmetical or logical calculations can be performed on data. Arithmetical calculations 
include addition (+), subtraction (–), multiplication (x) or division (/), for example, 
calculating the cost per unit (R cost divided by number of units); the VAT amount on a 
tax invoice (VAT% multiplied by the excluding VAT amount); net profi t/loss (expenses 
subtracted from income); the total amount on an invoice (adding the amounts of the 
individual items).

Logical calculations include comparing the data to other data or calculations – for 
example, is the data the same (=), not the same (<>), greater than (>), smaller than (<), 
greater than or equal to (>=) or smaller than or equal to (<=)? The logical calculation 
will have a true or false answer, and based on this answer, further processing will take 
place. The IF function is one of various Microsoft Excel functions that can be used 
for logical calculations. See study unit 5 in which the IF function is explained in detail.
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(c)  Sorting data

Data is organised (sorted) in an orderly sequence based on specifi c criteria, for 
example, purchase orders in numerical sequence or the names of customers in 
alphabetical order. In study unit 5 we will learn how to sort data using Microsoft Excel.

(d)  Summarising data

This process condenses the data by extracting only specifi c data based on criteria 
provided by the user – for example, adding all the transactions for a specifi c supplier 
for a particular month. A pivot table is an example of a Microsoft Excel function that 
can be used to summarise data.

(e)  Transforming data

Data is processed by transforming the format or medium of the original data into 
another format or medium – for example, accounting data is transformed into graphical 
data (graph) or audio fi les can be transformed into written text (used by individuals 
with hearing disabilities to communicate telephonically) or vice versa. (Wessels, Mc 
Gee, Prinsloo, Mc Gee and Van der Poll 2010:34)

In Microsoft Excel study unit 5 we will learn to transform data using graphs.

      

Note: This activity refers to databases that we will only learn about in study unit 
2. Return to this activity after you have completed study unit 2.

Campus Computers is a business that sells computers and software to students. 
The business has developed its own software to record its business transactions 
in a database.

The business has three overseas suppliers and two local suppliers from which 
it purchases inventory. Inventory must be ordered when the quantity on hand 
reaches the minimum reorder level.

Data was processed into information in the database of Campus Computers, 
as can be seen in the extract of the database fi les below.

Required:

Identify examples of each of the processing methods listed below:

(a) Classifying
(b) Sorting
(c) Calculating
(d) Summarising

userre
Sticky Note
come back to this after been done with study unit 2
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The following is an extract from the fi les of Campus Computers’ database:

Supplier no. Supplier name Telephone Currency Balance (a)

PCW003 PC World +27 09 847-9387 ZAR 9251.18

DIL001 Dille Computers +00 1 907-8334 USD 54397.90

FOR001 Forever PC +00 33 923-1426 EURO 94706.81

SAP001 SAPC +27 09 959-1234 ZAR 229866.02

GIG002 GIGAB Computers +00 1 213-1177 USD 1528599.85

Inventory 
no.(b)

Item 
description

Inventory 
category 

(c)

Quantity 
on hand 

(d)

Minimum 
reorder 

level

Last cost 
price

Order Yes/
No (e)

HD/250 360 Gig 
hard drive

Parts 22 7 729.50 No

LAP142 Laptop 
– SAPC

Computer 12 5 10000.00 No

LAP175 Laptop – 
GIGAB I

Computer 35 20 14000.00 No

MON190 Monitor – 
19 inch

Parts 7 12 3400.00 Yes

MOU050 Mouse 
– cordless

Accessories 9 15 45.35 Yes

Invoice 
no. (f)

Line 
no.

Supplier 
no.

Purchase 
date

Inventory 
no.

Quan Price 
per unit

VAT (g) Total (h)

PN10029 1 SAP001 14-Jun-13 LAP142 5 10000.00 7000.00 57000.00

PN10030 1 FOR001 15-Jun-13 MOU050 9 45.35 57.14 465.29

PN10030 2 FOR001 15-Jun-13 HD/250 1 729.50 102.13 831.63

PN10030 3 FOR001 15-Jun-13 MON190 3 3400.00 1428.00 11628.00

PN10031 1 GIG002 16-Jun-13 LAP175 4 15500.00 8680.00 70680.00

Supplier no. Month (i) Transaction 
type (j)

Amount excl 
VAT (k)

VAT (l) Amount incl 
VAT (m)

FOR001 April-13 Purchase 58456.50 8183.91 66640.41

FOR001 May-13 Purchase 114580.00 16041.20 130621.20

FOR001 May-13 Payment -101298.00 -14181.72 -115479.72

FOR001 June-13 Purchase 11337.65 1587.27 12924.92

Balance for the quarter (n) 83076.15 25812.38 94706.81
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      

(a) Classifying

 – Inventory is classifi ed according to three categories: Parts, Computers 
and Accessories in the Inventory category fi elds (c).

 – Transactions for supplier FOR001 are categorised into two categories: 
Purchases and Payments in the Transaction type fi elds (j).

(b) Sorting

 – The suppliers are sorted in ascending order, based on the Balance 
fi elds (a).

 – The inventory items are sorted in ascending order, based on the 
Inventory number fi elds (b).

 – Purchase transactions are sorted in ascending order, based on the 
Invoice number fi elds (f).

 – Transactions for supplier FOR001 are sorted, based on the Month 
fi elds (i).

(c) Calculating

 – The Supplier balance fi elds (a) have been updated with the total of the 
purchase transactions for that supplier.

 – The Quantity on hand fi elds (d) have been updated with the quantity 
purchased in the purchase transactions for that inventory item.

 – The Order Yes/No fi elds (e) have been updated with the logical test – the 
quantity on hand is less than the minimum reorder level.

 – The VAT fi eld (g) has been calculated for each purchase transaction.
 – The Total fi eld (h) has been calculated for each purchase transaction 

based on the quantity, price per unit and VAT amount.
 – The Amount including VAT fi elds (m) for supplier FOR001 have been 

calculated for each month, based on the Amount excluding VAT and 
VAT fi elds.

 – For supplier FOR001, the totals per quarter (n) for the fi elds Amount 
excluding VAT (k), VAT (l) and Amount including VAT (m) have been 
calculated.

(d) Summarising

 – The Amount excluding VAT (k), VAT (l) and Amount including VAT (m) 
transactions relating to supplier FOR001 were summarised for the quarter 
April 2013 to June 2013 in the last table.

4.2 Processing types
Data can be processed into information by means of two processing types, either batch 
processing or real-time processing.

(a)  Batch processing

Batch processing occurs when the transaction fi les (containing the captured data) 
are updated to the master fi les periodically, that is, daily, weekly or monthly.
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The main drawback of this method of processing is that the master fi les are only up to 
date once the updating of the transaction fi les has occurred. When using this method of 
processing, users who utilise information and data must be aware of which transaction 
fi les were updated and which fi les were not, and therefore how up to date the information 
they are looking at is. Transaction fi les and master fi les are explained in study unit 2.

(b)  Real-time processing

The immediate update of the transaction fi les to the master fi les as the transaction 
occurs is called real-time processing. 

Real-time processing ensures that the master fi les are always up to date, and this is also 
the greatest advantage of real-time processing. Transaction fi les and master fi les are 
explained in study unit 2.

5 Output/information

Processed data becomes information, and this information can be retrieved by users 
through batch output or interactive output.

5.1  Batch output

Batch output occurs when all requests for information (ie reports, queries, etc) are 
batched together and periodically extracted from the CIS.

Since requests are batched before being extracted, users have to wait to receive their 
required outputs. Batch output is often used for routine reports that must be extracted at 
the same time each day, week or month (eg sales reports for the day, week or month). 
These batched reports are prespecifi ed and include the same parameters each time.

The benefi t of using batch output is that reports are consistent between periods. For 
example, the sales reports will include the same branches in the different geographical 
areas each time the specifi c report is extracted. Another benefi t of batch output is that the 
extraction of reports can be scheduled over down times (over weekends, evenings, etc), 
thereby optimising computer resources.

5.2  Interactive output

Interactive output occurs when users are directly connected to the CIS and can 
request certain information and receive it immediately.

The main benefi t of using this method of output is that users can immediately receive 
information for decision making. One of the drawbacks of interactive output is that 
the computer resources are not optimally used and as a result, the performance of the 
CIS may be negatively affected. For example, at month-end, numerous users extract 
reports from the CIS while day-to-day transaction processing still continues. This increase 
in use of the CIS can make the users experience a “very slow” CIS response time (ie 
the computer is “slow”).

6 Typical processing systems
In section 3 to 5 we learnt about batch and online input, batch and real-time processing and 
batch and interactive output. Different combinations of these input, processing and output 
types are used in an organisation’s CIS. Some of these typical combinations are as follows:
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 •  Batch input, batch processing and batch output

The processing of claims at a medical aid is an example of such a system. Members 
submit claims, which are batched together and then entered in the CIS. All the entered 
batches are updated at the end of each day. Routine claim reports, indicating the claims 
of the previous week, are extracted and distributed every Monday morning. See fi gure 
1.2 for a visual representation.

FIGURE 1.2: Batch input, batch processing and batch output

 •  Batch input, batch processing and interactive output

For example, twice a week, the gym partner of a medical aid provides the medical aid 
with batch of electronic source documents in one fi le. This fi le contains the number of 
times each member of the medical aid visited the gym. The batch source documents 
contained in the electronic fi le are imported when received. The transaction fi les 
containing the gym data are updated every Saturday. The members can view their 
information on the medical aid’s secure website as soon as the transaction fi le has 
been updated.

 •  Online input, batch processing and interactive output

For example, each branch of the organisation enters its request for inventory online 
as needed. The transaction fi le containing the different branches’ requests is updated 
to the master fi le every two days. The branch manager can extract order information 
directly from the operational system.

 •  Online input, real-time processing and interactive output

An example of such a system is the processing of a transaction at a bank’s automatic 
teller machine (ATM). The customer enters the transaction at the ATM. The transaction 
is immediately updated to the master fi le and the customer receives a receipt with the 
transaction details and his or her new updated balance. See fi gure 1.3 for a visual 
representation.
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FIGURE 1.3: Online input, real-time processing and interactive output

7 Storage of data and information
Data is saved (stored) for use in processing, and information is stored (saved) to be used 
by users. Data and information must be stored in the CIS in such a way that it can be 
easily accessed when needed.

7.1 Flat fi le environment
Historically, computer systems’ data and information were stored in a fl at fi le environment,
where fi les are not related to one another and the users of data and information each 
keep their own data and information. 

This is similar to an environment in which users each have their own Microsoft Excel 
spreadsheet and do not share the data and information on their individual spreadsheets. 
As computer systems evolved and the need arose for users to share data and information, 
databases became the preferred method of storing data and information. The database 
environment will be discussed in detail in study unit 2. Simplistically, the fl at fi le and 
database environment can be visualised as in fi gure 1.4 (fl at fi le) and fi gure 1.5 (database).

FIGURE 1.4: Flat fi le environment
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FIGURE 1.5: SHARING DATA AND INFORMATION IN A DATABASE ENVIRONMENT

8 Summary
In this study unit, we looked at typical processing systems based on the types of data 
input, processing and output. We also gained an understanding of how data is processed 
into information by sorting, classifying, calculating, summarising and transforming it. In 
the next study unit, we will examine in detail the database environment used to store data 
and information.

          

After working through this study unit, you should be able to answer the following 
questions:

(a) Prepare a fi gure to depict the computerised information system (CIS) 
process.

(b) Organisations make better decisions if they have access to less data and 
valuable information. Is this statement true or false?

(c) Defi ne the term “raw data”.
(d) List the four (4) characteristics raw data should have before it is captured 

in the CIS.
(e) Explain why it is important for the raw data to have the characteristics 

mentioned in d.?
(f) Briefl y explain batch input and online input.
(g) Name the advantages and disadvantages of using batch input and online 

input respectively.
(h) List the methods and give an example for each method that can be used 

to process data into information.
(i) Briefl y explain batch processing and real-time processing.
(j) Name an advantage of using real-time processing.
(k) Briefl y explain batch output and interactive output.
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(l) Describe the advantages and disadvantages of using batch output and 
interactive output respectively.

(m) List four (4) typical processing systems that are found in CIS.
(n) Why are data and information stored?
(o) Explain the concept of a fl at fi le environment.
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2S T U D Y  U N I T  2 

3The database environment

7In this study unit

4

1 Introduction
In the previous study unit, we learnt that the database environment provided the solution 
to the need of users to be able to share and view the same data and information in an 
organisation. Databases became the preferred method of storing data and information 
because of their numerous advantages. In this study unit, we will gain an understanding 
of the database environment, the advantages and disadvantages of using a database 
environment and an understanding of the database environment’s components. We will 
also explain database models, distributed and centralised databases and the terminology 
used in a relational database. In conclusion, we will look at the factors to consider when 
choosing appropriate database management software and a database.
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2 The database environment
In a database environment, data and information can be effectively stored and 
retrieved. The database environment consists of three components, namely the users 
of the database, database management systems (DBMS) and the physical database, 
which includes both the hardware it runs on and the data in the physical database 
(see fi gure 2.1).

The database environment and its related components are explained in detail in sections 
4 to 6.

FIGURE 2.1: Database environment

3 Advantages and disadvantages of using a database environment
Using a database environment to store, process and retrieve data and information has 
advantages and disadvantages. We will briefl y look at some of these.

3.1 Advantages
 •  Reduced data redundancy. This is because all data is stored in only one place.
 •  Reduced costs for data entry and data storage. Data is only entered once, which 

creates a data capturing cost saving. The effect of reduced data redundancy is that 
less storage space is needed on storage devices, creating a data storage cost saving.

 •  Data integrity is maintained and improved. This is because changes and updates 
to data occur in one place.

 •  Improved data and information security. Since access to the database and therefore 
access to the data and information in the database is centrally controlled and managed, 
this increases security for the organisation’s data and information.

 •  Application software independence. Data is stored separately from the application 
software. Changes to the database will therefore not always require an automatic 
rewriting or updating of the application software, or vice versa.
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 •  Standardisation of data structures, data access, system software and fi le formats. 
This makes it easier to maintain data fi les. The standardisation creates a consistent 
structure on which all application software are based, which makes it easier to update 
existing or develop new application software.

 •  Improved data access. Data can be made available to different users at the same 
time as users share the data in the database. Database management software also 
makes it easy for users to access and retrieve data.

3.2 Disadvantages
 •  Start-up and operating costs. It can be expensive to acquire the hardware and 

software needed to set up a database environment. Furthermore, an organisation will 
need to hire additional employees, such as a database administrator, to manage the 
database environment.

 •  Database systems are complex to design and use.
 •  Because databases are complex, it is very time-consuming to design a proper 

database.
 •  Database or database management software failure will affect all application 

software linked to that specifi c database. This can make recovery from such a failure 
more diffi cult. A failure can shut down a whole organisation or department(s) in the 
organisation, making the organisation unable to run its daily operations and provide 
adequate customer service.

4 Database users
There are various database users in the database environment, including the following:

4.1  End-users
End-users capture data in the database and extract information from the database 
using database management system software.

Owing to their computer skill level, most end-users will interact with the database 
management system (DBMS) through application software. DBMS is explained in section 5.

 4.2 Application programmers
Application programmers are responsible for creating, maintaining, updating and 
managing the application and DBMS software which the end-users use to interact 
with the physical database.

4.3  Database administrator
The database administrator is responsible for managing and controlling the 
organisation’s databases.

The database administrator’s role includes functions such as the following:

 – Implement and maintain database management standards and conventions.
 – Ensure applications software complies to database management standards and 

conventions by establishing programming standards.
 – Defi ne the database structures.
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 – Design and create databases in line with database management standards and 
conventions

 – Implement, maintain and evaluate database access policies and security controls.
 – Monitor data and database security and access.
 – Monitor and maintain database performance.

4.4  Data administrator
The data administrator, also called a database analyst, is responsible for managing 
and controlling the data in the organisation’s databases.

One of the data administrator’s responsibilities is to manage the integrity of the data 
in the database by setting and enforcing the data standards and data defi nitions to be 
used in all the organisation’s databases. In many organisations, the functions of the 
data administrator and database administrator are combined – hence these functions 
are performed by the same person.

5 Database management systems (DBMS)
A DBMS is an integrated set of software that provides a user-friendly interface to the 
users for all data interactions between the user and the physical database – in other 
words, it enables the users to operate and interact with the database.

Some examples of commonly used DBMSs are Microsoft Access, SQL Server, Oracle, 
Sybase, MySQL (open source software).

5.1 DBMS functions
DBMS enables users to

 •  design, create and maintain the database structure and the database
 •  control the organisation, storage and retrieval of data in the database
 •  capture, maintain (delete, insert and amend) and manipulate the data in the database
 •  share data between multiple users simultaneously
 •  execute queries and generate outputs
 •  control the movement of the data between authorised users and the database
 •  control and monitor access to the database
 •  analyse and monitor database performance

5.2 Three-level database architecture
ANSI-SPARC (American National Standards Institute [ANSI] – Standards Planning and 
Requirements Committee [SPARC]) suggested a three-level database architecture, namely 
an external level, conceptual level and internal level (Boczko 2007:314). This three-level 
database architecture is now commonly used in modern DBMS frameworks and is based 
on the different views of data in a DBMS.

(a) External level

 The external level, also called the user view, is the individual end-user’s view of the 
data and the database.

Because users’ information needs differ, the views they require of the database will 
also differ – hence there may be an infi nite number of external views. For example, 
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the creditor’s clerk input screen and reports (user view) will look different from the 
input screen and reports (user view) of the cashbook clerk. When working on Pastel 
Partner (topic 6), we will see in practice how the user views differ, depending on the 
type of transaction processed (ie creditors, cashbooks, etc).

(b) Conceptual level

 The conceptual level is a complete view of the entire database, that is, a view of all 
the data from which the user views can be derived.

The database administrator will generally use this view. In comparison with the user 
view, which may have infi nite variations, there is only one conceptual view.

(c) Internal level

 The internal level, also called the physical view, is the low-level view of how the data 
is physically stored on a storage device such as a magnetic hard drive disk.

There is only one physical view. The binary code (1s and 0s, eg 01100011) in the 
database is one facet of the physical view.

The database administrator updates and maintains all three levels.

FIGURE 2.2: Three-level database architecture

5.3 DBMS key components
The key components of the DBMS are the data dictionary and database languages.

(a) Data dictionary

A data fi eld contains a single data value and is the smallest unit of data that can be 
accessed in a database. Data fi elds are explained in detail in section 6.3.

The data dictionary contains a record for each data fi eld in the database and this 
record gives a detailed description of that data fi eld.

The data fi eld description includes information such as the following:

 •  the name and description of the data fi eld
 •  other names the data fi eld may have
 •  a range of acceptable values
 •  the data type (type of data stored, ie numeric, alphabetic, alphanumeric, date, etc)
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 •  the fi eld length (the number of characters that can be entered into the data fi eld)
 •  the software and records it is used in
 •  the source of the data fi eld
 •  outputs in which it is used
 •  the authorised user groups for the data fi eld

An extract of some of the information contained in a data dictionary is provided below.

(b) Database languages

The database users (end-users, application programmers and database administrator) 
use different database languages to interact with the database.

These languages included a data defi nition language, data control language, data 
manipulation language and a data query language. These database languages are usually 
specifi c to the database model in use. (We will learn about these different types of 
database model in section 6.) SQL (structured query language) is one for the most 
commonly used database languages for a relational database model and combines the 
data defi nition language, data control language, data manipulation language and data 
query language.

 •  Data defi nition language (DDL)

As the name implies, data defi nition language is used to defi ne a database and 
includes commands to (1) create, modify and delete the database and database 
objects, (2) defi ne and describe the data structure of the database according to the 
database model used, and (3) create the data dictionary.

Database objects include database tables, views, rules, indexes and so forth. DDL is usually 
only available for use by the database administrator and requires detailed knowledge of 
the conceptual level of the DBMS.

 •  Data control language (DCL)

DCL controls the security and user access to the database objects and data in the 
database.

DCL is usually only available for use by the database administrator.

 •  Data manipulation language (DML)

DML is used in the routine operation of the database to insert, delete, modify and 
maintain the data stored in the database.

Data manipulation language can be used by all the database users, but the level of use will 
be determined by their skill level and access granted. Most end-users, however, access the 



. . . . . . . . . . .
22TO PI C 1

DML through application software. DML and DDL should not be confused. DML is used for 
the data stored in the database while DDL is used on the database objects and structure.

 •  Data query language

Data query language is used to retrieve data from the database.

All database users can use data query language. However, owing to their programming 
skill level, most end-users access the data query language through application software.

6 Physical database
A database can be defi ned as an organised collection of related data that is managed 
and stored electronically and can provide data to different application software in the 
organisation.

Through the use of a DBMS, different application software and users in an organisation 
can access the same data and a variety of other data in the database.

6.1 Database models
Databases can be classifi ed according to the theoretical data structure, referred to as a 
data model, on which it is based.

The data model used will determine the manner in which the data is stored, organised 
and the operations that can be performed on the database. A number of database models 
can be used. However, we will only briefl y discuss some of the main model types, namely 
hierarchical, network, relational, object-oriented and multidimensional.

(a)  Hierarchical model

The hierarchical model was used in early databases and, as the name indicates, the 
data is structured in a hierarchical (upside down tree-like) structure.

The relationship between the data records is based on a one-to-many relationship, also 
known as a parent/child relationship (a child can have only one parent, but a parent can 
have many children). This type of data structure is infl exible. Microsoft Windows Explorer 
is structured hierarchically, and unless we duplicate a fi le, a fi le can only be saved in one 
directory. See fi gure 2.3 for a visual representation.

FIGURE 2.3: Hierarchical model
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(b)  Network model

The network model supports many-to-many relationships, that is, data may be 
accessed by following several paths.

In many-to-many relationships, a child can have multiple parents and there can be 
relationships between children. Nowadays, the use of this model is mostly obsolete.

(c)  Relational model        

In a relational model, data is stored in two-dimensional 
rows and columns (ie tables).

A table is also known as a relation, and each database has several tables. Every table has 
its own primary key and the database uses this primary key to link (relate) the table to the 
other tables in the database (primary key is explained in section 6.3). A table is similar to 
a spreadsheet with rows and columns. (Spreadsheets are discussed in topic 2). MySQL, 
Microsoft SQL Server and Oracle are examples of relational model databases.

A disadvantage of using this model type is that it is slower than the network and hierarchical 
models because it uses more processing power to query data.

Relational databases provide many benefi ts such as the following:

 – Data can be accessed, inserted and/or deleted without changing the database structure.
 – The database structure can be easily customised for most types of data storage.
 – Data does not need to be duplicated.
 – Most users easily understand the structure.
 – It is easy to search for and extract data from the database.

Owing to its many advantages, the relational model is the most commonly used database 
model for business and fi nancial databases. Relational database terminology will be 
discussed in section 6.3.

(d)  Object-oriented model

In an object-oriented model, the data and the operations to be performed on the 
data are both stored in the database. This database model can furthermore store 
and process a wider range of data types than only text and numerical data – it also 
stores and processes images, audio and video data.

This model is used for more specialised databases such as multimedia web-based 
applications, molecular biology databases and defence industries. Object-oriented database 
models are not as widely used as relational databases because they are expensive to 
implement, and many organisations do not need to process other data types other than 
numerical and text data.

(e)  Multidimensional model                 

A multidimensional model is similar to a relational model, but 
whereas a relational model stores data in a two-dimensional 
table, a multidimensional model stores data in a three- or more 
dimensional table, creating a cube-like data structure.
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Data can be viewed in a spreadsheet-like format, which make it easier to understand where 
data with many interrelationships are stored and processed. Owing to the spreadsheet-
like format, this data structure is easy to maintain. This model type is mainly used for data 
warehouses and makes online analytical processing (OLAP) and business intelligence 
software (BIS) possible. BIS will be discussed further in study unit 19.

6.2 Centralised and distributed databases
The physical location of an organisation’s databases will depend on its specifi c business 
needs and requirements. We can classify a database according to its physical storage 
location as either a centralised or a distributed database.

(a)  Centralised database

When using a centralised database, the database is physically stored in one central 
location (ie it is on one server).

All users interact with this single database in the single location through the computer network. 
The benefi t of using this type of database is that the database is always up to date with 
the latest information if online input and real-time processing are used.

(b)  Distributed database

When using a distributed database, there are several interlinked databases stored in 
several computers in the same (eg headquarters) or different locations (eg branches).

When a distributed database is properly managed, users will not know that each person 
may be interacting with a database in a different location because they will all have the 
same view of the database. Distributed databases are either a partitioned or a replicated 
database.

A partitioned database is split into smaller portions (partitions) and the part applicable to 
the user is made available on the location closest to the user. Partitioned databases are 
generally used when minimal data sharing is necessary between users at the different 
locations. For example, an organisation with branches may use a partitioned database 
when its customers always only interact with that specifi c branch and there is thus no need 
for the branches to view each other’s customer databases.

In a replicated database, the whole original database is copied to the different locations, that 
is, the database is replicated at each location. For example, a pharmacy with countrywide 
branches at which customers can obtain new and repeat prescriptions at any of the branches 
may use a replicated database for customers. This will enable the customer to obtain a 
repeat prescription at any of the pharmacy’s branches without the branch needing to see 
the original prescription.

The different replicated databases in one network update by means of duplication or 
synchronisation. In duplication, the master (original) database is copied to the other 
locations, normally at a specifi c frequency and time, and will overwrite the database at 
the distributed locations. The database at the different locations can only be updated by 
updating the master database. Synchronisation is more complex and time consuming 
and involves a two-way updating of the master database and the distributed databases 
(ie the master database can update the distributed database and the distributed database 
can update the master database). This synchronisation process normally also happens 
at a preset frequency and time. Data confl icts (ie the same data must be updated by both 
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databases and the software needs to determine which database has the latest or correct 
data) are usually resolved through predetermined rules, but in some instances can also 
be resolved manually, that is, the user determines which is the latest version of the data.

       

One of the big four audit fi rms uses replicated databases for its electronic 
client audit fi les. A master database of the client audit fi les is created and then 
replicated on each audit team member’s computer. Each team member works 
on his or her own “replicated database” and synchronises to the master copy at 
a frequency determined by the audit team leader.

(a) Ask your auditor friends or family members or the auditors at your organisation 
if they use databases for their client audit fi les.

(b) Determine whether they use a centralised or a distributed database.
(c) Is the distributed database updated through duplication or synchronisation?

6.3 Relational database terminology
Because a relational database is the most commonly used database model for business 
and fi nancial databases, we will look at the database terminology applicable to relational 
databases.

A relational database comprises several database fi les, each of which consists of several 
data records. A data record consists of several data fi elds, each of which contains a data 
value. See fi gure 2.4 for a schematic representation, but bear in mind that each database 
contains many more data fi les, data records and data fi elds than those depicted in the fi gure.

FIGURE 2.4: Database overview
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Refer to fi gure 2.5 in the following discussion. Each of the fi les shown is only an extract 
– the real transaction and master fi les contain many more data fi elds and data values.

FIGURE 2.5: Database terminology

(a)  Data value

A data value is a character (a single number, letter or special character) or a group 
of related characters used to populate the data fi eld.

The data value entered will vary from data fi eld to data fi eld. For example, a data value 
can be a number, say, 5, or a name, say, Thabo.
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(b)  Data fi eld

A data fi eld contains a single data value and is the smallest unit of data that can be 
accessed in a database.

A data fi eld is similar to a cell in a spreadsheet. The data value contained in a data fi eld 
will differ from data record to data record.

Data fi elds can be compulsory (data must be entered into this fi eld), optional (the fi eld 
may be left blank if no data is entered) or calculated (the data value is not entered but 
automatically derived from a formula based on other data fi elds).

In fi gure 2.5, in the purchase transaction fi le, the data value, 4, is entered in the quantity 
data fi eld for record PN10031. The Balance data fi elds in the supplier master fi le are an 
example of a calculated data fi eld.

(c)  Attribute

An attribute, commonly known as a column, represents one unique characteristic 
of a single database table.

However, an attribute can appear in more than one database fi le. Each attribute will have 
a specifi c fi eld length (number of characters that can be entered in the fi eld) and a specifi c 
data type (numbers, characters, dates, etc). The fi eld length and the specifi c data type 
particular to that attribute are described in the data dictionary.

In fi gure 2.5, in the purchase transaction fi le, the attribute labelled “VAT” will include the 
VAT amount for each record. The “Credit limit” attribute in the supplier master fi le will 
indicate the credit limit of each supplier and the “Inventory category” attribute’s data type 
will be alphabetic characters only.

(d)  Field name

All attributes have a unique name known as a fi eld name, which labels the data 
stored in the attribute.

Field names are unique and no column (attribute) can therefore have the same name in 
a database table.

In fi gure 2.5, in the purchase transaction fi le, “Price per unit” is a fi eld name. “Minimum 
order qty” is a fi eld name in the inventory master fi le.

(e)  Data record

A data record is a set of logically related data fi elds about a single member or item.

A data record is also referred to as a “tuple” and is similar to a row in a spreadsheet. All 
data records of a particular data fi le will have the same structure – that is, it will consist of 
the same type of data fi eld that is ordered in the same order. For example, every student 
record in a student master fi le will contain a student number, fi rst name, surname, telephone 
number and identifi cation number.
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In fi gure 2.5, the data record for supplier, Forever PC, in the supplier master fi les contains 
data fi elds for “supplier code”, “supplier name”, “telephone”, “credit limit” and “balance”. 
All these data fi elds together are referred to as a data record.

In fi gure 2.5, Forever PC’s data record in the supplier master fi le is as follows:

FOR001 Forever PC +00 33 923-1426 95000 94706.81

(f)  Primary data fi eld

Each fi le has a unique data fi eld (known as the primary data fi eld) that can be used 
to uniquely identify each data record in a database fi le. A primary data fi eld is also 
known as a primary key.

In fi gure 2.5, the “supplier code” (e) data fi eld is the primary data fi eld in the “supplier 
master fi le” and the “inventory number” fi eld (f) is the primary data fi eld in the “inventory 
master fi le”.

The combination of the invoice no. (a) and the line no. (b) fi elds in the purchase transaction 
fi le together make a unique data fi eld – that is, PN10029 (invoice no.) and 1 (line no.) 
creates a primary key namely PN100291.

(g)  Foreign key

When a primary data fi eld of a database fi le is entered into another database fi le to 
create a relation between the two database fi les, the primary data fi eld in the other 
database fi le is known as a foreign key.

A foreign key does not uniquely identify a record and may have duplicates in a database 
fi le. The use of foreign keys prevents the duplication of data.

In fi gure 2.5, the “purchase transaction fi le” links (relates) to the “supplier master fi le” through 
the use of the “supplier code”. The “supplier code” (e) data fi eld is the primary data fi eld in 
the “supplier master fi le” as it uniquely identifi es the supplier record but in the “purchase 
transaction fi le” the “supplier code” (c) is the foreign key as it links the two fi les through a 
primary data fi eld. Note that there is more than one entry for supplier code “FOR001” in 
the purchase transaction fi le.

The “purchase transaction fi le” links (relates) to the “inventory master” fi le through the 
use of the “inventory number”. The “inventory number” fi eld (f) is the primary data fi eld in 
the “inventory master fi le”, but in the “purchase transaction fi le”, the “inventory number” 
(d) is known as the foreign key. The master fi les have been sorted in a different order, but 
individual data records can still be found using the unique primary keys and foreign key keys.

(h)  Database fi les

A database fi le, also known as a database table, is an organised collection of related 
data records.

Each database fi le contains related records – that is, the records in the database fi le 
have a common theme. There are different types of database fi les, namely master fi les, 
transaction fi les, reference fi les and history fi les.
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 • Master fi le

A master fi le contains data records of a relative permanent nature (ie they do not 
change regularly) about the organisation’s resources and subjects (ie customers, 
suppliers, inventory, employees, etc).

Some of the data in the master fi le is updated periodically by the transaction fi les. The 
master fi le is the most important fi le in the database and is the authoritative source of data. 
In fi gure 2.5, the supplier master fi le contains data records about all the organisation’s 
suppliers and the data fi elds in the records are relatively permanent (ie the name of the 
supplier and telephone number do not regularly change).

 • Transaction fi le

A transaction fi le contains data records relating to the daily individual activities of 
the organisation (eg the organisation’s sales). A transaction fi le changes regularly as 
additional transactions are processed.

These transaction data records (ie the transaction fi le) are used to update or change the 
master fi le. In fi gure 2.5, the purchase transaction fi le contains data records about the 
organisation’s purchase transactions for June 2013, which may be used to update the 
balance fi eld in the supplier’s master fi le.

 • Reference fi le

A reference fi le is a semipermanent fi le containing data records referenced to by 
the transaction fi le in order to complete a transaction.

Examples of a reference fi le in an accounting transaction processing systems are tax 
tables needed to calculate pay-as-you-earn (PAYE) or price lists referenced in order to 
calculate the sales price per item.

 • History fi le

A history fi le contains data records about transactions completed in the past.

The data records in the history fi les are derived from the transaction fi le and are used in 
future queries and references. For example, the prior year purchase transactions are moved 
from the purchase transaction fi le to the purchase history fi le at the end of the fi nancial 
year, during the year-end process.

         

Microsoft Access and OpenOffi ce Base are examples of database software. 
Visit the internet for the following:

(a) For basic information on Microsoft Access:

 – Type the following URL: http://offi ce.microsoft.com/en-us/support.
 – Select the “Support” menu and click on “Get Started with Offi ce”.
 – Select the “Access”.
 – View the getting started video.
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(b) For more information on how to use Microsoft Access:

 – Type the following URL: http://offi ce.microsoft.com/en-us/support.
 – Select the “Support” menu and click on “Offi ce Training”.
 – Select either “Access 2010” or “Access 2007”.
 – Complete the different training options.

(c) For additional insight into database terminology and the design of a 
database with regard to databases go to the following Microsoft website: 
http://www.microsoft.com/about/corporatecitizenship/citizenship/giving/
programs/up/digitalliteracy/gbr/curriculum2.mspx and complete the 
“Productivity Programmes” module, lesson 6.

7 Factors to consider when choosing a DBMS and database
Organisations should consider a number of factors when deciding on an appropriate 
DBMS and database. Each factor should not be considered in isolation because factors 
will infl uence one another and some factors, such as costs, may also be a constraint for 
all other factors. The following are some of the factors an organisation should consider:

 •  The database model type used should support the requirements of the organisation – that 
is, a fi nancial system might only require a relational database, but an organisation that 
requires online analytical processing (OLAP) needs to use a multidimensional model.

 •  The acquired DBMS and database should closely match the requirements of the 
organisation.

 •  The DBMS and database should be able to evolve to meet future organisational needs.
 •  The performance (ie reaction time) of the DBMS and database. How fast can records 

be updated or queried in the database?
 •  The cost of the DBMS and database should be considered. Can the organisation afford 

the DBMS and database?
 •  Different DBMS and databases will require different levels of specialised staff skills. 

Are there specialised skills available in the organisation or can the organisation acquire 
the skills required?

 •  The hardware needed to run the DBMS and database should be considered. The 
organisation may need to acquire hardware if it is not already available. This will have 
further cost implications.

 •  Can the DBMS and database be integrated with the rest of the organisation’s information 
systems?

 •  The database size (amount of data the database can manage) must be adequate for the 
organisation’s future data requirements and the database should easily be expandable.

 •  The number of concurrent users (the number of users who can assess the database 
at the same time) the DBMS and database can handle should be taken into account.

 •  The DBMS and database vendor should be a reputable organisation and fi nancially 
stable because this vendor will need to provide future support for the solution.

   

Pastel uses a relational database to store a huge amount of accounting data.

userre
Sticky Note
have to go back to activity 1.3 after been done with study unit 2.
its a must dear....!!!!
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 • Make a note that you must return to topic 1 once you have mastered Pastel 
(topic 6) and consider the following:

 – In which fi les are the various types of information that are captured during 
each Pastel lesson stored?

 – What are the fi eld names in each fi le?
 – Which fi les are master fi les and which transaction fi les? What about 

reference fi les?
 – How are the various fi les interlinked?
 – How are the various fi les updated with the processing of each type of 

transaction?

8 Summary
In this study unit, we learnt about the database environment, the advantages and 
disadvantages of using a database environment and the components of this environment. 
We also gained an understanding of different database models, centralised and distributed 
databases and the terminology used in a relational database. We dealt with the factors 
to consider when choosing appropriate database management software and a database. 
In the next study unit, we will investigate the utilisation of databases in an organisation.

          

After working through this study unit, you should be able to answer the following 
questions:

(a) Name the components of the database environment.
(b) List the advantages and disadvantages of using a database environment.
(c) Name and defi ne four database environment users.
(d) List the responsibilities of the database administrator.
(e) Defi ne database management system (DBMS).
(f) List the functions of a DBMS.
(g) Name and describe the three levels in three-level database architecture.
(h) State the two key components of the DBMS
(i) Name and describe the different database languages.
(j) Briefl y explain the concept “data dictionary”. Your answer should include 

the data elements and the information contained in them.
(k) Defi ne a database and data model.
(l) List and describe fi ve database model types.
(m) Briefl y discuss the advantages and a disadvantage of using a relational 

database model type.
(n) Identify the uses of an object-oriented database.
(o) Identify the uses of a multidimensional database.
(p) Defi ne the terms “centralised database” and “distributed database”.
(q) Name and describe the two types of distributed databases.
(r) List and describe the two methods in which a distributed database may be 

updated.
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(s) Defi ne the following terms: data value, data fi eld, fi eld name, data record, 
primary data fi eld and foreign key.

(t) When provided with a representation of a database, would you be able to 
identify data values, data fi elds, fi eld names, data records, primary data 
fi elds and foreign keys?

(u) Defi ne a database fi le and list the types of database fi les.
(v) For each type of database fi le, defi ne the fi le and explain its role.
(w) List the factors to consider when choosing a DBMS and a database.

   

If you are interested in further reading, the following authors discuss the database 
environment, components of this environment, database models and relational 
database terminology extensively:

 •  Boczko, T. 2007
 •  Dull, RB, Gelinas, UJ & Wheeler, PR. 2010
 •  Hall, JA. 2011
 •  Rommey, MB & Steinbart, PJ. 2009
 •  Stair, R, Reynolds, G & Chesney, T. 2008
 •  Wessels, P, Grobbelaar, E, Mc Gee, A & Prinsloo, G. 2007
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3S T U D Y  U N I T  3

5Utilising databases

13In this study unit

6

1 Introduction
As the effi cient data and information storage and retrieval needs of organisations increased 
over the years, the use of databases to manage data and information has also increased. 
Databases are widely used in business nowadays and their utilisation can differ between 
organisations. In the previous study unit, we learnt about the database environment, 
its components and the terminology used in a relational database. In this study unit, we 
will briefl y discuss the utilisation of databases in accounting and auditing. We will also 
look at the use of databases in data warehouses, data marts and data mining and online 
analytical processing.

2 Databases in accounting and auditing
Finance departments as well as accounting and auditing fi rms use accounting software to 
record fi nancial transactions. Most fi nancial software uses databases to store and retrieve 
fi nancial data. For example, Pastel Partner software, which you will learn more about in 
topic 6, uses a relational database to store data. We will learn more about different available 
accounting information systems (AISs) in study unit 14.

As technology develop, the use of electronic audit fi les in audits has increased. These 
audit software applications use databases to store and retrieve data. Examples of audit 
software that uses databases to store data are CaseWare (http://www.cqs.co.za) and CCH 
TeamMate (http://www.arclogics.com/TeamMate_Home.aspx).

Many auditors also use Microsoft Access or IDEA data analysis software to interrogate 
their clients’ operational and fi nancial data. These interrogations may fi nd anomalies, 
exceptions and trends in datasets obtained from clients, which then helps them to perform 
sound quality risk-based audits.
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3 Data warehouse
Many organisations have multiple databases such as a database for fi nancial information, 
operational information, marketing and so forth. Because these databases are not linked, 
it becomes diffi cult and extremely cumbersome to analyse data when it is needed from 
more than one database. Some organisations also have massive databases. Running 
queries on these huge databases requires a great deal of processing, which may affect 
operations owing to the slowness of response times. Data warehouses have been created 
to overcome these problems.

A data warehouse is a database populated with current and historical data extracted 
from the organisation’s various databases. It may also contain data from external 
sources and/or databases.

Depending on the purpose of the data warehouse, it sometimes only contains summary 
information or only certain specifi c related data extracted from the various databases. The 
data warehouse is updated periodically, usually according to a predetermined frequency, 
from the various source databases. These updates can also happen as the source database 
is updated; the data warehouse is then referred to as a real-time data warehouse. Bear 
in mind that data cannot be modifi ed in the data warehouse. It can only be updated by 
the source databases, which means that any updates to data must be done in the source 
database. One could therefore say that a data warehouse is “read-only”.

As you can imagine, data warehouses are massive because they contain data from various 
databases. Running queries on the data warehouse can be painstakingly slow because 
of the size of the data warehouse.

The database model types normally used for data warehouses are relational or 
multidimensional.

A data warehouse is interrogated using reporting and query tools that analyse the data 
mainly for decision making and strategic planning. A data warehouse is the backbone for 
data mining and business intelligence software (BIS). Business intelligence software is 
discussed in study unit 19.

The security and integrity of the data warehouse are crucial because the data is used for 
strategic and operational decisions. The data warehouse should therefore be protected 
against industrial espionage and incorrect information.

4 Data mart
Owing to the size of data warehouses and the resulting slow updating and querying of the 
data warehouse, a need arose to be able to interrogate “smaller” data warehouses. This 
requirement gave rise to data marts.

A data mart is a smaller data warehouse extracted from the main data warehouse 
and contains specifi c related data extracted for a specifi c organisational user group 
such as the fi nance department or the marketing department.

The use of data marts makes running queries much quicker than running queries on the 
full data warehouse.
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5 Data mining
Data mining software is used to analyse data sets in order to uncover previously 
unknown trends, patterns and relationships between data.

These analyses can be used in decision making (including strategic decisions), forecasts, 
predicative modelling, fraud detection, risk management and so on. The data sets used 
in data mining are usually a data warehouse or a data mart, but data mining may also be 
performed on source databases. For example, an insurance company using data mining 
on its motorcar claims could uncover the fact that red cars with drivers younger than 25 
years are more likely to be involved in an accident. The company could use this information 
to correctly price insurance premiums for red motorcar drivers 25 years and younger.

Examples of data mining software include RapidMiner, R, SAS Enterprise Miner, 
IBM SPSS Statistics and IBM SPSS Modeller.

6 Online analytical processing (OLAP)
Online analytical processing (OLAP) software enables users to interactively 
and rapidly analyse large data sets from various viewpoints (ie OLAP can handle 
multidimensional queries).

Take the following question: How many pairs of red shoes were sold per month to persons 
aged 20 to 30 years? The multiple dimensions used in the query were product type (shoes), 
product colour (red), time period (month) and age (20–30 years). Because these data sets 
are usually multidimensional, they are stored in a multidimensional database, although some 
OLAP software is also compatible with relational databases. OLAP is used in business 
intelligence, budgeting, forecasting, management reporting and so on. IBM Cognos 8 
Business Intelligence and Oracle Database OLAP Option are examples of OLAP software.

7 Similarities and differences between OLAP and data mining
OLAP and data mining are similar, but technically different. Both are business intelligence 
tools that complement each other, and they are used in conjunction with each other. OLAP 
and data mining, however, operate differently on data. OLAP is mainly used to summarise 
data, say, per month and per region, the number of smart phones sold to persons aged 20 
to 30 years. Data mining is used to break down data in order to uncover trends, patterns 
and relationships. Data mining will be used to answer a question such as: What factors 
resulted in the increase in smart phone sales in Gauteng during September? OLAP and 
data mining are therefore used to answer different questions. Data mining will answer 
questions such as the following: Why have sales increased in Mpumalanga? or A person 
with what characteristics would be more likely to buy our product? OLAP is used to answer 
the following kind of questions: What is the value of motor accident claims for women 
driving green motorcars in Kwazulu-Natal by month? or What are the average sales of 
electric drills by month and by region?

8 Summary
In this study unit, we briefl y examined how databases are used in accounting and auditing. 
We also discussed data warehouses, data marts, data mining and OLAP.
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The next topic deals with how to develop and create spreadsheets to solve problems in a 
business and accounting context using appropriate formats, formulas and functions. We 
will also gain an understanding of the risks and controls associated with spreadsheets.

          

After working through this study unit, you should be able to answer the following 
questions:

(a) Identify examples of the uses of databases in an accounting and auditing 
environment respectively.

(b) Defi ne a data warehouse.
(c) Users can modify the data in the data warehouse. Is this statement true 

or false?
(d) Name a disadvantage of using a data warehouse.
(e) Identify the type of database model usually used for data warehouses.
(f) Identify the type of tools used to interrogate a data warehouse.
(g) Briefl y describe a data mart.
(h) Explain why we prefer to use a data mart instead of a data warehouse?
(i) Briefl y describe data mining.
(j) Identify the uses for data mining analyses.
(k) List examples of data mining software.
(l) Defi ne OLAP.
(m) Identify a use of OLAP.
(n) Identify the type of database model usually used for OLAP.
(o) List examples of OLAP software.
(p) Briefl y explain the similarities and differences between OLAP and data 

mining.

   

If you are interested in further reading, the following authors discuss the use of 
databases in data warehouses, data marts and data mining and online analytical 
processing extensively:

 •  Dull, RB, Gelinas, UJ & Wheeler, PR. 2010
 •  Hall, JA. 2011
 •  Rommey, MB & Steinbart, PJ. 2009
 •  Stair, R, Reynolds, G & Chesney, T. 2008
 •  Wessels, P, Grobbelaar, E, Mc Gee, A & Prinsloo, G. 2007 
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P A R T  2 

Spreadsheets

PURPOSE

The purpose of part 2 is to help you develop and create spreadsheets to solve problems 
in a business and accounting context and to understand the risks and controls associated 
with spreadsheets.

Study guide 1 Study guide 2

Part 1

Data 
management and 

utilisation

Part 2

Spreadsheets

Part 4

Management 
reporting systems

Part 3

Transaction 
processing

Topic 

1 Data 
managment 
and 
utilisation

Topic 
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Topic
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Topics 

3 Accounting 
cycles 
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reporting 
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5 Accounting 
informtion 
system 
applications 
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accounting 
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system
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To p i c  2 
Spreadsheets

LEARNING OUTCOMES

After studying this topic, you should be able to

 –  identify and explain basic spreadsheet principles and components
 –  explain the spreadsheet development process
 –  describe the characteristics of a user-friendly spreadsheet
 –  apply formatting to spreadsheets
 –  provide the structures of spreadsheet formulas and functions
 –  identify the applicable spreadsheet formula or function to use when solving business 

and accounting problems
 –  apply spreadsheet formulas and functions to solve business and accounting problems
 –  list the inherent risks of spreadsheet software
 –  describe the controls to minimise or address the risks of spreadsheet software
 –  apply security and privacy settings to Microsoft Offi ce Excel documents

Study guide 1 Study guide 2
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Bear in mind that this study guide, part 2, is based on Microsoft Offi ce Excel 
2007 and 2010, and you will need to make some adjustments if you are using 
Microsoft Offi ce Excel 2003 or Open Offi ce.

Also note that Microsoft Offi ce Starter 2010 – Excel Starter is a reduced functionality 
version of the full version of Microsoft Offi ce Excel and is not adequate for use 
in this study guide.

Note:  Screen shots of Microsoft Offi ce Excel 2007 and 2010 are used interchangeably 
where there are a few or no differences. When there are obvious differences, 
both Microsoft Offi ce Excel 2007 and 2010 screen shots will be provided and 
discussed.

Note:  Microsoft product screen shots are reprinted with the permission of Microsoft 
Corporation.
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4S T U D Y  U N I T  4 

7Creating user-friendly spreadsheets

16In this study unit

8

1 Introduction
Application software is programs that run on computer systems, which users utilise to 
perform specifi c tasks. Business applications are applications or software that help 
businesses to increase their productivity and users to perform specifi c tasks (eg they allow 
users to create and edit documents or reports to perform simple or complex calculations 
needed by the business).

Application software may consist of a single program such as a media player or a 
collection (often referred to as a software suite) of related but independent programs 
and packages that have a common user interface or shared data format, such as Microsoft 
Offi ce, which consists of a closely integrated word processor, spreadsheet, database and so 
on. The advantages of using a software suite include the fact that all the packages have a 
similar look and feel, making them easy to use, information can easily be transferred 
between all the packages and all the packages are installed in a single operation. An 
example of integration between the packages included in a software suite could be the 
creation of a spreadsheet with complex calculations, which can then be transferred to a 
word processor to form part of a detailed annual fi nancial report.
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Application software can be either off-the-shelf software or in-house developments.

In this study unit, we will examine the use of spreadsheets as a business application tool, 
more specifi cally Microsoft Offi ce Excel (MS Excel). In creating user-friendly spreadsheets, 
we will be looking at the basic principles of mathematics, signs/operators and components 
of a spreadsheet. Workbook basics will be discussed as well as operating and formatting 
workbooks, fi nishing off with printing and page layout.

2 Basic principles to revise before working on Microsoft Offi ce Excel

NOTE

For this module, you require certain pre-existing mathematical and accounting knowledge 
as well as the ability to apply that knowledge. Section 2 merely emphasises some basic 
mathematics, accounting and suchlike knowledge that you should already have.

2.1 Signs/operators
In some instances, Microsoft Offi ce Excel uses different signs/operators from those usually 
seen in mathematics. Always use the applicable Microsoft Offi ce Excel signs/operators 
and not the mathematical signs/operators when writing a Microsoft Offi ce Excel formula. 
The table below indicates the mathematical signs/operators with their associated Microsoft 
Offi ce Excel signs/operators:
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2.2 Order of operation
The order of operation is the sequence of computation that a formula follows to arrive at 
an answer. Microsoft Offi ce Excel uses the same order of operation as mathematics and 
it will therefore perform computations in the following sequence:

 •  fi rst:  computations/calculations in parentheses/brackets, no matter where they 
are in the formula

 •  second:  computations with exponents
 •  third:  computations involving multiplication (*) and division (/) from left to right
 •  fourth:  computations involving addition (+) and subtraction (–) from left to right

10 + 10 * 5 = ? What do you think the answer would be?

Microsoft Offi ce Excel will fi rst calculate 10 * 5 = 50 and then add the 10 to the answer, that is,
10 + 10 * 5 = 60

How do you write the formula if you want Microsoft Offi ce Excel to fi rst add the two 
10s together and then multiply the answer by 5? What do you think? According to the 
order of operation, we know Microsoft Offi ce Excel will fi rst perform computations 
in brackets/parentheses. By inserting the 10 + 10 in parentheses, Microsoft Offi ce 
Excel will calculate the amount and then multiply the answer by 5 because multiplication 
is third in the sequence and after parentheses. Your formula will thus change to
(10 + 10) * 5 = 100

In which order would Microsoft Offi ce Excel perform this formula?

150 + 150 / (2 + 12) *12 / 4 = 182.14

Sequence Formula Reason

1st (2 + 12) = 14 Computations/calculations in parentheses/
brackets, no matter where they are in the 
formula.

2nd 150 / 14 = 10.714 Computations involving multiplication (*) and 
division (/) from left to right. The 14 relates to 
the answer calculated in the 1st sequence.

3rd 10.714 * 12 = 128.568 Computations involving multiplication (*) and 
division (/) from left to right. The 10.714 relates 
to the answer calculated in the 2nd sequence.

4th 128.568 / 4 = 32.142 Computations involving multiplication (*) and 
division (/) from left to right. The 128.568 relates 
to the answer calculated in the 3rd sequence.

5th 150 + 32.142 = 182.142 Computations involving addition (+) and 
subtraction (-) from left to right. The 32.142 
relates to the answer calculated in the 4th 
sequence.
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         

Using the examples below, recalculate each formula and compare your answer 
with the answer provided. Keep trying, by using the order of operation in 2.2 
until you fi nd the same answer.

100 + 100 / 2 = 150 (100 + 100) / 2 = 100
25 * 4 / 2 + 10 = 60 25 * 4 / (2 + 10) = 8.333
150 + 150 / 2 + 12 * 12 / 4 = 261 (150 + 150) / 2 + 12 * 12 / 4 =186
(150 + 150) / (2 + 12) * 12 / 4 = 64.29

2.3 Changing the sign of an amount
To change the sign of an amount from a positive to a negative, or from a negative to a positive, 
the amount can be multiplied by -1. For example; +50 * -1 = -50 and -100 * -1 = +100.

2.4 Percentages (%)
If a whole cake is equal to 100% and you and 4 friends need to share it equally, each one 
of you will receive 20% of the cake. How did we calculate this? 1 person/5 persons, that 
is, 1/5 = 0.2 or 20%.

A percentage is a fraction in which one (1) equals the whole or 100%. In Microsoft Offi ce 
Excel and mathematics, 1 = 100% (100 / 100 = 1). Everything less than 1 (but more than 
0), is a % thereof. Please use the applicable fraction and not the percentage when working 
with percentages in Microsoft Offi ce Excel. For example:

% How to write it in Microsoft Offi ce Excel
33.33% 0.3333
100% 1
14% 0.14

When you see a cell on a spreadsheet refl ected as a percentage, always remember that the 
underlying value of the cell is still a fraction. The format of the cell (see section 8.1 in this 
study unit) was only changed to display the fraction as a percentage, but the underlying 
value did not change – that is, the underlying value of the fi fty percent (50%) in the cell is 
0.50. When you use a cell displaying a percentage format in any of your formulas/functions, 
DO NOT multiply or divide the value by 100.

2.5 Working with VAT percentage, gross profi t percentage and mark-up
You should be able to calculate amounts inclusive and exclusive of VAT, as well as the VAT 
amount itself, by using the applicable VAT percentage. You should also be able to calculate 
sales amounts, cost of sales and gross profi t, mark-up and gross profi t percentage. You 
can use the following formula, or any other formula you are comfortable with, to help you 
with these calculations:

  

The amount you need to calculate = the amount you need to calculate in 
percentage, divided by the amount you have in percent multiplied by the amount 
you have in rand.

Basic principles:

 •  Sales price excluding VAT + VAT = sales price including VAT



. . . . . . . . . . .
45 Stu d y unit  4

EXAMPLE 1: VAT

R % Microsoft Offi ce Excel 
underlying value

Selling price (excluding VAT) 500 100 1.00
VAT 70 14 0.14
Selling price (including VAT) 570 114 1.14

Calculate the selling price excluding VAT, using the selling price including 
VAT and the VAT percentage.

The amount you need in rand = the amount you need in % / the amount you 
have in % * the amount you have in rand.

 – The amount you need in % = 1.00 (you need to calculate the selling price 
excluding VAT).

 – The amount you have in % = 1.14 (you have the selling price including VAT).
 – The amount you have in R = R570 (you have the selling price including VAT 

in rand).
 – 1.00/1.14 * R570 = R500.

(Using mathematical rules, this formula can be simplifi ed to R570/1.14 = R500.)

Calculate the selling price including VAT using the selling price excluding 
VAT and the VAT %.

The amount you need in rand = the amount you need in % / the amount you 
have in % * the amount you have in rand.

 –  The amount you need in % = 1.14 (you need to calculate the selling price 
including VAT).

 –  The amount you have in % = 1.00 (you have the selling price excluding VAT).
 –  The amount you have in R = R500 (you have the selling price excluding VAT 

in rand).
 –  1.14/1.00 * R500 = R570.

(Using mathematical rules, this formula can be simplifi ed to 1.14 * R500 = R570.)

Calculate the VAT amount using the selling price including VAT and the VAT %.

The amount you need in rand = the amount you need in % / the amount you 
have in % * the amount you have in rand.

 –  The amount you need in % = 0.14 (you need to calculate the VAT amount).
 –  The amount you have in % = 1.14 (you have the selling price including VAT).
 –  The amount you have in R = R570 (you have the selling price including VAT 

in rand).
 –  0.14/1.14 * R570 = R70.

Calculate the selling price including VAT using the VAT amount and the VAT %.

The amount you need in rand = the amount you need in % / the amount you 
have in % * the amount you have in rand.

 –  The amount you need in % = 1.14 (you need to calculate the selling price 
including VAT).

 –  The amount you have in % = 0.14 (you have the VAT%).
 –  The amount you have in R = R70 (you have the VAT amount in rand).
 –  1.14/0.14 * R70 = R570.
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 

The business world uses the terms “mark-up” and “gross profi t margin” 
interchangeably, although there are differences between the two.

Mark-up, like gross profi t, is the difference between the selling price and cost 
price of an item.

Mark-up may be expressed either as a rand amount or as a percentage. If an 
item has a cost price of R100 and it sells for R150, then the mark-up is R50 if 
it is expressed in rand.

The mark-up margin of the item would be 50% (selling price [R150] minus cost 
[R100] divided by cost price [R100] of the item) if it is expressed as a percentage.

Gross profi t margin, however, is calculated as the difference between the 
selling price and cost price of an item, divided by the selling price of the item. 
Thus, as in the example above, the gross profi t margin of the item would be 
33% (selling price [R150] minus cost [R100], divided by selling price [R150] of 
the item), which is expressed as a percentage.

Basic principles:

 •  Gross profi t or mark-up = sales – cost of sales
 •  Sales = cost of sales + gross profi t or mark-up
 •  Mark-up margin (%) = mark-up/cost of sales
 •  Gross profi t margin (%) = gross profi t/sales

EXAMPLE 2: Mark-up and mark-up margin

The mark-up margin (percentage) in this example is 20%.

R % Microsoft Offi ce Excel underlying 
value

Cost of sales 1,580 100 1.00

Mark-up 316 20 0.20

Sales 1,896 120 1.20

     

Calculate the cost of sales amount, using the sales amount of R1,896 and 
the mark-up margin.

The amount you need in rand = the amount you need in % / the amount you 
have in % * the amount you have in rand.

 –  The amount you need in % = 1.00 (you need to calculate the cost of sales).
 –  The amount you have in % = 1.20 (you have the sales).
 –  The amount you have in R = R1,896 (you have the sales amount in rand).
 –  1.00/1.20 * R1,896 = R1,580.

(Using mathematical rules, this formula can be simplifi ed to R1,896/1.20 = 
R1,580.)
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Calculate the sales amount, using the cost of sales amount of R1,580 and 
mark-up margin.

The amount you need in rand = the amount you need in % / the amount you 
have in % * the amount you have in rand.

 –  The amount you need in % = 1.20 (you need to calculate the sales amount).
 –  The amount you have in % = 1.00 (you have the cost of sales).
 –  The amount you have in R = R1,580 (you have the cost of sales amount in 

rand).
 –  1.20 / 1.00 * R1,580 = R1,896.

(Using mathematical rules, this formula can be simplifi ed to R1,580 * 1.20 = 
R1,896.)

Calculate the mark-up amount, using the sales amount of R1,896 and mark-
up margin.

The amount you need in rand = the amount you need in % / the amount you 
have in % * the amount you have in rand.

 –  The amount you need in % = 0.20 (you need to calculate the mark-up amount).
 –  The amount you have in % = 1.20 (you have the sales).
 –  The amount you have in R = R1,896 (you have the sales amount in rand).
 –  0.20/1.20 * R1,896 = R316.

Calculate the sales amount, using the mark-up amount of R316 and mark-up 
margin.

The amount you need in rand = the amount you need in % / the amount you 
have in % * the amount you have in rand.

 –  The amount you need in % = 1.20 (you need to calculate the sales amount).
 –  The amount you have in % = 0.20 (you have the mark-up margin).
 –  The amount you have in R = 316 (you have the mark-up amount in rand).
 –  1.20/0.20 * 316 = R1,896.

EXAMPLE 3: Gross profi t and gross profi t margin

The gross profi t % in this example is 20%.

R % Microsoft Offi ce Excel underlying 
value

Cost of sales 2,000 80 0.80

Gross profi t 500 20 0.20

Sales 2,500 100 1.00
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     

Calculate the cost of sales amount, using the sales amount of R2,500 and 
the gross profi t %.

The amount you need in rand = the amount you need in % / the amount you 
have in % * the amount you have in rand.

 –  The amount you need in % = 0.80 (you need to calculate the cost of sales).
 –  The amount you have in % = 1.00 (you have the sales).
 –  The amount you have in R = R2,500 (you have the sales amount in rand).
 –  0.80/1.00 * R2,500 = R2,000.

(Using mathematical rules, this formula can be simplifi ed to 0.80 * R2,500 = 
R2,000.)

Calculate the sales amount, using the cost of sales amount of R2,000 and 
gross profi t %.

The amount you need in rand = the amount you need in % / the amount you 
have in % * the amount you have in rand.

 –  The amount you need in % = 1.00 (you need to calculate the sales amount).
 –  The amount you have in % = 0.80 (you have the cost of sales).
 –  The amount you have in R = R2,000 (you have the cost of sales amount in 

rand).
 –  1.00/0.80 * R2,000 = R2,500.

(Using mathematical rules, this formula can be simplifi ed to R2,000/0.80 = 
R2,500.)

3 How to solve a problem in Microsoft Offi ce Excel
Here are a few simple guidelines to keep in mind, before you start with your spreadsheet:

 •  Understand the business problem you are dealing with. What is the problem? What 
should I calculate? What is it based on? Which amounts do I have? What assumptions 
should I make?

 •  How will you solve/fi x the problem? Formulate your desired results.
 •  Plan your spreadsheet before you create it in Microsoft Offi ce Excel.
 •  Now go to Microsoft Offi ce Excel and prepare the spreadsheet in such a way that it will 

give you the required output/deliverable.
 •  Use neighbouring columns and rows when organising your information.
 •  Do not skip columns or rows just because you want to spread the information. Use the 

formatting functions instead.
 •  Use a single column at the left of the table for row headings.
 •  Use a single row at the top of the table for column headings.
 •  If your table requires a title, put it in the row above the column heading and in the same 

column as the row heading.
 •  Put all your assumptions/variables on the face of your spreadsheet. As far as possible, 

do not hard code any formulas, such as entering an amount or percentage in a formula. 
Instead, refer to a cell where the amount or percentage is displayed.

 •  Build in checks and balances where possible to ensure that the spreadsheet you 
created, functions correctly.

 •  Keep the spreadsheet logical.
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NOTE

Hint:

If you are struggling to write a formula using cell references, fi rst write the formula using 
amounts and replace the amount with the relevant cell reference.

4 Using Microsoft Offi ce Excel: regional settings

PLEASE NOTE

For reporting purposes, one should adhere to ISO31-0 (International Organisation for 
Standardisation) used in South Africa, where the thousands separator is a space (“ “) and 
the decimal separator is a comma (,).

For example: 8 355 214
 1 234,81
 R 235 789,19

However, when using Pastel Accounting and spreadsheets (Microsoft Offi ce Excel or 
OpenOffi ce Calc) for AIN2601 purposes, you will need to ensure that your computer’s 
regional settings are set up as follows to ensure standardisation of spreadsheet formulas 
and functions:

When using a computer with Windows Vista or Windows 7:

 •  Click on the Start button at the bottom left-hand corner of the computer screen and 
then click on Control Panel.
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 •  Windows Vista users:

 –  On the left-hand side of the Control Panel window, click on Classic View. Double 
click on the Regional and Language Options icon.

 –  Select the Formats tab, make sure that the Current Format is English (South 
Africa) and click on the Customize this format button.
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 •  Windows 7 users:

 –  On the top right-hand corner, click on the drop down arrow next to View by and 
select Small icons. Double click on the Regional and Language Settings icon.

 –  Select the Formats tab, make sure that the Format is English (South Africa) and 
click on the Additional settings button.
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Numbers tab:

Currency tab:
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 •  After changing the Decimal symbol, Digital grouping symbol and List separator 
according to the instructions above, click on the Apply button for these settings to 
take effect.

In AIN2601, numbers and currency will be formatted as follows:

For example: 8,355,214
 1,234.81
 R 235,789.19

Note:  The reason for the above deviations from the accepted standard used in South 
Africa as mentioned above, is to

 •  ensure the standardisation of spreadsheet formulas and functions in this course
 •  increase the user friendliness of spreadsheets (eg the displayed amounts are easier 

to read)

See section 8 in this study unit for worksheet and cell formatting.

PLEASE NOTE

If information is used for most formal reporting purposes, the above-mentioned ISO 
standard should be used.

 

You should perform all the activities included in this study unit to familiarise 
yourself with Microsoft Offi ce Excel. By performing these activities, you will  
learn the basics of Microsoft Offi ce Excel. You will need to know these basics 
when commencing the subsequent study units in this topic because this 
information will not be discussed in detail later on.

Note:  These are not manual exercises. You actually need to do them on 
a computer!

5 Background

5.1 What is a spreadsheet
A spreadsheet is a grid of columns and rows that cross (intersect), much like a chessboard. 
Columns appear vertically and are identifi ed by a letter (say, A, B, C, etc), while rows appear 
horizontally and are identifi ed by a number (say, 1, 2, 3, etc). Where a column and a row 
intersect, a cell is formed. Each cell has a unique address based on the specifi c column 
and row in which it can be found. A cell’s reference is always expressed as fi rst the column 
reference and then the row reference. Cell B6, for example, refers to a cell found where 
column B and row 6 intersect. B6 is known as a cell reference. A cell address can never 
change, but the data entered in a cell can change.
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5.2 Components and layout of a spreadsheet
When working in Microsoft Offi ce Excel, you can have many fi les or workbooks. Each fi le 
can have many separate sheets called worksheets. They are identifi ed as Sheet1, Sheet2, 
Sheet3 and so on. (Since the terms “workbook” and “fi le” mean the same thing, you can 
use either term when working with spreadsheets.)

The most recognisable difference between a word-processing document and a spreadsheet 
is that the spreadsheet uses rows and columns. Numerical data entered into a spreadsheet 
is easier to read, understand and manipulate when presented in rows and columns. Another 
major advantage of using a spreadsheet is that complicated calculations can be done 
with the use of formulas and functions, whereas this is not possible in a word processing 
document.
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Below is a typical Microsoft Offi ce Excel 2007 spreadsheet layout.

Below is a typical Microsoft Offi ce Excel 2010 spreadsheet layout.
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A selection of the spreadsheet components (Active cell, Ribbon, Dialogue box launcher, 
Offi ce button (Microsoft Offi ce Excel 2007) and Quick access toolbar) will now be explained 
in more detail.

5.3 Active cell
A cell becomes active when you select/click on that cell. The active cell is outlined in black 
and the headings for the column and the row in which the cell is located, are highlighted. 
In the example above, a cell in column B in row 2 was selected. The headings in column 
B and row 2 are highlighted, and cell B2 is outlined. The outlined cell and the highlighted 
column and row headings make it easier to see that cell B2 is the active cell. The cell 
reference of the active cell (B2 in this example), will also appear in the Name Box in the 
upper-left corner of the worksheet. Note that anything you type or any function you insert 
will be entered or inserted into the active cell.

5.4 Ribbon
The Ribbon, which is new to Microsoft Offi ce Excel 2007 and is also used in Microsoft 
Offi ce Excel 2010, has three basic components: Tabs, Groups and Commands. This 
provides the user with a graphical interface to work with in Microsoft Offi ce Excel.

 •  Tabs. The seven tabs (Home, Insert, Page Layout, Formulas, Data, Review and View) 
each represent core tasks in Excel. The commands on the Home tab are those that 
Microsoft identifi ed as the most commonly used when you do basic tasks in worksheets. 
Tabs are similar to the Menu bar in Microsoft Excel 2003.

 •  Groups. Each tab has different groups that show related commands together. Groups 
are similar to the different Toolbars in Microsoft Excel 2003.

 •  Commands. This is a button or a menu. Commands are attached to pictures (called 
icons), that help you to easily recognise the command you want to use. Each icon 
performs a particular command when you click on it with the mouse. (Hint: Hovering 
with your mouse pointer over an icon/command, will make the description of the icon 
appear.)

The commands on the Ribbon are the ones most commonly used. Microsoft Offi ce 
Excel 2007 and 2010 show some commands based on the tab and/or object you selected, 
instead of showing every command all the time. For example, if your worksheet does not 
have a chart, the commands needed to work with charts, are not visible. However, once a 
chart has been created, the Chart Tools will appear, with three tabs: Design, Layout and 
Format. When you complete the chart and click outside the chart area, the Chart Tools 
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tabs go away. To get the tabs back, click inside the chart and the tabs reappear. (Creating 
and editing charts will be explained in detail in section 6 in study unit 5.)

Do not worry if all the commands are not visible all the time because they will appear as 
soon as you have taken the fi rst step.

5.5 Dialog Box Launcher       
When you see the Dialog Box Launcher arrow in the 
lower-right corner of a group, there are more options 
available for that group. When you click on the arrow 
with your mouse, it will open a dialog box or a task pane.

5.6 Microsoft Offi ce Button  and File tab 
In Microsoft Offi ce Excel 2007, the Microsoft Offi ce Button (Offi ce Button) in the 
upper-left corner of the window will open a menu with commands that may be used to 
open, save, print, send and close your workbooks/fi les. The Excel Options button at the 
bottom of the menu will give you access to set options such as cell reference style, or 
display options.

In Microsoft Offi ce Excel 2010, the File tab in the upper-left corner of the window will 
open a menu with commands used to open, save, print, send and close your workbooks/
fi les. Options included in the File tab menu, will give you access to set options.

Note that the Microsoft Offi ce Button found in Microsoft Offi ce 2007 has been replaced 
by File in Microsoft Offi ce Excel 2003 and 2010.

5.7 Quick Access Toolbar 
The commands on the Quick Access Toolbar are always visible. You can add commands 
you often use, to this toolbar by right-clicking on the command/icon you want to add and 
click on Add to Quick Access Toolbar. To remove a button from that toolbar, right-click 
the button on the toolbar, and click Remove from Quick Access Toolbar.

6 Workbook basics
We will now take you through various activities to help you understand workbook basics.

6.1 Starting a workbook
You will be able to start working with Microsoft Offi ce Excel by following these steps:

         

 •  Click on the Windows start icon/button.
 •  Select Programs.
 •  Select Microsoft Offi ce.
 •  Select Microsoft Offi ce Excel 2007 or select Microsoft Offi ce Excel 2010.

OR

 •  Select the Microsoft Offi ce Excel icon from your computers’ desktop if it is 
visible.
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The Microsoft Offi ce Excel window with a full size workbook window will open. 
The workbook will be displayed in the same way as discussed under the layout 
of the workbook. The workbook will contain a fi le titled “Book 1”.

6.2 Saving a fi le

        

The use of Microsoft Offi ce Excel 2007 and 2010 is discussed separately in 
activity 4.3.

Microsoft Offi ce Excel 2007:

 •  Click on the Offi ce Button.
 •  Click on the arrow next to Save As.
 •  This will open the Save As menu options.

 –  Saving the workbook as an 
Excel Workbook, will save 
the fi le in Excel 2007 format. 
Selecting Excel 97–2003 
Workbook will save the 
workbook in Excel 2003 
format. Please note that you 
will need to download and 
install a Compatibility Pack in 
order to use Microsoft Offi ce 
2007 documents in Microsoft 
Offi ce 2003. You can visit the 
Microsoft website for more 
information, or to download 
the Compatibility Pack.  

 •  Select Excel Workbook. This will open the Save As dialogue box.
 •  Beside Save In:, select the folder where the workbook/fi le should be saved.
 •  Type the name of the fi le (“Test01”) into the fi le name’s text box, which is 

beside File name. (You will be typing over/replacing the default fi le name 
Book1.xlsx.)

 •  Click the Save button.
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PRACTICAL HINTS:

 •  Create separate folders (in a logical place), for example, create a folder for all your 
AIN2601 fi les.

 •  Use descriptive fi le names.
 •  When creating a fi le, consider its compatibility with the Excel versions used by other users 

to whom you would like to send the fi le or with whom you would like to share the fi le.

Microsoft Offi ce Excel 2010:

 •  Click on the File tab.
 •  Click on Save As.
 •  This will open the Save As dialog box.

OR

 •  Click on the File tab.
 •  Click on Save & Send.
 •  This will open the Save & Send menu options.
 •  Click on Change File Type.

 –  Saving the workbook as an Excel Workbook will save the fi le in Excel 
2010 format. Selecting an Excel 97–2003 Workbook will save the 
workbook in Excel 2003 format. Note that you will need to download 
and install a Compatibility Pack in order to use Microsoft Offi ce 2010 
documents in Microsoft Offi ce 2003. You can visit the Microsoft website 
to fi nd more information or to download the Compatibility Pack.
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 •  Select Excel Workbook. This will open the Save As dialogue box.
 •  Beside Save In:, select the folder in which the workbook/fi le should be saved.
 •  Type the name of the fi le (“Test01”) into the fi le name’s text box, which is 

beside File name.

(You will be typing over/replacing the default fi le name Book1.xlsx.)

 •  Click the Save button.

6.3 Close a fi le and exit Microsoft Offi ce Excel
(a) Only close the fi le you are working in while Microsoft Offi ce Excel is still open.

        

 •  Click on the Offi ce Button (2007) or File tab (2010).
 •  Select Close.
 •  Select Yes to save the changes.
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(b) Close the fi le as well as Microsoft Offi ce Excel.

        

 •  Click on the Offi ce Button (2007) or File tab (2010).
 •  Select Exit Excel (lower right-hand corner).
 •  Select Yes to save the changes.

Shortcut

 •  Closing only the fi le – click on the X in the right-hand corner of the tab bar.
 •  Closing the fi le and Microsoft Offi ce Excel – click on the X in the right-hand 

corner of the title bar.

NOTE

Always ensure that you click Yes to save the changes you have made (i.e. if you wish to 
keep the changes).

Before you start the next section, start Microsoft Offi ce Excel and open the existing 
workbook fi le “Test01”.

6.4 Naming/renaming worksheets

        

 •  On the Sheet tab bar, right-click on the sheet tab for Sheet1.
 •  Click on Rename. Sheet1 will now be highlighted.
 •  Type the name “test”.
 •  Press Enter.

Shortcut

 •  Double click on Sheet1.
 •  Type the name “test”.
 •  Press Enter.
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6.5 Inserting worksheets

        

 •  Click on the Home tab.
 •  In the Cells group, click on the arrow below Insert.
 •  On the drop-down menu click on Insert Sheet.

A new Worksheet, called Sheet4, will be added to your workbook.

Shortcut

 •  Click on the Insert worksheet icon, or
 •  Press Shift + F11.

6.6 Inserting columns or rows
To insert a single column, click on any cell in the column immediately to the right of 
where you want the new column to be inserted, and click on the applicable command.

        

 •  On the sheet named “test”, enter “Old column B” in cell B1 and “Old 
column C” in cell C1.

 •  Click on any cell in column C (e.g. C2).
 •  Click on the Home tab.
 •  In the Cells group, click on the arrow below Insert.
 •  On the drop-down menu click on Insert Sheet Columns.
 •  The spreadsheet will appear as follows:
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To insert a single row, click on any cell in the row immediately below where 
you want the new row to be inserted, and click on the applicable command.

        

 •  On sheet 2, enter “Old row 2” in cell A2 and “Old row 3” in cell A3.
 •  Click on any cell in row 3 (e.g. A3).
 •  Click on the Home tab.
 •  In the Cells group, click on the arrow below Insert.
 •  On the drop-down menu, click on Insert Sheet Rows.
 •  The spreadsheet will appear as follows:

6.7 Deleting worksheets

        

 •  Click on sheet 3 (the worksheet you want 
to delete).

 •  Click on the Home tab.
 •  In the Cells group, click on the arrow 

below Delete.
 •  Click on Delete Sheet.

Sheet3 will be deleted.

Shortcut

 •  Click on the tab of the sheet you wish 
to delete (Sheet 3 in this instance).

 •  Right click and select Delete.
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6.8 Deleting columns or rows
To delete a single column, click on any cell in that column and click on the applicable command.

        

 •  On sheet named “test”, click on any cell in column C.
 •  Click on the Home tab.
 •  In the Cells group, click on the arrow below Delete.
 •  On the drop-down menu, click on Delete Sheet Columns.
 •  The spreadsheet will now appear as follows:

To delete a single row, click on any cell in that row and click on the applicable command.

        

 •  On sheet 2, click on any cell in row 3.
 •  Click on the Home tab.
 •  In the Cells group, click on the arrow below Delete.
 •  On the drop-down menu, click on Delete Sheet Rows.
 •  The spreadsheet will now appear as follows:

6.9 Moving around in a spreadsheet
Besides using the mouse to move around in a spreadsheet, the following keyboard keys 
can also be used:

 •  CTRL + HOME Move the active cell to A1.
 •  CTRL + END  Move the active cell to the last used cell (right bottom) in the 

worksheet.
 •  END + → Move to the last column.
 •  END + ↓ Move to the last row.
 •  Page Up Move one screen up.
 •  Page Down Move one screen down.
 •  F5 Allows you to specify the cell reference to go to.
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6.10 Selecting a worksheet range

        

 •  Anchor the cell pointer:

 –  Click in Cell A1.
 –  Press and hold the mouse button (left button) in Cell A1.

 •  Highlight the range A1:D4.

 –  While holding down the mouse button, drag across the worksheet to 
Cell D4.

 •  Release the mouse button.
 •  The address of the range you have just highlighted is A1:D4.

7 Operating the workbook

7.1 Entering data
(a) Entering numbers

        

 •  Click in Cell A1.
 •  Enter the number “12345678”.        
 •  Press Enter.

(b) Entering text

If the fi rst character you enter is a letter, Microsoft Offi ce Excel automatically precedes the 
entry with a label-prefi x character (‘). If you wish to enter numbers as a label, you should 
start your entry with a label-prefi x character (‘). For example, if 007 is entered as a number, 
it will display as 7, but if it is entered with a label-prefi x character ‘, and thereafter 007, it 
will be displayed as 007.
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          

 •  Click in Cell A2.
 •  Enter the text “Spreadsheet”.
 •  Click in Cell C2.
 •  Enter the value “50 000” as a label.
 •  Press Enter.

7.2 Editing data
Data can be corrected in two stages:

(a) Correcting errors while data is being entered

        

 •  Click in Cell A5.
 •  Enter the text “DECENBER” (do not press Enter).

You realise you have misspelt the word DECEMBER.

 •  Click with the mouse pointer to the left of the character N.
 •  Press the Delete key.
 •  Type the character M.
 •  Confi rm the entry by pressing Enter on the keyboard.

(b) Correcting errors after data has being entered

        

 •  Click in Cell A6.
 •  Enter the text “DECENBER”.
 •  Confi rm the entry by pressing Enter on the keyboard.

You realise that you have misspelt the word DECEMBER.

 •  Double click with the mouse pointer on the word or press F2.
 •  Click with the mouse pointer to the left of the character N.
 •  Press the Delete key.
 •  Type the character M.
 •  Confi rm the entry by pressing Enter on the keyboard.
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7.3 Removing data

        

 •  Click in Cell A1.
 •  Select range A1:J10 with the mouse.
 •  Press the Delete key.

7.4 Copying data

        

 •  Click in Cell A1.
 •  Type the text JANUARY.
 •  Click in cell A2.
 •  Type the text FEBRUARY.
 •  Select range A1:A2 with the mouse.
 •  Click on the Home tab.
 •  In the Clipboard group, click on Copy.   

Note:  The range contents will be placed on the CLIPBOARD, which is a 
temporary storage area.

 •  Click on C1, the destination cell.
 •  Click on the Home tab.
 •  In the Clipboard group, click on Paste.   
 •  The data is copied to the new destination and will appear as follows:

Note:  When you copy data, you will not remove the data from the cell, but 
merely make a copy. The copy will be pasted in another location. When 
the contents of the cell have been pasted, it overwrites the existing cell 
content where it was pasted.

Shortcut

 •  Copy: Press CTRL + C simultaneously.
 •  Paste: Press CTRL + V simultaneously.

7.5 Moving of text

        

 •  Select range A1:A2 with the mouse.
 •  Click on the Home tab.
 •  In the Clipboard group, click on Cut.
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Note:  The range contents will be placed on the CLIPBOARD, which is a 
temporary storage area.

 •  Click on E1, the destination cell.
 •  Click on the Home tab.
 •  In the Clipboard group, click on Paste.
 •  The data is moved to the new destination and will look like this:

Note:  When you cut data, you will remove the data from the cell and paste it 
in another location. When the contents of the cell have been pasted, it 
overwrites the existing cell contents.

Shortcut

 •  Cut: Press CTRL + X simultaneously.
 •  Paste: Press CTRL + V simultaneously.

8 Workbook and cell formatting
Every time a new fi le is created, the default setting is applicable. If you exit the program 
and return to it, the settings in the dialog will be the default settings.

8.1 Cell formatting
The best way to understand 
the way these settings work 
is to enter data in a range 
and see what happens if the 
settings in the dialog box are 
changed. You can either use 
an icon on the Home tab in 
the Fonts, Alignment and 
Number groups, or click on 
the Dialog Box Launcher 
in one of these groups to 
open the Format Cells 
dialog box shown on the 
right.

Using your mouse to right 
click on a cell and selecting 
Format Cells, will also open 
this dialog box.

We will now cover the more 
frequently used formatting 
options.
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         

 •  Open a New Workbook.

Do not change any of the columns’ widths before being instructed to do so.

 •  In cell A1, enter “Microsoft Excel Formats”.
 •  In cell A2, enter “JANUARY”.
 •  In cell A3, enter “Format cells”.
 •  In cell B2, enter 100000.
 •  In cell B3, enter 50000.
 •  In cell B5, enter 0.02.
 •  In cell B6, enter 2.
 •  In cell C2, enter 80000.
 •  In cell C3, enter 6500.54.

(a) Number formatting

Use number formatting to differentiate one kind of numeric data from another for example, 
currency (R), percentage (%) and so forth. There are different ways to access the different 
options needed.

           

 •  Select cell B2.          
 •  Click on the Home tab on the 

Ribbon.
 •  In the Number group, click on 

Comma Style icon.
 •  Select cell B3.
 •  Click on the Home tab on the 

Ribbon.
 •  In the Number group, click on the 

arrow next to the Accounting Number Format icon. In the drop-down menu, 
select R English (South Africa).

 •  Select cell C2.
 •  Click on the Home tab on the Ribbon.
 •  In the Number group, click on the Dialog Box Launcher arrow. This will 

open the Format Cells dialog box.
 •  Select the Number tab.
 •  Under Category, select Number.
 •  Select three decimal places, tick the 1 000 separator and leave the negative 

numbers on the fi rst option (-1,234.210).
 •  Select OK to change the format.
 •  Select cell C3.
 •  Right click on your mouse and select Format Cells.
 •  Select the Number tab.
 •  Under Category, select Currency
 •  Under Symbol, select $ English (US).
 •  Select one decimal place and leave the negative numbers on the fi rst option 

(-$1,234.1).
 •  Select OK to change the format.
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 •  Select cell B5.
 •  Click on the Home tab on the Ribbon.
 •  In the Number group, click on Percent Style icon.
 •  Select cell B6.
 •  Click on the Home tab on the Ribbon.
 •  In the Number group, click on the Dialog Box Launcher arrow. This will 

open the Format Cells dialog box.
 •  Select the Number tab.
 •  Under Category, select Percentage.
 •  Select two decimal places.
 •  Click on OK.

Did cell B5 or B6 refl ect 2% after the % format had been applied to it?

Cell B5’s value was entered as 0.02.

It is VERY important to remember that the underlying value of a cell formatted 
as a % is a fraction – that is, the underlying value of cell B5 is 0.02 and not 2, 
and the underlying value of cell B6 is 2, and not 200 in Microsoft Offi ce Excel. 
See section 2.4 in this study unit.

(b) Alignment of data

This will give you various options in Text alignment, Text control and Text direction.

            

Merge combines the selected cells into one cell.

 •  Select range A1:C1.
 •  Click on the Home tab on the Ribbon.
 •  In the Alignment group, click on the arrow next to the Merge & Centre.
 •  On the drop-down menu, select Merge & Centre.

Wrap text makes all the contents in a cell visible, displaying it on multiple lines.

 •  Select range A2:A3.
 •  Click on the Home tab on the Ribbon.
 •  In the Alignment group, click on the Wrap text icon.
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(c) To change fonts and attributes

Under the Font tab, you will see some of the following default settings for the workbook 
(your default settings may differ from what is shown below):

 •  Font name: Arial
 •  Font style: Regular
 •  Size: 10
 •  Colour: Automatic
 •  Underline: None

Under this tab, you can change any of the above-mentioned settings and add bold, italics 
and underlining to the text.

           

 •  Select cell A1.
 •  Click on the Home tab on the Ribbon.
 •  In the Font group, click on the arrow next to the Font box.
 •  On the drop-down menu, select Comic Sans MS.
 •  In the Font group, click on the arrow next to the Font size box.
 •  On the drop-down menu, select 12.
 •  In the Font group, click on the Bold icon.
 •  Select range A2:C6.
 •  In the Font group, click on the Dialog Box 

Launcher arrow. This will open the Format 
Cells dialog box.

 •  Select the Font tab.
 •  Under Font, select Arial.                                
 •  Under Size, select 11.
 •  Select OK to change the format.

(d) Borders

You can frame the data with borderlines and different 
edges.

           

 •  Select cell B3.
 •  Click on the Home tab on the Ribbon.
 •  In the Font group, click on the arrow next 

to the Border icon.
 •  On the drop-down menu (shown on the 

right), select the Bottom Double Border 
icon.

 •  Select cell C3.
 •  Click on the Home tab on the Ribbon.
 •  In the Font group, click on the arrow next 

to the Border icon.
 •  On the drop-down menu, select the Top 

and Double Bottom Border icon.
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(e) Fill

Here you can set the background colour and pattern of the cells selected. (Do not change 
any of these for this activity.)

(f) Protection

Here you can lock cells, so that they cannot be changed when a worksheet is protected. 
(Do not change any of these for this activity.)

Protection and spreadsheet security will be dealt with in detail in study unit 6

        

 •  Your results for activity 4.20 should appear as follows:
      

8.2 Column width
The column width should be set to fi t the largest set of 
characters in a cell. If you see the following in a cell 
######## (hashes), it means the column width is too small.

There are two ways of correcting this problem:

 •  Using an icon/command

 –  Click on the Home tab on the Ribbon.
 –  In the Cells group, click on the arrow below the 

Format icon.
 –  On the drop-down menu, select Column Width and 

increase the column width until the data appears

       OR

 •  Using the mouse (method 1)

 –  Move the mouse pointer to the letter “B” of the 
column header.
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 –  Point to the right of the column border.
(The mouse pointer changes to a black two-headed vertical arrow.)

 – Click the mouse and drag to the right to increase the width of the column (while still 
holding in the mouse button), or to the left to decrease the column width.

 •  Using the mouse (method 2)

 –  Move the mouse pointer to the letter “B” of the column header.
 –  Point to the right of the column border.

(The mouse pointer changes to a black two-headed vertical arrow.)
 –  Double click the mouse to fi t the largest data cell.

The data will now be displayed without hashes.

8.3 Row height
The row height should be set to fi t the largest set of characters in a cell. If you cannot see 
all the text in a cell, it means the row height is too small. For example:

There are two ways to correct this problem:

 •  Using an icon/command

 –  Click on the Home tab on the Ribbon.
 –  In the Cells group, click on the arrow below the Format icon.
 –  On the drop-down menu, select Row Height and increase the row height until the 

data appears.

 •  Using the mouse (method 1)

 –  Move the mouse pointer to the number “1” of the row header.
 –  Point to the bottom of the row border.

(The mouse pointer changes to a black two-headed horizontal arrow.)
 –  Click the mouse and drag down to increase the height of the row (while still holding 

in the mouse button) or drag upwards to decrease the row height.

 •  Using the mouse (method 2)

 –  Move the mouse pointer to the number “1” of the row header.
 –  Point to the bottom of the row border.

(The mouse pointer changes to a black two-headed horizontal arrow.)
 –  Double click the mouse to fi t the largest data cell.

The data will now be displayed in full.
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9 Printing and page layout

9.1 Print area
This defi nes/selects the area of a worksheet you want to print. Always defi ne the area 
you want to print before you continue with the rest of the page setup (see section 9.2 in 
this study unit).

         

 •  Select the area you want to print (as you would select a range).
 •  Click on the Page Layout tab on the Ribbon.
 •  In the Page Setup group, click on the arrow below the Print Area icon.
 •  On the drop-down menu, select Set Print Area.

       

9.2 Page setup
Setting the layout 
of a worksheet that 
needs to be printed, 
can be done by either 
using the

 •  applicable tab 
and icon on the 
Ribbon, or

 •  Page Setup 
dialog box by 
clicking on the 
Dialog Box 
Launcher arrow 
in the Page 
Setup group on 
the Page Layout 
tab.

The Page Setup dialog box will appear as shown on the right.
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(a) Page

 •  Orientation

Orientation is used to set whether you want to print the printed worksheet in a portrait or 
landscape format.

Ribbon: 

Page Layout tab

Dialog Box Launcher: 

Page Setup dialog box

 •  Click on the Page Layout tab.
 •  In the Page Setup group, click on the 

arrow below the Orientation icon.
 •  On the drop-down menu, select either 

Portrait or Landscape.

 •  Select the Page tab in the Page Setup 
dialog box.

 •  Click on either the Portrait or Landscape 
option button.

 –  Leave the default selection.

 •  Scaling

Scaling is used to set the width or height of a printed worksheet to a maximum number 
of pages or to stretch or shrink the printed worksheet to a percentage of its actual size.

Ribbon: 

Page Layout tab

Dialog Box Launcher: 

Page Setup dialog box

 • Click on the Page Layout tab.
 • In the Scale to Fit group

 – by clicking on the arrow next to Scale 
you can increase or decrease the 
size in relation to the normal size.

 – by clicking on the arrow next to 
Width you can defi ne over how many 
pages wide you want to print the 
selected area.

 – by clicking on the arrow next to 
Height, you can defi ne over how 
many pages tall you want to print 
the selected area.

 • Select the Page tab in the Page Setup 
dialog box.

 • By selecting “Adjust to” you can 
stretch or shrink the printed worksheet 
to a percentage of its actual size.

 • By selecting “Fit to”, you can reduce 
the width and/or the height of the printed 
worksheet to fi t a maximum number of 
pages wide and/or tall. For example, 
if you set both wide and tall to 1, your 
selected print area will print the print 
area set in section 9.1 in this study unit, 
to one page only.

 –  Leave the default selection.
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 •  Paper size

Select the size of paper you are printing to.

Ribbon: 

Page Layout tab

Dialog Box Launcher: 

Page Setup dialog box

 • Click on the Page Layout tab
 • In the Page Setup group, click on the 

arrow next to the Size icon
 • On the drop-down menu, select the 

applicable paper size

 • Select the Page tab in the Page Setup 
dialog box.

 • Select the applicable paper size from 
the drop-down menu.

 –  Select A4 .

(b) Margins

Here you can change the margin size of the printed worksheet.

Ribbon: 

Page Layout tab

Dialog Box Launcher: 

Page Setup dialog box

 • Click on the Page Layout tab.
 • In the Page Setup group, click on the 

arrow next to the Margin icon.
 • On the drop-down menu, select the 

applicable margins, or select Custom 
Margins to open the Page Setup dialog 
box

 • Select the Margins tab in the Page 
Setup dialog box.

 • Increase or decrease the margins to 
the required size.

 –  Select Normal margins.

(c) Header/footer

Headers or footers can be included to provide useful information in your worksheet printouts 
such as page numbers, the date and time and the fi le name, or other predefi ned information.

Ribbon: 

Insert tab

Dialog Box Launcher: 

Page Setup dialog box

 • Click on the Insert tab. 
 • In the Text group, click on the Header 

& Footer icon.
 • Click the left, centre, or right header or 

footer text box at the top or at the bottom 
of the worksheet page. 

 • Type the text you want.
 • Clicking on any of the text boxes, will 

display the Design tab.
 • On the Design tab, in the Header 

& Footer Elements group, click the 
element that you want to include.

 • Select the Header/Footer tab in the 
Page Setup dialog box. 

 • Include the applicable Header and or 
Footer.

 – Include your name as a Header.
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 –  Include the page number as a Footer, by clicking on Page number icon on the Design 
tab, in the Header & Footer Elements group.

To return to Normal view, click on the View tab. 
In the Workbook Views group, click on the Normal icon.

(d) Sheet gridlines and Row and Column headings

Gridlines, row headings (1, 2, 3, etc) and column headings (A, B, C, etc) are displayed 
by default in Page Layout view, but they are not printed automatically when printing a 
worksheet. To print the gridlines and/or row and column headings, do the following:

Ribbon: 

Page Layout tab

Dialog Box Launcher: 

Page Setup dialog box

 • Click on the Page Layout tab.
 • In the Sheet Options group:

 – Tick Print under Gridlines to print 
gridlines.

 – Tick Print under Headings to print 
row and column headings.

 • Select the Sheet tab in the Page Setup 
dialog box.

 • Under Print
 – Click on Gridlines to print gridlines.
 – Click on Row and column headings 

to print the headings.
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9.3 Print and Print preview

           

The use of Microsoft Offi ce Excel 2007 and 2010 is discussed separately in 
activity 4.21.

Microsoft Offi ce Excel 2007:

 •  Click on the Offi ce Button.
 •  Select Print.
 •  Select Print Preview.

 –  In this view you can see what your worksheet will look like when it is 
printed on paper.

 –  Select Close Print Preview to close the window and return to your 
worksheet.
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           

Microsoft Offi ce Excel 2007 (contd):

 •  Click on the Offi ce Button.
 •  Select Print.
 •  The Print dialog box will appear, with the following options:

 •  “Printer”

 –  To which printer do you want to print your document?
 –  Leave the default selection.

 •  “Print range”

 –  Defi ne if you want to print everything (All) or just certain pages (Pages: 
From – To).

 –  Leave the default selection.

 •  “Copies”

 –  Set the number of copies you want to print.

 •   “Print what”

 –  Active Sheet (print the sheet that is displayed).
 –  Entire workbook (print all the sheets in the fi le).
 –  Selection (print only the range you have selected).

 •  Select the Preview button to see the print online, or
 •  Select OK to print.
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           

Microsoft Offi ce Excel 2010:

 •  Click on the File tab.
 •  Select Print.
 •  This will open the following Print options and settings:

 •  The print preview is automatically displayed on the right-hand side of the 
screen.

 •  “Print”
 –  Click on the Print button to print.

 •  “Copies”
 –  Set the number of copies you want to print.

 •  “Printer”
 –  To which printer do you want to print your document?
 –  Leave the default selection.
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           

Microsoft Offi ce Excel 2010 (contd):

 •  “Settings”

 –  Under Settings, the following print settings appear:

Refer to the drop-down menus below when the arrows on the right-hand side 
of the settings are clicked.

 •  The main settings include the following:

 – What to print:

◊  Click on the fi rst arrow next to the Print Active Sheets.
◊  Active sheet (print the sheet that is displayed)
◊  Entire workbook (print all the sheets in the fi le)
◊  Selection (print the range you have selected)

 – Pages

◊  Defi ne the range of pages you want to print – either print everything 
or only certain pages (Pages: ? to ? ).

◊  Leave the default selection.

 – Page orientation

◊  Select either Portrait or Landscape.
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10 Summary
In this study unit we looked at the basics of using Microsoft Offi ce Excel as a business 
application tool. We revised some of the basic principles of mathematics, signs/operators 
and explained the components of a spreadsheet. Workbook basics were also discussed, 
as well as operating and formatting workbooks, ending with printing and page layout, all 
integrated into various activities.

In the next study unit, you will be introduced to and shown how spreadsheets can be 
used as a business application tool, performing both simple and complex calculations 
to help you solve business and accounting problems. This will be done by showing and 
explaining to you how to create different formulas and use various functions – the real 
power of spreadsheets.

          

After working through this study unit, you should be able to answer the questions 
below.

At the end of study unit 5, all the work covered in this study unit will be tested 
in comprehensive self-assessment activity questions because the study units 
in part 2 build on one another, equipping you to effectively use Microsoft Offi ce 
Excel as a business application tool.

(1) List the Microsoft Offi ce Excel order of operation in sequence.
(2) You are the owner of Music Life, a music store selling local music CDs to the 

public. Music Life is a registered VAT vendor. You would like to purchase 15 
CDs of DJ Powa’s newly released album for your store from Pony Records. 
Pony Records is also a registered VAT vendor.

The cost price, including VAT, is R114 per CD. Music Life sells these CDs 
at R171 per CD, including VAT.

The VAT rate is 14%.

Required

(a) Calculate the cost price excluding VAT for the purchase of all 15 CDs.
(b) Calculate the mark-up margin.
(c) Calculate the gross profi t (excluding VAT) for each CD sold.
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          

Question 2:

(a) Cost price excluding VAT for the purchase of all 15 CDs:

R114 * 1/1.14 = R100 (cost price excluding VAT per CD)
R100 * 15 CDs = R1,500

(b) Mark-up margin:

R171 – R114 = R57 (gross profi t/mark-up including VAT)
R57/R114 = 50%

(c) Gross profi t (excluding VAT) for each CD sold:

R171 * 1/1.14 = R150 (sales price excluding VAT per CD)
R150 – R100 = R50
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5S T U D Y  U N I T  5 

9Spreadsheet formulas and functions

55In this study unit

10

1 Introduction
In the previous study unit you were introduced to spreadsheets. We looked at what a 
spreadsheet is, the various components and layouts of a spreadsheet and some basics 
of workbooks, formatting, printing and page layout.

By using spreadsheets as business applications, we can perform either simple or 
complex calculations to solve business and accounting problems. To do this we can create 
different formulas and use various functions. These formulas and functions will be 
discussed in this study unit.
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2 Working with formulas

A formula in Microsoft Offi ce Excel always start with an = sign.

2.1 Common errors when using formulas and functions
Once an error shows up in a cell, you have to fi nd the cause of the error and edit the 
worksheet in order to correct the error. Below are common error displays found in Microsoft 
Offi ce Excel and the reasons for it:

#DIV/0!
This error occurs when the formula calls for division by a cell that either contains the value 
0 or, as is more often the case, is empty. Division by zero is not possible according to 
mathematical principles.

#NAME?
This error occurs when Microsoft Offi ce Excel does not recognise text in a formula.

#NULL!
This error occurs most often when you insert a space where you should have used a comma 
to separate cell references used as arguments for functions.

#NUM!
This error occurs when Microsoft Offi ce Excel encounters a problem with a number in 
the formula, such as the wrong type of argument in a Microsoft Offi ce Excel function or a 
calculation that produces a number too large or too small to be represented in the worksheet.

#REF!
This error occurs when Microsoft Offi ce Excel encounters an invalid cell reference, such 
as when you delete a cell referred to in a formula or paste cells over cells referred to in 
a formula.

#VALUE!
This appears when you use the wrong type of argument in a function, the wrong type of 
operator or when you try to do a mathematical operation that refers to cells containing 
text entries.

#N/A!
This error occurs when a value is not available to a function or formula.
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2.2 Entering formulas
(a) Adding, subtracting, dividing and multiplying values

        

 •  Open a new workbook/fi le.
 •  Rename worksheet “Sheet 1” as “Practice”.
 •  Click on cell A1 in worksheet “Practice”.
 •  Type the value 100 and Enter.
 •  Click on cell A2.
 •  Type the value 20 and Enter.

Add the two values together in cell A3. After adding the two cells, the answer 
will be displayed in cell A3.

 •  Click on cell A3 (chosen for the formula).
 •  Type = to begin the formula.
 •  Type the fi rst operand (cell A1) by using the arrow key or by using the mouse 

to click on the cell.
 •  Type the fi rst operator ( + ).
 •  Type the next operand (cell A2) by using the arrow key or using the mouse 

to click on the cell.
 •  Press Enter.
 •  The answer that appears is 120.

Repeat the above activity, but instead of adding the two values, now subtract 
them from each other in cell A4, multiply the two values in cell A5 and divide 
the two values by each other in cell A6.

This can be achieved by merely changing the operator every time, but keeping 
the same format of operations – that is, using cell A1 as the fi rst operand and 
cell A2 as the second operand. The answer should look like this:
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(b) Adding values in two separate worksheets

         

 •  Rename worksheet “Sheet2” as “Test”.             
 •  Click on cell A1 in worksheet “Test”
 •  Type the value 200 and Enter.
 •  Click on cell A2.
 •  Type the value 40 and Enter.
 •  Click on cell A3 in worksheet “Test” (chosen for the formula).
 •  Type = to begin the formula.
 •  Type the fi rst operand (sheet Test cell A1) by using the arrow key.
 •  Type the fi rst operator ( + ).
 •  Type the next operand (sheet Test cell A2) by using the arrow key.
 •  Type the second operator ( + ).
 •  Click on sheet tab “Practice”.
 •  Click on cell A1 in worksheet “Practice”.
 •  Type the third operator ( + ).
 •  Click on cell A2 in worksheet “Practice”.
 •  Press Enter.
 •  The answer that appears is 360.   

The formula in cell A3 on sheet “Test” will be:

=A1+A2+Practice!A1+Practice!A2

Note that the sheet name precedes the cell reference if the cell is not on the 
current sheet (because every sheet has a cell A1, A2, A3, etc).

(c) Combing text and values (&)

Using “&” will refl ect the contents of the cells/value/text combined beside each other – for 
example, =2000&100 will refl ect as 2000100. Spaces and other symbols can be added 
by inserting them in the formula using quotes – for example, =2000&“-”&100 will refl ect 
as 2000–100.
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        

 •  Rename worksheet “Sheet3” as “Add”.
 •  Type the following data in the worksheet:

A B C

1 Nissan Hardbody

2 1985 12

3 Toyota Corolla

4 Ford 200

5 81 Model

 •  In cell C1, enter =A1&B1, and in cell C2, enter =A2&B2.

 –  Observe the results displayed in cell C1 (NissanHardbody) and in cell 
C2 (198512).

 –  Note that using “&” in the formula in cell C2 did not sum the two values 
but displays the values beside each other.

 •  In cell C3, enter =A3&“ ”&B3, in cell C4, enter =A4&“-”&B4 and in cell C5, 
enter =19&A5&“ ”&B5.

 –  Observe the results displayed in cell C3 (Toyota Corolla), in cell C4 
(Ford-200) and in cell C5 (1981 Model)

 –  Note that using “ ” inserted a space in the displayed answer (C3 & C5), 
while inserting “-” included a dash in the displayed answer (C4).

 •  The answer should appear as follow:
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2.3 Copying formulas
(a) Relative reference

Where the column and row reference of a cell reference in a formula changes when copied 
down and/or across, the cell address is referred to as being a relative reference.

A formula or a function can be copied by using the steps in section 7 in study unit 4 or by 
doing the following:

 •  Click on the cell containing the formula you want to copy.
 •  Position your mouse pointer on the right-hand bottom corner of the cell until the mouse 

pointer turns to a black cross.
 •  Click and drag the formula down or across to the cells to which you want to copy the 

formula and release the mouse button.

Copy down

When a formula is copied down (over rows) in a spreadsheet, the cell’s row reference 
will increase by the number of rows that the formula was copied down, for example:

 •  A formula =A1*B1 which copied down one row, will change to =A2*B2 – that is, cell 
A1 + 1row = cell A2 and cell B1 + 1row = cell B2.

 •  A formula =A1*B1, which copied down three rows, will change to =A4*B4 – that is, cell 
A1 + 3rows = cell A4 and cell B1 + 3rows = cell B4.

A B

1

2

3

4

5

        

 •  Enter the following data in a spreadsheet:

A B C D

1 Number of items Price per item Total price

2 Shoes 6 5

3 T-shirts 4 15

4 Jackets 2 20

5 Jeans 5 18

 •  In cell D2, calculate the total price for shoes by entering the formula =B2*C2.
 •  Copy the formula in cell D2 to cells D3, D4 and D5.

Number of rows copied 
down (3 rows)
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What happened to the formula in cell D3? Is it still =B2*C2 or did it change?

 –  The row reference in the cell reference increased by the number of rows 
that the formula was copied down (ie 1). Cell B2 + 1row = cell B3 and 
cell C2 + 1row = cell C3. The formula therefore changed from =B2*C2 
to =B3*C3.

What happened to the formula in cell D5? Is it still =B2*C2 or did it change?

 –  The row reference in the cell reference increased by the number of rows 
that the formula was copied down (ie 3 rows). Cell B2 + 3rows = cell 
B5 and cell C2 + 3rows = cell C5. The formula therefore changed from 
=B2*C2 to =B5*C5.

 •  The answer should appear as follows:

Copy across

When a formula is copied across (over columns) in a spreadsheet, the cell’s column 
reference will increase by the number of columns that the formula was copied across. 
For example:

 •  A formula =A1+A2 copied across one column, will change to =B1+B2 – that is, cell A1 
+ 1column = cell B1 and cell A2 + 1column = cell B2.

 •  A formula of =A1+A2 copied across three columns, will change to =D1+D2 – that is, 
cell A1 + 3columns = cell D1 and cell A2 + 3columns = cell D2.

A B C D E

1

2

  Number of columns copied 
across (3 columns)
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        

 •  Enter the following data into a spreadsheet:

A B C D E

1 March April May June

2 Shoes 500 1005 580 730

3 T-shirts 700 650 408 840

4 Total

 •  In cell B4, calculate the total for March by entering the formula =B2+B3.
 •  Copy the formula in cell B4 to cells C4, D4 and E4.

What happened with the formula in cell C4? Is it still =B2+B3 or did it change?

 –  The column reference in the cell reference increased by the number of 
columns that the formula was copied across (ie 1). Cell B2 + 1column = 
cell C2 and cell B3 + 1column = cell C3. The formula therefore changed 
from =B2+B3 to =C2+C3.

What happened with the formula in cell E4? Is it still =B2+B3 or did it change?

 –  The column reference in the cell reference increased by the number of 
columns that the formula was copied across (ie 3). Cell B2 + 3columns = 
cell E2 and cell B3 + 3columns = cell E3. The formula therefore changed 
from =B2+B3 to =E2+E3.

 •  The answer should appear as follows:
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Copy across and down

        

 •  Enter the following data in a spreadsheet:

A B C

1 Number sold January February

2 Shoes 20 25

3 T-shirts 50 80

4 Jackets 35 32

5 Jeans 60 70

6

7 Selling price per item January February

8 Shoes 100 100

9 T-shirts 50 55

10 Jackets 300 310

11 Jeans 150 100

12

13 Total sales per item January February

14 Shoes

15 T-shirts

16 Jackets

17 Jeans

 •  Calculate the total sales per item by multiplying the number sold by the 
selling price of the item.

 •  Calculate in cell B14 the total sales for shoes sold in January by entering 
the formula =B2*B8

 •  Copy the formula in cell B14 to cells B15, B16 and B17.

What happened with the formula in cell B16? Is it still =B2*B8 or did it change?

 –  The row reference in the cell reference increased by the number of rows 
that the formula was copied down (ie 2). Cell B2 + 2rows = cell B4 and 
cell B8 + 2rows = cell B10. The formula therefore changed from =B2*B8 
to =B4*B10.
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 •  The answer should appear as follows:
    

 •  Copy the formula in cell B14 to cells C14 C15, C16 and C17.

What happened with the formula in cell C14? Is it still =B2*B8 or did it change?

 –  The column reference in the cell reference increased by the number of 
columns that the formula was copied across (ie 1). Cell B2+1column = 
cell C2 and cell B8 + 1column = cell C8. The formula therefore changed 
from =B2*B8 to =C2*C8.

What happened to the formula in cell C17? Is it still =B2*B8 or did it change?

 –  Not only did the column reference in the cell reference increase by the 
number of columns that the formula was copied across (ie 1), but the 
row reference also increased by the number of rows that the formula 
that was copied down (ie 3). The formula therefore changed from =B2*B8 
to =C5*C11, that is:

◊ cell B2 + 1column + 3rows = C5
◊ cell B8 + 1column + 3rows = C11

 •  The answer should appear as follows:
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(b) Absolute reference

In contrast to a relative reference (see section 2.3(a) in this study unit), the column and/
or row reference in an absolute reference is “fi xed” and does not change when a formula 
is copied down and/or across. Inserting a dollar sign ($) in front of the row or/and column 
reference will make the reference absolute. Inserting a $ in front of a column or a row will 
ensure that the column or row reference is absolute (“fi xed”) and will not change when the 
formula is copied across or down. This is the same as using glue to permanently “glue” a 
cell reference. There are three types of absolute references, as explained below:

 •  Absolute row reference. Insert the $ in front of the row reference only (eg B$5). 
When copied, only the column reference (B) will change. Because the row reference 
(5) is fi xed, it will not change.

 •  Absolute column reference. Insert the $ in front of the column reference only (eg $B5). 
When copied, only the row reference (5) will change. Because the column reference 
(B) is fi xed, it will not change.

 •  Absolute column AND row reference. Insert the $ in front of both the column and 
row reference (eg $B$5). When copied, both the column reference (B) and the row 
reference (5) will not change because they are fi xed.

The $ can be inserted by

 •  changing the formula to include the $

or

 •  highlighting the cell reference in the formula/function and pressing the F4 function key 
until the $ is displayed. Each time the F4 key is pressed, it will change where the $ is 
displayed – that is, in front of both the column and row reference, in front of the row 
reference only or in front of the column reference only.

Absolute row reference (eg B$5)

        

 •  Enter the following data in a spreadsheet:

A B C

1 VAT rate 14%

2

3 Sales excluding 
VAT

Sales including 
VAT

4 January 1500

5 February 1200

6 March 1300

7 April 500

8 May 800

9 June 1400



. . . . . . . . . . .
95 Stu d y unit  5

 •  Calculate the sales amount per month, including VAT by using the VAT % 
provided. The formula will be entered once and copied to the rest of the 
cells. What formula would you enter in cell C4?

 •  In cell C4 type = (B4*B1)+B4 – that is, sales including VAT = (sales excluding 
VAT x VAT rate) + sales excluding VAT.

 •  Copy the formula in cell C4 to cell C5 and observe how the formula changes. 
As explained in section 2.3(a) (copy down) in this study unit, relative row 
references in a formula will increase by the number of rows that the formula 
is copied down – that is, the formula will change from =(B4*B1)+B4 to 
=(B5*B2)+B5.

 –  However, we did not want cell reference B1 in the formula to change to 
B2 because the VAT % was entered in cell B1.

 –  How do you think cell reference B1 should change to ensure (when it is 
copied down) that it still refers to cell B1 and will not change? The row 
reference should be made absolute (fi xed) by inserting a $ sign in front 
of the row reference (B$1).

 •  Delete the formula copied to cell C5.
 •  In cell C4, change cell reference B1 to include the applicable absolute 

reference (ie =(B4*B$1)+B4).
 •  Now copy the new formula in cell C4 to range C5:C9 and observe how the 

formula changes.

What happened with the formula in cell C6? How did it change?

 –  The row reference of the relative cell reference changed, as explained 
in section 2.3(a) (copy down) of this study unit (B4 to B6). However, the 
row reference in B$1 did not change because it was absolute/fi xed. The 
formula therefore changed from =(B4*B$1)+B4 to =(B6*B$1)+B6.

 •  The answer should appear as follows:
   

Note:  When the VAT rate was entered in the spreadsheet, it was 0.14, and 
the format of the cell changed to display a % format. The format of 
the numbers was changed to a number format with two decimals. 
See section 8.1(a) in study unit 4.
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Absolute column reference (eg $B5)

        

 •  Enter the following data in a spreadsheet:

A B C D E F G H

1 VAT 
rate

14%

2

3 January February March April May June July

4 Sales 
excl 
VAT

1,500.00 1,200.00 1,300.00 500.00 800.00 1,400.00 900.00

5 Sales 
incl 
VAT

 •  Calculate the sales amount per month, including VAT, by using the provided 
VAT %. The formula will be entered once and copied to the rest of the cells. 
What formula would you enter in cell B5?

 •  In cell B5 type =(B4*B1)+B4
 •  Copy the formula to cell C5 and observe the change in the formula. As 

explained in section 2.3(a) (copy across) in this study unit, relative column 
references in a formula will increase by the number of columns that the 
formula is copied across, that is, the formula will change from =(B4*B1)+B4 
to =(C4*C1)+C4.

 –  However, we did not want cell reference B1 in the formula, to change to 
C1 because the VAT % was only entered in cell B1.

 –  How do you think cell reference B1 should change to ensure (when it 
is copied across) that it still refers to cell B1 and will not change? The 
column reference should be made absolute (fi xed) by inserting a $ sign 
in front of the column reference ($B1).

 •  Delete the formula you have copied to cell C5.
 •  In cell B5, change cell reference B1 to include the applicable absolute 

reference (ie to =(B4*$B1)+B4).
 •  Now copy the formula to range C5:H5 and observe how the formula changes.

What happened with the formula in cell E5? How did it change?

 –  The column reference of the relative cell references changed as explained 
in section 2.3(a) (copy across) in this study unit (B4 to E4). However, the 
column reference in $B1 did not change because it was absolute/fi xed. 
The formula therefore changed from =(B4*$B1)+B4 to =(E4*$B1)+E4
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 •  The answer should appear as follows:

Absolute column and row references (eg $B$5)

        

 •  Enter the following data in a spreadsheet:

A B C D E

1 VAT rate 14%

2

3 Sales excl VAT January February March April

4 Shoes 2,000.00 2,500.00 3,000.00 2,900.00

5 T-shirts 500.00 800.00 700.00 400.00

6 Jackets 3,500.00 3,200.00 3,800.00 4,000.00

7 Jeans 6,000.00 7,000.00 4,000.00 3,000.00

8 Hats 150.00 200.00 300.00 250.00

9

10

11 Sales incl VAT January February March April

12 Shoes

13 T-shirts

14 Jackets

15 Jeans

16 Hats
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 •  Calculate the sales amount per month, including VAT, by using the provided 
VAT %. The formula will be entered once and copied to the rest of the cells. 
What formula would you enter?

 •  In cell B12, type =(B4*B1)+B4.
 •  Copy the formula to cell D15 and observe how the formula changes. As 

explained in section 2.3(a) (copy across & down) in this study unit, relative 
column and row references in a formula will increase by the number of 
columns/rows copied across/down. The formula will change from =(B4*B1)+B4 
to =(D7*D4)+D7.

 –  However, we did not want cell reference B1 in the formula, to change to 
D4 because the VAT % was entered in cell B1.

 –  How do you think cell reference B1 should change to ensure (when it is 
copied across and down) that it still refers to cell B1 and will not change? 
The column and the row reference should be made absolute (fi xed) by 
inserting a $ sign in front of the column and row reference ($B$1).

 •  Delete the formula you copied to cell D15.
 •  In cell B12, change cells reference B1 to include the applicable absolute 

references (ie =(B4*$B$1)+B4).
 •  Now copy the formula to range B13:B16 and range C12:E16 and observe 

how the formula changes.

What happened with the formula in cell D15? How did it change?

 –  The column and row references of the relative cell references changed 
as explained in 2.3(a) (copy across & down) in this study unit (B4 to D7). 
However, the column and row reference in $B$1 did not change because 
it was absolute/fi xed. The formula therefore changed from =(B4*$B$1)+B4 
to =(D7*$B$1)+D7.

 •  The answer should appear as follows:
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3 Functions
A function is a short cut to make calculations easier and quicker. Functions should always 
be used if they are available – for example, adding 20 cells together by =A1+A2+A3…
+A20 compared to =SUM(A1:A20).

3.1 Structure of a function
A function ALWAYS begins with an equal sign (=), followed by the function name, the 
opening parenthesis, the arguments for the function, separated by commas, and the 
closing parenthesis.

Arguments are the information needed by the function in order to calculate the function 
correctly.

We will now break down the following examples in the above-mentioned structure:

=SUM(cell1:cell2)

Structure The formula

Begins with = sign =

Function name SUM

Opening parenthesis (

The arguments for the function cell1:cell2

Closing parenthesis )
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=PMT(rate,nper,pv,fv,type)

Structure The formula

Begins with = sign =

Function name PMT

Opening parenthesis (

The arguments for the function separated 
by commas

rate,nper,pv,fv,type

Closing parenthesis )

=IF(Logical_test,value_if_true,value_if_false)

Structure The formula

Begins with = sign =

Function name IF

Opening parenthesis (

The arguments for the function separated 
by commas

Logical_test,value_if_true,value_if_false

Closing parenthesis )

3.2 Reference operators: when to use : or ,
(a) Colon :

A colon ( : ) is used to select all the cells from and including the fi rst cell reference to and 
including the last cell reference. A1:A9 will therefore include all the cells from and including 
A1 to A9 (see the highlighted cells below).

 
 

  

Include all 
the cells

  
=SUM(A1:A9)
  Answer: 558
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(b) Comma ,

A comma ( , ) is used if you wish to select specifi ed cells, and it is placed between each 
cell reference. A1,A4,A6 will therefore only include/select only cells A1, A4 and A6 (see 
the highlighted cells below).

Only include the 
highlighted cells

= SUM(A1,A4,A6)
Answer: 239

A comma is also used to separate the arguments of a function – for example, 
=IF(condition,value_if_true,value_if_false).

(c) Combining a colon : and a comma ,

A comma (,) and a colon (:) can be combined. This is used when combining two different 
ranges. For example, A1:A3,A6:A8 will select/include cells A1, A2, A3, A6, A7 and A8 (see 
the highlighted cells below).

Include both the highlighted 
cell ranges

= SUM(A1:A3,A6:A8)
Answer: 417
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3.3 Insert a function

        

 •  Click on the Formulas tab.
 •  Click on the fx insert function icon.
 •  At “Or select a category” choose All.
 •  The dialog box will now display the following:

NOTE

By changing the Category, the functions for that specifi c category will be displayed in 
the Select a function box. By clicking on the Function in the Select a function box, a 
description will appear at the bottom of the dialog box, explaining the purpose of the function.

4 Commonly used functions
The following are some examples of commonly used functions in the fi nancial environment:

(a) Mathematical functions

Bear in mind that cell1 (number1) refers to the fi rst cell in the range and cell2 (number2) 
to the last cell in the range – that is, A1:A9 being all cells in the range A1 to A9; and cell11, 
cell12, cell13 refer to selected cells – that is, A1,A4,A6 being specifi c cells A1, A4 and 
A6. See section 3.2 in this study unit for an explanation of the difference between using 
a comma and a colon.
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SUM

This function adds values in individual cells or cell ranges together.

=SUM(cell1:cell2)
Adds all the values in a specifi ed range of cells
=SUM(cell11,cell12,cell13)
Adds all the values for specifi ed cells

        

 •  Create a worksheet and enter the following data:

A B
1 T-shirts in stock per different 

type of T-shirt
2
3 Type of sport T-shirt Number of T-shirt
4 Soccer 125
5 Rugby 77
6 Swimming 65
7 Cricket 45
8 Tennis 89
9 Netball 36
10 Basketball 25
11 Hockey 50
12 Athletics 95
13 Table tennis 16

 •  In cell B14, calculate the total number of T-shirts for all the types of T-shirts.
 •  In cell B16, calculate the total number of T-shirts for the swimming, netball 

and hockey T-shirts only.
 •  In cell B18, calculate the total number of T-shirts for the rugby, swimming, 

cricket, hockey and athletic T-shirts only.
 •  The answer should appear as follows:
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ROUND

This function rounds the value in the specifi ed cell to the specifi ed number of digits.

=ROUND(cell1,number_of_digits)

Cell1 refers to cell that will be rounded. Number_of_digits refers to the number of digits 
the answer should be rounded to.

        

 •  Use the data entered in activity 5.11.
 •  In column C, divide the number of T-shirts for soccer, swimming, basketball 

and table tennis by 3.
 •  Using the round function, in column D round the answer, calculated in column 

C, as follows:

 –  round soccer T-shirts to 1 digit
 –  round swimming T-shirts to 2 digits
 –  round basketball T-shirts to 3 digits
 –  round table tennis T-shirts to 4 digits

 •  The answer should appear as follows:
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It is not always necessary to round the answer of a cell in a separate cell. The round 
function can be used with a formula in a cell: =ROUND(formula,number_of_digits)

 • Formula

Formula refers to the formula you want to calculate.

 • Number of digits

Number_of_digits refers to the number of digits the answer should be rounded to.

        

 •  Use the data entered in activity 5.12.
 •  Delete the formulas and functions entered in columns C and D.
 •  In column C, divide the number of T-shirts for soccer, swimming, basketball 

and table tennis by 3 and round the answer of the formula as follows:

 –  round soccer T-shirts to 1 digit
 –  round swimming T-shirts to 2 digits
 –  round basketball T-shirts to 3 digits
 –  round table tennis T-shirts to 4 digits

 •  The answer should appear as follows:
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(b) Statistical functions

Bear in mind that cell1 refers to the fi rst cell in the range, cell2 to the last cell in the 
range and cell11, cell12, cell13 to selected cells. See section 3.2 in this study unit for an 
explanation of the difference between using a comma and a colon.

AVERAGE

This function calculates the average value for the specifi ed cells or ranges.

=AVERAGE(cell1:cell2)
calculates the average of the values in a specifi ed range of cells.
=AVERAGE(cell11,cell12,cell13)
calculates the average of the values for specifi ed cells.

        

 •  Use the data entered in activity 5.11
 •  Delete the formulas in cells B14, B16, B18.
 •  In cell B14, calculate the average number of T-shirts for all the types of 

T-shirts.
 •  In cell B16, calculate the average of T-shirts for the swimming, netball and 

hockey T-shirts only.
 •  In cell B18, calculate the average of T-shirts for the rugby, swimming, 

cricket, hockey and athletic T-shirts only.
 •  The answer should appear as follows:
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MAXIMUM

This function is used to identify the maximum (greatest, highest, most, largest) value in a 
range of cells or in specifi ed cells.

=MAX(cell1:cell2)
determines the largest value in a specifi ed range of cells.
=MAX(cell11,cell12,cell13)
determines the largest value for specifi ed cells.

        

 •  Use the data entered in activity 5.11.
 •  Delete the formulas in cells B14, B16, B18.
 •  In cell B14, calculate the largest number of T-shirts available for all the 

types of T-shirts.
 •  In cell B16, calculate the highest number of T-shirts available for the 

swimming, netball and hockey T-shirts only.
 •  In cell B18, calculate the greatest number of T-shirts available for the rugby, 

swimming, cricket, hockey and athletic T-shirts only.
 •  The answer should appear as follows:
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MINIMUM

This function is used to identify the minimum (smallest, least, lowest, tiniest) value in a 
range of cells or in specifi ed cells.

=MIN(cell1:cell2)
determines the smallest value in a specifi ed range of cells.
=MIN(cell11,cell12,cell13)
determines the smallest value for specifi ed cells.

        

 •  Use the data entered in activity 5.11.
 •  Delete the formulas in cells B14, B16, B18.
 •  In cell B14, calculate the smallest number of T-shirts available for all the 

types of T-shirts.
 •  In cell B16, calculate the lowest number of T-shirts available for the 

swimming, netball and hockey T-shirts only.
 •  In cell B18, calculate the least number of T-shirts available for the rugby, 

swimming, cricket, hockey and athletic T-shirts only.
 •  The answer should appear as follows:
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(c) Financial functions

For all the functions mentioned below, the following defi nitions apply:

rate = the interest rate used

nper = the applicable period

pmt = the payment/instalment amount

fv = future value

pv = present value

type = 1 if the instalment is paid at the beginning of the month

type = 0 if the instalment is paid at the end of the month

Always ensure that the payment period, interest rate period and the applicable period 
are all the same period/denominator. Remember, you should be comparing apples with 
apples, and not apples with oranges.

Example

If, in the case study, you are given the information in different periods, you must fi rst 
convert it.

 •  Payment is an instalment per month, the interest rate is a % per annum and the 
period is in years.

 •  Because the payment period is in months, you will need to convert the current yearly 
interest rate to a monthly interest rate by dividing the yearly interest rate by 12.

 •  Because the payment period is in months, you will also need to convert the applicable 
period currently in years to a number of months by multiplying the period in years by 12.

Note that for activities 5.17 to 5.20, the interest rate should be entered in the spreadsheet 
as 0.14 and formatted to display as 14%. See section 8.1(a) in study unit 4.

NOTE

Using fi nancial functions available (that is present value, future value and payment), interest 
will be compounded based on the number of periods used in the function.

CALCULATION OF PAYMENTS

=PMT(rate,nper,pv,fv,type)
calculates the payment for a loan based on constant payments and a constant interest rate.

        

 •  You want to buy a car for R50 000. Enter the present value in cell B3.
 •  The bank can fi nance your car at a constant interest rate of 14% per year 

over fi ve years. Enter the interest rate in cell B4 and the period in cell B5.
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 •  Use the =PMT function and calculate the monthly payment you need to 
make to the bank at the end of each month.

 –  Enter the following formula in cell B7: =PMT(B4/12,B5*12,B3,0,0)

Structure The formula Explanation

Begins with = sign =

Function name PMT

Opening parenthesis (

rate B4/12

The interest rate is an annual 
(yearly) rate and needs to 
be divided by 12 to make it 
a monthly rate because the 
payment value required is a 
monthly payment.

nper B5*12

The period is a term in years 
and needs to be multiplied by 
12 to make it a period in months 
because the payment value 
required is a monthly payment.

pv B3

The present value of the loan 
amount. This is the amount you 
want to borrow from the bank to 
fi nance the vehicle.

fv 0

The future value of the loan. 
Since the loan will be fully paid 
by the end of the period, the 
future value of the loan is 0.

type 0 The instalment is paid at the end 
of the month (paid in arrears).

Closing parenthesis )

 •  The answer should appear as follows:

Note:  Because an instalment/payment is regarded as an outfl ow of cash, it is 
shown as a negative value.



. . . . . . . . . . .
112TO PI C 2

        

 •  Use the same information as in activity 5.17
 •  Calculate the monthly amount payable to the bank if you pay the amount at 

the beginning of the month (ie you pay in advance).

 –  Enter the following formula in cell B7: =PMT(B4/12,B5*12,B3,0,1)

Structure The formula Explanation

Begins with = sign =

Function name PMT

Opening parenthesis (

rate B4/12

The interest rate is an annual 
(yearly) rate and needs to 
be divided by 12 to make it a 
monthly rate.

nper B5*12
The period is a term in years 
and should be multiplied by 12 
to make it a period in months.

pv B3

The present value of the loan 
amount. This is the amount you 
want to loan from the bank to 
fi nance the vehicle.

fv 0

The future value of the loan. 
Since the loan will be fully paid 
by the end of the period, the 
future value of the loan is R0.

type 1
The instalment is paid at the 
beginning of the month (paid 
in advance).

Closing parenthesis )

CALCULATION OF FUTURE VALUE

=FV(rate,nper,pmt,pv,type)
returns the future value of an investment based on constant payments and a constant 
interest rate.
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        

 •  You want to save R500 at the end of each month and the bank is prepared 
to give you a constant interest rate of 14% per annum. Enter the investment 
amount in cell B3, the investment rate in cell B4 and the period in cell B5.

 •  Use the =FV function and calculate what the value of your savings will be 
after fi ve years.

 –  Enter the following formula in cell B7: =FV(B4/12,B5*12,B3,0,0)

Structure The formula Explanation

Begins with = sign =

Function name FV

Opening parenthesis (

rate B4/12

The interest rate is an annual 
(yearly) rate and needs to 
be divided by 12 to make it 
a monthly rate as you save 
monthly.

nper B5*12

The period is a term in years 
and should be multiplied by 12 
to make it a period in months 
because you save monthly.

pmt B3

The payment amount you want 
to save each month. Note that 
the amount is negative (-R500) 
because it is an outfl ow of cash 
to an investment.

pv 0 The present value of your 
investment. Since you have not 
saved anything yet, the current 
value (present value) of your 
investment is 0.

type 0 You save at the end of each 
month.

Closing parenthesis )

 •  The answer should appear as follows:
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CALCULATION OF PRESENT VALUE

=PV(rate,nper,pmt,fv,type)
returns the present value of an investment – the total amount that a series of total payments 
is worth today at a constant interest rate and over a constant period.

         

 •  At the end of each month, you have R500 that you can use to pay off a loan 
to the bank. The bank offers you a constant interest rate of 14% per annum 
over 60 months. Enter the payment in cell B3, the interest rate in cell B4 
and the period in cell B5.

 •  Use the =PV function and calculate what amount you can borrow from the 
bank.

 –  Enter the following formula in cell B7: =PV(B4/12,B5*12,B3,0,0)

Structure The formula Explanation

Begins with = sign =

Function name PV

Opening parenthesis (

rate B4/12
The interest rate is an annual 
(yearly) rate and needs to be divided 
by 12 to make it a monthly rate.

nper B5

The period is a term in months. 
Note that you do not need to adjust 
the period because it is already in 
months.

pmt B3

The payment amount you can make 
each month. Note that the amount 
is negative (-R500) because it is an 
outfl ow of cash to an investment.

fv 0

The future value of the loan. 
Because the loan will be fully paid 
by the end of the period, the future 
value of the loan is R0.

type 0 The instalment is paid at the end of 
the month (paid in arrears).

Closing parenthesis )

 •  The answer should appear as follows:
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(d) Logical functions

=IF(logical_test,value_if_true,value_if_false)
returns one value if the specifi ed logical test evaluates to be TRUE and another value if 
the specifi ed logical test evaluates to be FALSE.

Logical_test:

A logical test is any value or expression that can be evaluated as either TRUE or FALSE. 
For example, A1<1000 is a logical test; if A is equal to 500, then the expression evaluates 
as TRUE, but if A is equal to 2000, then the expression will evaluate as FALSE. A logical 
test can evaluate against text (eg A1=“yes”), a value (eg A1<1000), another cell (eg A1>=B2) 
or a formula (eg C5=(A2*B2) ).

A logical test usually consists of three parts:

(1) a cell reference, say, A1
(2) a comparison calculation operator, that is, less than (<); greater than or equal to 

(>=); less than or equal to (<=); not equal to (<>); and equal to(=)
(3) a value, text, cell reference or formula against which to evaluate the cell reference 

in part (1) – for example, 10000, “YES”, B6 or (B5*B6). Note when using text, that it 
should be in quotes (“ “) and that it is case sensitive (“ABC” and “abc” is, after all, not 
exactly the same).

Value_if_true:

Which value should be displayed in the cell if the logical test is evaluated as TRUE (the 
value that is returned if the logical_test is TRUE)?

The value can either be

 •  text (eg “Yes”, “Open”, etc). Note that text should always be in quotes (“ “) and is case 
sensitive.

 •  a value (eg 1000.00 or 15090.23). Note that the value does not have any spaces, commas 
or currency and that a full stop (.) is used to indicate decimals.

 •  refer to a cell reference (eg B5 or E18)
 •  be a calculation (eg B5*C7 or B5+30 or A10*0.14)

Value_if_false:

Which value should be displayed in the cell if the logical test is evaluated as FALSE (the 
value that is returned if the logical_test is FALSE)?

The value can either be

 •  text (eg “close”, “new”, etc). Note that text should always be in quotes (“ “) and is 
case sensitive.

 •  a value (eg 56789.23 or 9874563). Note that the value does not have any spaces, commas 
or currency and that a full stop (.) is used to indicate decimals.

 •  refer to a cell reference (eg G3 or J50)
 •  be a calculation (eg A5-B7 or D5/30 or C10*0.02)
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         

 •  You have invited a few friends and their children to a soccer match. The 
soccer tickets are R30 per adult and R15 per child. You also want to invite 
the persons 21 years and older to an after party. The cost of the after party 
is R100 per person.

 •  You want to determine the following:

 –  the total cost and cost per person for the soccer tickets only
 –  who you wish to invite to the after party, indicated with “Invite”, and who 

you do not wish to invite, indicated with “Don’t invite”
 –  the total cost and total cost per person including the after party and the 

soccer tickets costs

 •  NOTE THAT ALL FORMULAS WILL ONLY BE ENTERED IN THE FIRST 
CELL AND COPIED DOWN TO THE FOLLOWING CELLS.

 •  Please save this fi le as “Activity 5.21” because it will be used in a 
subsequent activity.

 •  Enter the following data in a spreadsheet:

A B C D E F

1 Soccer match and after party

2

3 Price per person

4 Soccer ticket 
– adult

R 30.00

5 Soccer ticket 
– child

R 15.00

6 After party R 100.00

7

8 Name Adult/ 
Child

Age Soccer 
ticket 
price

Invite to 
after party

Total cost 
soccer 

and after 
party

9 Peter Adult 43

10 Sarah Adult 40

11 Thab o  Child 12

12 Sandy Child 10

13 Thomas Child 5

14 Viwe Adult 32

15 Abel Child 8

16 Rikki Child 9

17 Martin Adult 22

18 Razia Adult 19
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 • What will the formula in cell D9 be? Remember that you will copy the formula 
to the rows below.

 •  Enter the following formula in cell D9 and copy to range D10:D18. See what 
happens. Does the formula give you the desired result?

 =IF(B9=“Adult”,B$4,B$5)

Structure The formula Explanation

Begins with = sign =

Function name IF

Opening 
parenthesis (

logical_test B9=“Adult”

You want to evaluate if the person 
is an adult (as indicated in cell 
B9). Note the relative reference of 
cell B9. Also note that “Adult” is in 
quotes (“”) because you evaluate 
against text.

value_if_the 
logical test is true B$4

You want to return the adult ticket 
price (entered in cell B4) if the 
answer to your logical test is true, 
that is, the person is an adult. 
Note that the row reference in 
the cell reference is absolute ($4) 
because you do not want the row 
reference to increase when the 
formula is copied downwards.

value_if_the 
logical test is false B$5

You want to return the child ticket 
price (entered in cell B5) if the 
answer to your logical test is 
false, that is, the person is not an 
adult. Note that the row reference 
in the cell reference is absolute 
($5) because you do not want the 
row reference to increase when 
the formula is copied downwards.

Closing 
parenthesis )

 •  Delete the formula entered in range D9:D18.
 •  Enter the following formula in cell D9 and copy it to range D10:D18.

 =IF(B9=“Child”,B$5,B$4)
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Structure The formula Explanation

Begins with = 
sign =

Function name IF

Opening 
parenthesis (

logical_test B9=“Child”

You want to evaluate if the 
person is a child (as indicated 
in cell B9). Note the relative 
reference of cell B9. Also note 
that “Child” is in quotes (“”) 
because you evaluate against 
text.

value_if_the 
logical test is true B$5

You want to return the child 
ticket price (entered in cell B5) 
if the answer to your logical 
test is true, that is, the person 
is a child. Note that the row 
reference in the cell reference 
is absolute ($5) because you 
do not want the row reference 
to increase when the formula is 
copied downwards.

value_if_the 
logical test is 
false

B$4

You want to return the adult 
ticket price (entered in cell B4) 
if the answer to your logical test 
is false, that is, the person is 
not a child. Note that the row 
reference in the cell reference 
is absolute ($4) because you 
do not want the row reference 
to increase when the formula is 
copied downwards.

Closing 
parenthesis )

 • See what happens. Does the formula give you the desired result? Is the 
result different from the previous formula entered or is the result the same?

Bear in mind that there is usually more than one logical test that can apply 
in IF functions, and the true and false value will depend on your logical test.

 •  What will the formula in cell E9 be? Take into account that you will copy the 
formula to the rows below.

 •  Enter the formula below in cell E9 and copy it to range E10:E18. See what 
happens. Does the formula give you the desired result?
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 =IF(C9>=21,“Invite”,“Don’t invite”)

Structure The formula Explanation

Begins with = 
sign =

Function name IF

Opening 
parenthesis (

logical_test C9>=21

You want to evaluate if the 
person is 21 years and older as 
per the age indicated in cell C9. 
Note the relative reference of cell 
C9. Also, note that, in contrast 
to the previous IF formula, the 
21 is not in quotes because you 
evaluate against a value and not 
text.

value_if_the 
logical test is 
true

“Invite”

You want to return, “Invite”, if 
the answer to your logical test 
is true, that is, the person is 
21 years and older. Note that 
“Invite” is in quotes (“”) because 
you want to return text.

value_if_the 
logical test is 
false

“Don’t invite”

You want to return, “Don’t 
invite”, if the answer to your 
logical test is false, that is, the 
person is younger than 21. Note 
that “Don’t invite” is in quotes (“”) 
because you want to return text.

Closing 
parenthesis )

 • Delete the formula entered in range E9:E18.
 •  Enter the following formula in cell E9 and copy it to range E10:E18.

 =IF(C9<21,“Don’t invite”,“Invite”)

Structure The formula Explanation

Begins with = 
sign =

Function name IF

Opening 
parenthesis (
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logical_test C9<21

You want to evaluate whether the 
person is younger than 21 as per 
the age indicated in cell C9. Note the 
relative reference of cell C9. Also 
note that the 21 is not in quotes 
because you evaluate against a 
value and not text.

value_if_the 
logical test is 
true

“Don’t invite”

You want to return, “Don’t invite”, 
if the answer to your logical test is 
true that is, the person is younger 
than 21. Note that “Don’t invite” is 
in quotes (“”) because you want to 
return text.

value_if_the 
logical test is 
false

“Invite”

You want to return, “Invite”, if the 
answer to your logical test is false, 
that is, the person is 21 years and 
older. Note that “Invite” is in quotes 
(“”) because you want to return text.

Closing 
parenthesis )

 •  See what happens. Does the formula give you the desired result? Is the 
result different from the previous formula entered or is it the same?

As explained previously, more than one logical test can usually apply in 
IF functions and the true and false value will depend on your logical test.

 •  What will the formula in cell F9 be? Take into account the fact that you will 
copy the formula to the rows below.

 •  Enter the formula below in cell F9 and copy it to range F10:F18. See what 
happens. Does the formula give you the desired result?

 =IF(E9=“Invite”,D9+B$6,D9)

Structure The formula Explanation

Begins with = 
sign =

Function name IF

Opening 
parenthesis (

logical_test E9=“Invite”

You want to evaluate whether the 
person is invited to the after-party as 
calculated in cell E9. Note the relative 
reference of cell E9. Also note that 
“Invite” is in quotes (“”) because you 
evaluate against text.
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value_if_the 
logical test is 
true

D9+B$6

You want to return the sum of the 
ticket price (D9) and the after-party 
cost (B6) if the answer to your 
logical test is true, that is, the person 
is invited to the party. Note that the 
cell reference for D9 is relative, while 
the row reference in cell B$6 ($6) is 
absolute.

value_if_the 
logical test is 
false

D9

You want to return only the ticket price 
(D9) if the answer to your logical test 
is false, that is, the person is not 
invited to the party. Note the relative 
cell reference for D9.

Closing 
parenthesis )

 • Delete the formula entered in range F9:F18.
 •  Enter the following formula in cell F9 and copy it to range F10:F18.

 =IF(E9=“Don’t invite”,D9,D9+B$6)

Structure The formula Explanation

Begins with = 
sign =

Function name IF

Opening 
parenthesis (

logical_test E9=“Don’t invite”

You want to evaluate whether the 
person is not invited to the after party 
as calculated in cell E9. Note the 
relative reference of cell E9. Also 
note that “Don’t invite” is in quotes 
(“ “) because you evaluate against text.

value_if_the 
logical test is 
true

D9

You want to return only the ticket 
price (D9) if the answer to your 
logical test is true, that is, the person 
is not invited to the party. Note the 
relative cell reference for D9.

value_if_the 
logical test is 
false

D9+B$6

You want to return the sum of the 
ticket price (D9) and the after party 
cost (B6) if the answer to your 
logical test is false, that is, the 
person is invited to the party. Note 
that the cell reference for D9 is 
relative, while the row reference in 
cell B$6 ($6) is absolute.

Closing 
parenthesis )
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 •  Please save this fi le as “Activity 5.21” because it will be used in a 
subsequent activity.

 •  The results of activity 5.21 should appear as follows:

NOTE:  MICROSOFT OFFICE EXCEL WILL DISPLAY IN A CELL, ON THE FACE OF THE 
WORKSHEET, A VALUE OR TEXT, BUT A FORMULA OR A FUNCTION MAY BE BEHIND 
THAT CELL.
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To check a formula/function, click on the cell containing the formula/function and press 
F2. This will indicate which cells are used in your formula/function because Excel then 
highlights the various cells used in colour.

(e) Text functions

Cell refers to the cell to which you want this function to apply.

Also note that a character is defi ned as text, number, symbols and spaces.

=LEFT(cell,num_chars)

This function returns a specifi ed number of characters (num_chars) from the start (left-
hand side) of the text.

         

 •  Create a new worksheet.
 •  Enter the word FUNCTION in cell A3.
 •  In cell B3 enter the function =left(A3,3).
 •  The answer returned in cell B3 would be the fi rst 3 characters of the word 

(ie FUN).

Specifi ed number of characters num_of_chars

Character position/
number

1 2 3 4 5 6 7 8

Starts here F U N C T I  O N

         

 •  Use the same worksheet as in activity 5.22.
 •  Enter the word “F*U NCT+I ON” in cell A4.
 •  In cell B4 enter the function =left(A4,5).
 •  The answer returned in cell B4 will be the fi rst 5 characters of the word 

(ie F*U N). Note that the space between the “U” and “N” is counted as a 
character.

Specifi ed number of characters num_of_chars

Character position/
number

1 2 3 4 5 6 7 8 9 10 11 12

Starts here F * U N C T +  I O N
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=MID(cell,start_num,num_chars)

This function returns a specifi ed number of characters from the middle of a text string given 
a starting position (start_num) and the length specifi ed (num_chars).

         

 •  Use the same worksheet as in activity 5.23.
 •  In cell C3 enter the function =mid(A3,4,3).
 •  The answer returned in cell C3 will be “CTI”.

Starts here start_num

Character position/
number

1 2 3 4 5 6 7 8

F U N C T I  O N

Number of characters 
specifi ed num_of_chars

         

 •  Use the same worksheet as in activity 5.24.
 •  In cell C4 enter the function =mid(A4,7,5).
 •  The answer returned in cell C4 would be “T+I O”. Note that the space between 

the “U” and “N” and the “I” and “O” is counted as a character.

Starts here start_num

Character position/
number

1 2 3 4 5 6 7 8 9 10 11 12

F * U N C T + I O  N

Specifi ed number of 
characters num_of_chars 
number_of_characters_to 

return
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=RIGHT(cell,num_chars)

This function returns a specifi ed number of characters (num_chars) from the end (right-
hand side) of the text.

         

 •  Use the same worksheet as in activity 5.25.
 •  In cell D3 enter the function =right(A3,3).
 •  The answer returned in cell D3 will be “ION”.

Specifi ed number of 
characters num_of_chars

Starts here

Character position/
number

1 2 3 4 5 6 7 8

F U N C T I  O N

         

 •  Use the same worksheet as in activity 5.26.
 •  In cell D4 enter the function =right(A4,5).
 •  The answer returned in cell D4 will be “+I ON”. Note that the space between 

the “I” and “O” is counted as a character.

Specifi ed number of characters num_of_
chars number_of_characters_to return

Starts here

Character position/
number

1 2 3 4 5 6 7 8 9 10 11 12

F * U N C T + I O  N

 •  The results of activities 5.22 to 5.27 should appear as follow:
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(f) Lookup functions

Vertical lookup: =VLOOKUP(lookup_value,table_array,col_index_num,range_lookup)

This function searches for a value in the leftmost (fi rst) column of a range of cells, and 
returns a value in the same row from a column you specify.

Lookup_value

This is the value you want to search in the fi rst column of the table_array (see table array 
below). Lookup_value can be a value, a cell reference or text. VLOOKUP returns the #N/A 
error value where the lookup_value is smaller than the smallest value in the fi rst column 
of table_array.

Table_array

This range of cells (two or more columns) contains the data you want to look up. The 
lookup_value searches the values in the fi rst column of the table_array. The values 
in the fi rst column of table_array can be text, numbers or values – upper-case and 
lower-case text are equivalent.

 •  If the range lookup is set as TRUE then the table_array must be sorted in ascending 
order based on the fi rst column. See section 5.1 in this study unit on how to sort data.

 •  If range_lookup is set as FALSE, the table_array lookup value should be unique 
(primary key).

 •  The data in the fi rst column of table_array should not contain leading spaces, trailing 
spaces, inconsistent use of quotation marks or non-printing characters because vlookup 
may return an incorrect or unexpected value.

 •  When searching for number or data values make sure the data in the fi rst column of 
table_array is not stored as text but as values.

Col_index_num

This is the column number in table_array (refer to table_array above) from which the 
matching value should be returned. The number 1 will return the value in the fi rst column 
of the table_array, while 2 will return the value in the second column of the table_array.

 •  VLOOKUP will return a #VALUE! error if the col_index_num is less than 1.
 •  VLOOKUP will return a #REF! error if the col_index_num is greater than the number 

of columns in table_array.

Range_lookup

This specifi es whether you want VLOOKUP to fi nd an exact or an approximate match.

 •  When set as TRUE, an exact or approximate match is returned – that is, if an exact 
match is not found, the next largest value that is less than lookup_value is returned.

 •  When set as FALSE, an exact match is found and the error value #N/A is returned if 
no match is found. If there is more than 1 value in the fi rst table_array that matches 
the lookup_value, then the fi rst value that is found is used.

Always use FALSE unless you have a good reason to do otherwise.
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VLOOKUP means that Microsoft Offi ce Excel will go vertically down a list until it 
fi nds the value it is looking for, then jump right to the appropriate column and return 
that information.

         

 •  Create a new worksheet.
 •  Enter the following data in the worksheet:

A B C D

1 Assignment mark list

2 Student nr Name Assignment 
mark

3 123456 Peter 80

4 234567 Sarah 65

5 345678 Thab o 34

6 456789 Sandy 56

7 567890 Thomas 48

8 678901 Viwe 78

9 789012 Abel 51

10 890123 Rikki 49

11 912345 Martin 63

12

13 Exam mark list

14 Student nr Name Exam marks

15 789012 Abel J 64

16 912345 Martin Q 57

17 123456 Peter R 45

18 890123 Rikki B 49

19 456789 Sandy D 53

20 234567 Sarah M 62

21 345678 Thabo H 72

22 567890 Thomas V 55

23 678901 Viwe C 46

 •  You want to create one list with both the exam marks and fi nal marks beside 
each student’s name. You have decided to refl ect the exam marks beside 
the assignment marks but you do not want to go and fi nd each student’s 
exam mark manually and then type it beside the assignment marks. You 
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also know that the student number is unique to each student and refl ected 
in both sets of data. How can you do this?

 •  You can use the VLOOKUP. What formula would you enter?
 •  In cell D3 enter =VLOOKUP(A3,A$15:C$23,3,FALSE).

Structure The formula Explanation

Begins with = 
sign =

Function name VLOOKUP

Opening 
parenthesis (

Lookup_value A3

The value you want to look up in 
the exam mark list (table_array) 
is the student number, which is 
refl ected in cell A3.

Table_array A$15:C$23

You will fi nd the data for the 
exam marks in this range of cells. 
Note that the student number is 
in the fi rst column (A) of the data 
range because the value you 
are looking for should always be 
in the fi rst column. Also note that 
the row references are absolute 
because you do not want the 
data range reference to change 
when you copy the formula.

Col_index_num 3
The exam marks are in column 
C, the third column of the 
table_array.

Range_lookup FALSE
It is set as FALSE because you 
want to fi nd the exact match for 
the student number.

Closing 
parenthesis )

 •  Copy the formula in cell D3 to range D4:D11.
 •  Manually check to see if the formula gave the correct exam mark to the 

correct student.
 –  Why was the student name not used as the lookup_value? The reason 

is that there may be more than one student with the same name and 
because the student name in the two lists are not EXACTLY the same.

 –  Why was absolute references used for the table_array, but not for the 
lookup_value?

 –  Why was range_lookup specifi ed?
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 •  The results should appear as follow:
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         

 •  Create a new worksheet.
 •  You have calculated the taxable income for a number of friends and now 

want to determine their applicable tax rate.
 •  You have created the following spreadsheet with each person’s taxable 

income as well as the tax table. Enter the following data in the worksheet:

A B C D

1 Taxable income

2 Name Taxable income Fixed tax amount Tax rate

3 Peter 358,000

4 Sarah 279,000

5 Thab o 155,000

6 Sandy 86,000

7 Thomas 198,600

8 Viwe 412,300

9 Abel 567,000

10 Rikki 654,000

11 Martin 220,000

12    

13 Tax table   

14 Taxable income Fixed tax amount Tax rate above 
lower limit-1

15 Lower bracket Upper bracket  

16 1 150,000 0 18%

17 150,001 235,000 27,000 25%

18 235,001 325,000 48,250 30%

19 325,001 455,000 75,250 35%

20 455,001 580,000 120,750 38%

21 580,001 - 168,250 40%
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 • You do not want to look up each person’s fi xed tax amount and tax rate 
individually but want to use a Microsoft Offi ce Excel formula. Which formula 
would you enter in cell C3? You would copy this formula to the rows below.

 •  In cell C3 enter =VLOOKUP(B3,A$16:D$21,3,TRUE).

Structure The formula Explanation

Begins with = sign =

Function name VLOOKUP

Opening 
parenthesis (

Lookup_value B3

The value you want to look up 
in the tax table (table_array) is 
the taxable income, which is 
refl ected in cell B3.

Table_array A$16:D$21

You want to look for the values 
in the tax table which can be 
found in this range of cells. 
Note that the value for which 
the lookup_value is looking 
should be in the fi rst column 
of the data range (column A in 
this example). Also note that 
the row references are absolute 
because the cell references 
should not change when you 
copy the formula downwards.

Col_index_num 3

When you fi nd the row with the 
data you are looking for, this will 
indicate to the function which 
column’s data you want to be 
returned. The fi xed tax amount 
is in column C, the third column 
of the table_array.

Range_lookup TRUE

It is set as TRUE because you 
want to fi nd the next largest 
value that is less than the 
lookup value – that is, you want 
to fi nd the lower bracket of the 
tax group.

Closing 
parenthesis )
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 •  In cell D3 enter =VLOOKUP(B3,A$16:D$21,4,TRUE).

Structure The formula Explanation

Begins with = sign =

Function name VLOOKUP

Opening 
parenthesis (

lookup_value B3

The value you want to look up 
in the tax table (table_array) is 
the taxable income, which is 
refl ected in cell B3.

Table_array A$16:D$21

You want to look for the values 
in the tax table that can be 
found in this range of cells. Note 
the value for which the lookup_
value is looking to match against 
should be in the fi rst column 
(column A in this example) of 
the data range. Also note that 
the row references are absolute 
because the cell references 
should not change when you 
copy the formula downwards.

Col_index_num 4

This tells the function which 
column’s data you want to be 
returned that is included in the 
row containing the data you are 
looking for. The tax rates are in 
column D, the fourth column of 
the table_array.

Range_lookup TRUE

It is set as TRUE because you 
want to fi nd the next largest 
value that is less than the 
lookup value – that is, you want 
to fi nd the lower bracket of the 
tax group in which the taxable 
amount belongs.

Closing 
parenthesis )

 • Copy the formula in C3 to range C4:C11 and copy the formula in D3 to 
range D4:D11.

 •  The results should appear as follows:
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5 Working with data

5.1 Sorting data
Sorting data is a great tool to present your information neatly and logically or to analyse 
data. You can use it to put a list of names in alphabetical order, arrange amounts from 
highest to lowest or from biggest to smallest or arrange dates from earliest to latest. You 
can either sort the data in ascending order (going up/lowest to the highest) or descending 
order (going down/highest to lowest). You can also sort the data based on sorting criteria 
for more than one column.

Make sure you select the whole range you want to sort and not only the column on which 
you want to base the sort. The data in the other columns beside the particular column 
will not follow the sort if you only select the column on which you want to base the sort.

        

 •  Use the completed spreadsheet in activity 5.21
 •  We fi rst want to sort the adult and child indicator per column B so that all 

the children are refl ected fi rst. At the same time, we also want to sort the 
ages for each group (column C) from youngest to oldest.

 •  Select range A8:F18.
 •  Click on the Data tab on the Ribbon.
 •  In the Sort & Filter group, click on the Sort icon.
 •  This will open the following Sort dialogue box:

 •  Ensure that the My data has headers box has been ticked (otherwise the 
headers will be sorted inside the data).

 •  Click on the arrow in the Sort by dialog box and select Adult/child from 
the drop-down menu.

 •  Click on the arrow in the Sort on dialog box and select Values from the 
drop-down menu.
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 •  Click on the arrow in the Order dialog box and select Z to A from the drop-
down menu.

      

 •  Click on Add Level to add another sort criteria (you can add as many as 
you need).

 •  Click on the arrow in the Then by dialog box and select Age from the drop-
down menu.

 •  Click on the arrow in the Sort on dialog box (in the Then by row) and select 
Values from the drop-down menu.

 •  Click on the arrow in the Order dialog box (in the Then by row) and select 
Smallest to Largest from the drop-down menu.

      

 •  Your complete selection will appear as follows:

 •  Click OK to action the sort.
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 •  The result of the sort will appear as follows:

5.2 Filter data
Filtering data allows you to display only the rows that meet your specifi ed criteria and to 
hide the rows you do not want displayed. You can also fi lter by more than one column, but 
remember that fi lters are additive, which means each additional fi lter is based on the current 
fi lter, and further reduces the subset of data. The fi lter will only apply to the selected data 
range. You can copy, fi nd, edit, format, chart and print the subset of fi ltered data without 
rearranging or moving it. You can only fi lter by a list values, a format or criteria. However, 
each of these fi lters is mutually exclusive. You can, for example, fi lter by font colour or by 
a list of numbers, but not both.

        

 •  Use the completed spreadsheet of activity 5.21.
 •  Select range A8:F18.
 •  Click on the Data tab.
 •  In the Sort & Filter group, click on the Filter icon.
 •  This will create drop-down arrows next to each column heading.

Drop-down 
arrow

 •  Click on the drop-down arrow next to 
“Invite to after party”.

 •  In the drop-down menu only select 
“Don’t invite”.

 •  Click on OK.                  
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 •  Only the rows with “Don’t invite” in that column are displayed and they will 
appear as follows:

 •  Did you notice the following:

 –  The fi lter icon is displayed on the drop-down arrow next to “Invite to after 
party”. This indicates that a fi lter is applied on that column.

 –  The row reference displayed seems to be missing rows, that is, only 
rows 1 to 8, 11 to 13 and 15 to 18 are displayed. The applied fi lter did not 
delete rows 9, 10 and 14 but only hid them from view.

 •  We now only want to display all the persons who were not invited but who 
are younger than 10. To do this we will apply an additional fi lter.

 •  Click on the drop-down arrow next to “Age” and select Number Filters.
 •  In the drop-down menu select Less Than… .
 •  This will open the Custom AutoFilter dialog box.
 •  Click on the box to the right of is less than and either type 10 or select 10 

from the drop-down menu.
 •  Click OK to action the fi lter.
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 •  Only the rows with “Don’t invite” in column E and where the person’s age 
(column C) is less than 10 are displayed and the rest of the rows are hidden. 
The spreadsheet will appear as follows:

 •  Did you notice the following:

 –  The fi lter icon is displayed on the drop-down arrow next to “Invite to after 
party” and “Age”. The fi lter icon indicates that a fi lter has been applied 
on that column.

 –  The row reference displayed seems to be missing rows – that is, rows 
1–8, 13, 15, 16, but not the other rows, are displayed. The applied fi lters 
did not delete the other rows but only hid them.

 •  To remove a fi lter from a particular column, click on the applicable column’s 
drop-down arrow and tick next to (Select All). You can also change the fi lter 
by clicking on the applicable column’s drop-down arrow and selecting the 
new fi lter you want to apply.

 •  To remove all fi lters in total from the data range follow the following steps:

 –  Select the data range that was fi ltered.
 –  Click on the Data tab.
 –  In the Sort & Filter group, click on the Filter icon to deselect the fi lter 

option.
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6 Working with charts
Charts are visual/graphical representations of data and are useful in helping to understand 
and interpret the data presented. Charts sometimes make it is easier to identify trends in 
data.

Bear in mind that the people looking at a chart do not have the underlying data in front of 
them, so it is vital to ensure that the following are always included in a chart:

 •  A chart title. The title of your chart needs to be descriptive and indicate what your 
chart is all about.

 •  Category-axis title. This is a short description of the categories on the category-axis 
(eg months, item codes, etc). Charts mostly display categories on the horizontal axis 
(x), whereas bar charts display categories on the vertical axis (y).

 •  Value-axis title. This is a short description of the values on the value-axis (eg rand, 
number, percentage, etc). Charts mostly display values on the vertical axis (y), while 
bar charts display values on the horizontal axis (x).

 •  Category-axis scale label. This describes each category-axis scale – for example, 
if your category-axis title is, say, “Months”, the scale label will probably be “January”, 
“February”, “March” and so on.

 •  Legend. This indicates what colour represents which particular data series.

6.1 Creating a chart
To create a chart, follow the steps below.

        

 •  Create the following data in a new Workbook fi le on Sheet1:

 –  “Total sales R (Actual)” is calculated as the applicable number of “Items 
sold (Actual)” * R150.

 –  “Total sales R (Budget)” is calculated as the applicable number of “Items 
sold (Budget)” * R100.

 •  Save the Workbook fi le as “GRAPH”.

A B C D E

1 SA Textbooks Pty Ltd

2

3 Items sold 
(Actual)

 Items sold 
(Budget)

Total sales R 
(Actual)

Total sales R 
(Budget)

4 Jan 1567 1500 235,050 150,000

5 Feb 975 1000 146,250 100,000

6 Mar 445 560 66,750 56,000

7 Apr 1249 1300 187,350 130,000

8 May 368 300 55,200 30,000

9 Jun 1345 1100 201,750 110,000

 •  Select range A3:C7
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Excel is very particular when a data range is selected.  The range SHOULD be 
selected correctly the fi rst time.  For example, in this activity, do not move your 
mouse pointer over column D and then back to column C.

 •  While the above-mentioned range is selected:

 –  Click on the Insert tab.
 –  In the Chart group, click on the arrow next to the Column icon.
 –  In the drop-down menu, select 2D Clustered Column (Hint: Hovering 

with your mouse pointer over the different chart icons will make the 
description of the icon appear.)

 –  You will notice that the graph inserted into your worksheet is basic without 
any graph and axis titles and so on. You are going to update the graph 
to be more user friendly.

 –  Click anywhere on the graph. You will notice that a new tab is now available 
on the Ribbon: Chart Tools. The Chart Tools will add three more tabs: 
Design, Layout and Format.

 •  Click on the Layout tab.
 •  In the Labels group, click on the arrow below the Chart title icon.
 •  In the drop-down menu, select Above Chart.
 •  This will open a text box in the chart area above the chart with the text 

“Chart title”.
 •  Click in the text box and delete “Chart Title”. Type in “Textbooks sold per 

month”.
 •  In the textbox, highlight “Textbooks sold per month”.

 –  Click on the Home tab and change the font of the chart title to Arial, font 
size 16, Bold and Italic.

 •  Click on the Layout tab.
 •  In the Labels group, click on the arrow below the Axis Titles icon.
 •  In the drop-down menu, click on the arrow next to Primary Horizontal 

Axis Title.
 •  In the drop-down menu, select Title Below Axis.
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 • This will open a text box in the chart area, below the chart, with the text 
“Axis title”.

 •  Click in the box and delete “Axis title”. Type in “Months”.

 •  Click on the Layout tab.
 •  In the Labels group, click on the arrow below the Axis Titles icon.
 •  In the drop-down menu, click on the arrow next to Primary Vertical Axis 

Title.
 •  In the drop-down menu, select Vertical Title.
 •  This will open a text box in the chart area, left of the chart, with the text 

“Axis title”.
 •  Click in the box and delete “Axis title”. Type in “Number”.

 

 •  Click on the Design tab.
 •  In the Location group, click on the Move Chart icon.
 •  Select New sheet: and change the name from Chart1 to Number.
 •  Click on OK.

Did you notice that the graph was moved to a new worksheet called “Number”?

 •  Save the workbook fi le “GRAPH”.
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 •  The graph you created should appear as follows:

        

 •  Use the worksheet created in activity 5.32 (ie the fi le called “GRAPH”).
 •  Select ranges A3:A9 and D3:E9 simultaneously by using the control key.

 –  This is done by selecting range A3:A9.
 –  While the above-mentioned range is selected, press the “CTRL” (control) 

key on the keyboard.
 –  While the “CTRL” (control) key is pressed down, used the mouse to select 

range D3:E9.

 •  While the above-mentioned range is selected, click on the Insert tab on 
the Ribbon.

 •  In the Chart group, click on the arrow below the Line with Markers icon.
 •  In the drop-down menu, select 2D Line. (Hint: If you hover your mouse 

pointer over the different chart icons, the description of the icon will appear.)
 •  You will notice that the graph inserted into your worksheet is basic without 

any chart title or axis titles, etc.
 •  Click on the graph so that the Chart Tools tabs on the Ribbon will be 

displayed.
 •  Click on the Layout tab on the Ribbon.
 •  In the Labels group, click on the arrow below the Chart title icon.
 •  In the drop-down menu, select Above Chart.
 •  This will open a text box in the chart area above the chart with the text 

“Chart title”.
 •  Click in the text box and delete “Chart Title”. Type in “Total sales per month”.
 •  Click on the Layout tab on the Ribbon.
 •  In the Labels group, click on the arrow below the Axis Titles icon.
 •  In the drop-down menu, click on the arrow below Primary Horizontal Axis 

Title.
 •  In the drop-down menu, select Title Below Axis.
 •  This will open a text box in the chart area, below the chart, with the text 

“Axis title”.
 •  Click in the text box and delete “Axis title”. Type in “Month”.
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 •  Click on the Layout tab on the Ribbon.
 •  In the Labels group, click on the arrow below the Axis Titles icon.
 •  In the drop-down menu, click on the arrow below Primary Vertical Axis Title.
 •  In the drop-down menu, select Rotate Title.
 •  This will open a text box in the chart area, to the left of the chart, with the 

text “Axis title”.
 •  Click in the text box and delete “Axis title”. Type in “Rand”.

    

 •  Click on the Layout tab on the Ribbon.
 •  In the Labels group, click on the arrow below 

the Legend icon.
 •  In the drop-down menu, select Show Legend 

at Bottom.
 •  Click on the Design tab on the Ribbon.
 •  In the Location group, click on the Move Chart 

icon.
 •  Select Object in: and select Sheet2 from the 

drop-down menu (click on the arrow to activate 
the menu).

 •  Click on OK.                   

Did you notice that the graph was moved to Sheet2?

 •  Save the workbook fi le “GRAPH”.
 •  The graph you created should appear as follows:
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Note the difference in the look and feel between moving the chart to a New 
sheet or to an Object in another sheet.

6.2 Updating data in a chart
(a) Updating source data

You can update the range of data the chart is reading after it was created. For example, 
you would use this to add an additional month’s information as it becomes available.

        

 •  Click on the chart created in activity 5.32.
 •  Click on the Design tab on the Ribbon.
 •  In the Data group, click on the Select data icon.
 •  This will open the Select Data Source Data dialog box.

 •  Note that your current data selection has dotted lines around it.
 •  Also note the current Chart data range: =‘Sheet1’!$A$3:$C$7.
 •  Update the data range to include May and June’s data by

 –  clicking on the table with the data and re-selecting the data range (ie 
A3:C9) to include the new data range (note that your new data selection 
has dotted lines around it)

or

 –  changing the information in the Chart data range: box from 
=‘Sheet1’!$A$3:$C$7 to =Sheet1!$A$3:$C$9

 •  Click on OK to action the change.
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 •  The updated graph will appear as follows:

(b) Changing the chart type

Microsoft Offi ce Excel provides many different type of charts, including 3D charts. You 
can change the type of chart after you have created it.

        

 •  Click on the chart created in activity 5.33 or activity 5.34.
 •  Click on the Design tab on the Ribbon.
 •  In the Type group, click on the Change Chart Type icon.
 •  This will open the Change Chart Type dialog box.
 •  Experiment by choosing different types of charts.
 •  Click on OK to action the change.
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(c) Changing the chart layout and format

You can customise your chart to give it your own individual look. You can, for example, 
apply specifi c shape styles and format the shapes and text of chart elements.

        

 •  Click on the chart created in activity 5.33, activity 5.34 or activity 5.35.
 •  Click on the Layout tab on the Ribbon.
 •  Experiment by selecting different icons on this tab.
 •  Click on OK to action the changes.

 •  Click on the Format tab on the Ribbon.
 •  Experiment by selecting different icons on this tab.
 •  Click on OK to action the changes.

7 Spreadsheets: the bigger picture
We have included this fi nal section to help you see the bigger picture. Now that you have 
worked through this study unit and have mastered the basic formulas and functions included 
in the AIN2601 syllabus, it is time for you to apply this knowledge to simulated real-life 
scenarios. We have taken the time to compile three assessment questions to demonstrate 
how you would apply your newly gained knowledge in an examination situation.

We would like to use this opportunity to stress the importance of examination technique. 
If you combine your subject knowledge with the correct examination technique, you will 
pass the Microsoft Offi ce Excel portion of the examination with fl ying colours.

 •  Remember that we actually try to guide you in the right direction in the question. Always 
read the spreadsheet from TOP to BOTTOM, LEFT to RIGHT as well as the given 
case study information. Keep that in mind. You will fi nd the necessary information to 
answer the questions.

 •  “Formulas” and “functions” are similar, and the terms are sometimes used 
interchangeably. You will always see this sentence in your Microsoft Offi ce Excel 
questions in the examination:

 “Note: Where it is indicated that your formula will be copied to other cells, your formula 
should take absolute and relative addresses into account, but only where necessary!”

This reminds you that you need to consider whether the formula will be copied down or 
across the spreadsheet, which will infl uence the absolute and relative cell references 
to be included in the formula/function. However, refer to the last part of the sentence 
again: “…but only where necessary!” Invest the time in gaining a sound understanding of 
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absolute and relative references. It is incorrect to use absolute references unnecessarily. 
You will not receive a mark for an absolute reference that has been used unnecessarily.

 •  As far as copying down (over rows) and across (over columns) is concerned, we will 
never tell you whether you are copying down or across, but the clue will be in looking 
at the cell range to which we want you to copy the formula. If the rows change, for 
example, C11:C14, then you are copying DOWN and the row reference should include 
an absolute reference if necessary. If the columns change, for example, C11:K11, 
then you are copying ACROSS and the column reference should include an absolute 
reference if necessary.

 •  This hint is based on your own personal preference: If you become fl ustered when trying 
to do basic calculations in Microsoft Offi ce Excel, do the mathematical calculation fi rst 
and then substitute the amounts with the correct cell references. However, indicate 
your fi nal answer clearly (with the cell references).

 •  Make sure you indicate your fi nal answer clearly. Avoid using the word OR, because 
we will only mark your fi rst answer. Your fi nal answer will be marked if you have clearly 
indicated the formula to be your fi nal answer.

 •  You must learn all formula structures by heart. When you start writing your paper, fi rst 
write down all structures so you can refer back to them once you start with the Microsoft 
Offi ce Excel questions. This should prevent you from becoming fl ustered when you 
are pressed for time.

 •  Frequent mistakes in Microsoft Offi ce Excel questions

When marking a Microsoft Offi ce Excel question, one mark per error will be deducted for 
the mistakes indicated below. Bear in mind that we will only deduct marks until you have 
zero for a formula – you will therefore never receive a negative mark for that specifi c formula.

 •  Not starting the formula with =

Correct Lose 1 mark

=sum(B5:B19) sum(B5:B19)

=if(C3>B4,500,1000) if(C3>B4,500,1000)

 •  Using [ ] instead of ( )

Correct Lose 1 mark

=sum(B5:B19) =sum[B5:B19]

=if(C3>B4,500,1000) =if[C3>B4,500,1000]

 •  Incorrect use of parentheses ( )

Correct Lose 1 mark

=sum(B5:B19) =sum(B5:B19

=if(C3>B4,500,1000) =(ifC3>B4,500,1000)

=sum(B5:B19) =sumB5:B19)
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 •  Using ; instead of : or , (see section 3.2 in this study unit)

Correct Lose 1 mark per incorrect syntax

=sum(B5:B19) =sum(B5;B19) 1 mark lost

=if(C3>B4,500,1000) =if(C3>B4;500;1000) 2 marks lost

 •  Using SUM in a formula where it is unnecessary

Correct Lose 1 mark

=B5+B10 =sum(B5+B10)

=B10*B4 =sum(B10*B4)

=B5/B10 =sum(B5/B10)

 • Not using “ ” when using text in a formula

Correct Lose 1 mark per incorrect syntax

=if(C3=“yes”,“open”,“close”) =if(c3=yes,“open”,“close”) 1 mark lost

=if(C3=“yes”,“open”,“close”) =if(c3=“yes”,open,close) 2 marks lost

=if(C3=“yes”,“open”,“close”) =if(c3=yes,open,close) 3 marks lost

 •  Using mathematical signs instead of Microsoft Offi ce Excel signs

Correct Lose 1 mark

* x

/ ÷

 •  Using a formula when a function is available

Correct Lose 1 mark

=sum(B5:B10) = B5+B6+B7+B8+B9+B10

=average(B5:B10) =(B5+B6+B7+B8+B9+B10)/6

 •  Incorrect writing of values/amounts in a formula or function

Correct Lose 1 mark

0.1 0,1

100000 100 000 or R100000 or 100,000
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 •  Expressing percentages incorrectly

Correct Lose 1 mark

5%   5   or 5/100 or    5    *100 or 5/100*100
100                    1000.05

14%  14   or 14/100 or   14   *100 or 14/100*100
100                      1000.14

When you use a cell displaying a % format in any of your formulas/functions, DO NOT 
multiply or divide the value by 100. Multiplying by 100 when expressing percentages is 
incorrect because the end result will be 100 times more than it should be. Dividing by 100 
when expressing percentages is also incorrect because the end result will be 100 times 
less than it should be.

A percentage is a fraction where 1 equals the whole or 100%. Multiplying by 100% at the 
end of a formula is correct because 100% is effectively 1 (1.00), where 1 times any value 
= the original value you multiplied the 1 by.

Also refer to the above examples of the 5% and 14% being expressed as 0.05 and 0.14 
respectively.

Note: No student will receive less than 0 for a particular formula.

8 Summary
By using spreadsheets as business applications, you can perform either simple or complex 
calculations. We showed you how Microsoft Offi ce Excel can help you solve business 
and accounting problems you may encounter when using different formulas and various 
functions.

In the next study unit we focus on spreadsheet security risks and controls.

          

QUESTION 1   (included and discussed in this question: LEFT, MID, RIGHT, 
ROUND, IF, PMT, SUM, AVERAGE)

During the holidays you work for an organisation named “Dreams Made Possible” (DMP). 
This organisation provides study loans for students at African University. Most of the 
calculations are currently performed on paper. Your supervisor knows that you have 
spreadsheet skills and has therefore requested you to create a spreadsheet that can 
automatically perform the loan calculations.

Your supervisor supplies you with the following information:

 •  African University provides DMP with a student’s student number and the number of 
modules he or she has passed and the number of modules he or she has failed.
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 •  The University provides a student’s results for modules taken all in one fi eld (see range 
B8:B12). The format of that fi eld is number of modules passed(P):number of modules 
failed(F). The total number of modules taken by a student to date is the sum of the 
modules passed and failed. For example 3(P):4(F) will indicate that a student has 
passed three modules, has failed four modules and has taken seven modules in total 
(3 passed + 4 failed = 7 in total).

 •  A student’s module pass rate is calculated as the number of modules passed, divided 
by the total number of modules taken to date.

 •  Students with a pass rate of less than 50% can borrow money at an annual interest 
rate of 20%, while students with a pass rate of greater than or equal to 50% can borrow 
money at an annual interest rate of 15%. The applicable interest rates were entered 
into cell B2 and cell B3 respectively.

 •  All student loans must be repaid, in full, over fi ve years.
 •  All loan repayment instalments are paid at the end of the month.

You know that there is a formula in Microsoft Excel that can calculate a loan instalment /
repayment amount. You have used the help function to obtain the format of the applicable 
formula:

=PMT(rate,nper,pv,fv,type).

You have created the spreadsheet below:

A B C D E F G H
1 Module 

pass rate
Interest 
rate per 
annum

2 0% – 49% 20%
3 50% – 100% 15%
4
5 Repayment 

term (years)
5

6
7 Student 

number
Modules 
Pass:Fail

Number
of 
modules 
passed

Number 
of 
modules 
failed

Module 
pass rate

Applicable 
interest 
rate

Loan 
amount

Repayment/
instalment 
amount per 
month

8 4123456 2(P):6(F) 2 6 25% 20% R 7,000 -R 185.46
9 4789012 6(P):2(F) 6 2 75% 15% R 3,000 -R 71.37
10 3345678 2(P):0(F) 2 0 100% 15% R 6,000 -R 142.74
11 4567890 5(P):4(F) 5 4 56% 15% R 4,000 -R 95.16
12 3678903 3(P):5(F) 3 5 38% 20% R 6,000 -R 158.96
13
14 Total R 26,000
15 Average -R 130.74
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QUESTION 1  (contd)

Required

Note:

Where it is indicated that your formula will be copied to other cells, your formula 
should take absolute and relative addresses into account, but only where necessary!

(a) Which spreadsheet formula was entered in cell C8 to extract the number of modules 
passed by student 4123456 from the information provided in cell B8? You may 
assume, for the purpose of your formula, that the number of modules passed or failed 
will not exceed nine (9). Note: Your formula will be copied to cells C9:C12. (2)

(b) Which spreadsheet formula was entered in cell D8 to extract the number of modules 
failed by student 4123456 from the information provided in cell B8? You may assume, 
for the purposes of your formula, that the number of modules passed or failed will not 
exceed nine (9). Note: Your formula will be copied to cells D9:D12.  (3)

(c) Which spreadsheet formula was entered in cell E8 to calculate the module pass rate 
for student 4123456? The formula must round the module pass rate to two (2) decimal 
digits. Note: Your formula will be copied to cells E9:E12.  (3)

(d) Which spreadsheet formula was entered in cell F8 to determine the applicable interest 
rate per student based on the student’s module pass rate? Since DMP may change 
this rate in future, it would be best to refer to the applicable cells, instead of inserting 
the actual % in the formula. Refer back to the case study information. Note: Your 
formula will be copied to cells F9:F12.  (5)

(e) Which spreadsheet formula was entered in cell H8 to calculate the monthly repayment/
instalment amount? Refer back to the case study information. Note: Your formula 
will be copied to cells H9:H12.  (4)

(f) Which spreadsheet formula was entered in cell G14 to calculate the total amount 
loaned to students?  (2)

(g) Which spreadsheet formula was entered in cell H15 to determine the average 
repayment/instalment amount of all students? (2)

QUESTION 2   (included and discussed in this question: MID, RIGHT, calculating 
VAT % and markup margin, MAX, MIN)

You work for the Pretoria branch of Top Music, a music store selling both imported 
and local music CDs. Your branch must report at the end of each week to Top Music’s 
head offi ce in Johannesburg. The report writer programme, which creates the weekly 
statistics report from the line of business system, is not working. Your branch manager is 
excited because you volunteered to help create the required statistics from the raw line of 
business data (LOB data) which was exported to a spreadsheet.

Your branch manager supplies you with the following information:

 •  The Value Added Tax (VAT) percentage is 14%.
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 •  The markup margin is 20% for Local (L) CDs and 25% for Imported (I) CDs.
 •  The LOB data always consists of 19 characters and the structure is as follow:

 –  characters 1 to 3 are the number of units sold
 –  characters 4 to 12 are the product name
 –  characters 13 to 18 are the sales price per unit excluding VAT
 –  character 19 indicates if the product is Imported (I) or Local (L)
 –  for example:

9 9 9 P R  O D U C T N A 9 9 9 . 9 9 L

No. of 
units sold

Product name Sales price per unit 
excluding VAT

L=Local/
I=Imported

You have created the spreadsheet on the next page.

Required

Use the information supplied to answer the following questions relating to the spreadsheet 
provided.

Note:  Where it is indicated that your formula will be copied to other cells, your formula 
must take absolute and relative addresses into account, but only where necessary!

(a) Which spreadsheet formula was entered in cell D9 to extract the sales price per 
product excluding VAT for product LUIDKEELS from the LOB data provided in cell 
A9? Note: Your formula will be copied to cells D10:D14. (3)

(b) Which spreadsheet formula was entered in cell E9 to calculate the sales price per 
product including VAT for product LUIDKEELS? Note: Your formula will be copied 
to cells E10:E14. (3)

(c) Which spreadsheet formula was entered in cell G9 to extract the imported (I) or local 
(L) indicator for product LUIDKEELS from the LOB-data provided in cell A9? Note: 
Your formula will be copied to cells G10:G14. (2)

(d) Which spreadsheet formula was entered in cell I9 to calculate the total cost price 
including VAT for product LUIDKEELS? Note: Your formula will be copied to cells 
I10:I14.  (3)

(e) Which spreadsheet formula was entered in cell J17 to determine the highest total 
profi t, including VAT, of all products?  (2)

(f) Which spreadsheet formula was entered in cell J18 to determine the lowest total 
profi t, including VAT, of all products?  (2)
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QUESTION 3  (included and discussed in this question: &, FV, PV, Logical analysis)

Joseph, one of your colleagues at Top Music, heard of the excellent job you did in creating 
the weekly statistics using a spreadsheet and has therefore requested your help. An 
investment company has suggested a savings product for all employees of your branch. 
Joseph wants to show his co-workers what the possible amount is that they could receive 
at retirement if they start saving and investing now.

Joseph provides you with the following information and spreadsheet formulas:

 •  The staff member’s identity number is given, which Joseph obtained with the person’s 
approval. The fi rst two (2) characters of an identity number indicate the year in which 
the staff member was born.

 •  The staff member’s monthly available income is indicated.
 •  All staff members were born before the year 2000.
 •  The normal retirement age is 65 years.
 •  The current investment return rate is 10% per annum.
 •  Each individual staff member’s investment term in years is equal to the difference 

between the normal retirement age and his or her current age.
 •  The investment company suggested that staff members who are 50 years and older 

should save 10% of their monthly available income and that staff members younger 
than 50 years should save 5% of their monthly available income.

 •  Monthly payments to the investment company will be made at the end of each month.
 •  =FV(rate,nper,pmt,pv,type)
 •  =PV(rate,nper,pmt,fv,type)

You have created the spreadsheet on the next page.

Required

Use the information supplied to answer the following questions relating to the spreadsheet 
that has been provided:

Note:  Where it is indicated that your formula will be copied to other cells, your formula 
must take absolute and relative addresses into account, but only where necessary!

(a) Which spreadsheet formula was entered in cell B8 to include a 19 at the beginning 
of the two-digit birth year in cell B7, thereby changing the birth year for Bipin from a 
two-digit year in cell B7 to a four-digit year? Note: Your formula will be copied to 
cells C8:F8. (2)

(b) Which spreadsheet formula was entered in cell B11 to calculate Bipin’s monthly savings 
amount based on the suggestions made by the investment company? The monthly 
savings amount must be a negative amount because it is an outfl ow of cash from 
the staff member to the investment company. Refer back to the information provided. 
Note: Your formula will be copied to cells C11:F11. (5)

(c) Which spreadsheet formula was entered in cell B12 to calculate the investment term 
in years for Bipin? Refer back to the information supplied. Note: Your formula will 
be copied to cells C12:F12. (2)

(d) Which spreadsheet formula was entered in cell B13 to calculate the expected value 
of Bipin’s total savings at the end of the investment term? Note: your formula will 
be copied to cells C13:F13. (4)
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         

QUESTION 1  (step-by-step illustrated solution)

Note:  Where it is indicated that your formula will be copied to other cells, your 
formula should take absolute and relative addresses into account, but 
only where necessary!

(a) Which spreadsheet formula was entered in cell C8 to extract the number of 
modules passed by student 4123456 from the information provided in cell 
B8? You may assume, for the purpose of your formula, that the number of 
modules passed or failed will not exceed nine (9). Note: Your formula will 
be copied to cells C9:C12. (2)

Step 1: Identify the formula to be used: LEFT

Step 2: Formula structure: =LEFT(cell,num_chars)

Step 3: Write down your answer: =LEFT(B8,1)

Step 4:  Will the formula be copied? Yes, the formula will be copied to cell 
C9:C12. The column stayed the same (ie C), and the rows changed 
from 9:12 which means you are copying DOWN. Did you identify any 
cell references that should contain an absolute reference? NO – the cell 
reference, B8, needs to change to B9, B10, and so forth, as you copy 
the formula down.

Structure The formula Explanation
Begins with = 
sign =

Function name LEFT

You need to insert a formula into cell C8, based on information 
extracted from cell B8. The second bullet point in the case 
study gave information on the structure of B8, from which 
the number of modules passed is to be extracted. For 
example, 3(P):4(F) will indicate that a student has passed 
three modules, has failed four modules and has taken 
seven modules in total (3 passed + 4 failed = 7 in total). The 
information pertaining to the number of modules passed is 
on the left-hand side of cell B8, and we therefore need to use 
the “left” function because it returns a specifi ed number of 
characters (num_chars) from the start (left-hand side) of the 
text. It was essential to read the information supplied and 
the spreadsheet layout provided to be able to answer 
this question because it gave all the clues on how to 
answer the question.

Opening 
parenthesis (

cell B8
This argument indicates to Microsoft Offi ce Excel from which 
cell information will be extracted, in this instance, from cell 
B8, as stated in the question.
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num_chars 1

From the content of cell B8 (ie 2(P):6(F)), which character/s 
do you need to be returned in cell C8? You need the number 
of modules passed only, which will be 2, NOT 2(P). You need 
to physically count the number of characters to let Microsoft 
Offi ce Excel know how many characters from cell B8 should 
be returned in cell C8. A character means every time you 
have touched the keyboard, which means a space also counts 
as one character since you have touched the space bar. In 
this instance it is the number of modules passed only, the 
2, and that is only one character.

Closing 
parenthesis ) Do not forget!

(b) Which spreadsheet formula was entered in cell D8 to extract the number 
of modules failed by student 4123456 from the information provided in cell 
B8? You may assume, for the purposes of your formula, that the number 
of modules passed or failed will not exceed nine (9). Note: Your formula 
will be copied to cells D9:D12.  (3)

Step 1: Identify the formula to be used: MID

Step 2: Formula structure: =MID(cell,start_num,num_chars)

Step 3: Write down your answer: =MID(B8,6,1)

Step 4:  Will the formula be copied? Yes, the formula will be copied to cells 
D9:D12 which means you are copying DOWN because the column did 
not change, only the rows. Did you identify any cell references where 
you want to include an absolute reference? NO: The cell reference B8 
should change as you copy the formula down.



. . . . . . . . . . .
158TO PI C 2

Structure The formula Explanation
Begins with = sign =

Function name MID

Why did you decide to use the “mid” function instead of “left” or 
“right”? The question wanted you to extract the number of modules 
failed from cell B8. From the content in cell B8 (ie 2(P):6(F)), you 
only need to extract 6 and NOT 6(P). That explains why you cannot 
use the “left” or “right” function, because 6 is in the middle of the 
text string. You have therefore opted to use the “mid” function 
because it returns a specifi ed number of characters from the 
middle of a text string given a starting position (start_num) and 
the length specifi ed (num_chars).

Opening parenthesis (

cell B8
This argument indicates to Microsoft Offi ce Excel from where 
information will be extracted, and in this instance, it will be from 
cell B8, as stated in the question.

start_num 6

This is where the main difference between the “mid” function 
and the “left” and “right” functions lies. With “left” and “right”, 
Microsoft Offi ce Excel already knows where to start “counting” 
in order to return the specifi ed number of characters, but in the 
case of using the “mid” function, you will need to tell Microsoft 
Offi ce Excel where to start counting – in other words, where the 
middle is (ie where to start counting). Bear in mind that this does 
not necessarily mean the actual mathematical middle, it simply 
means somewhere in the middle.

num_chars 1

From the content of cell B8 (ie 2(P):6(F)), which character(s) do 
you need to be returned in cell D8? The number of modules failed 
only, which will be 6, NOT 6(F). You need to physically count the 
number of characters to let Microsoft Offi ce Excel know how 
many characters from cell B8 should be returned in cell D8. In 
this instance, it is the number of modules failed only, the 6, which 
is only one character.

Closing parenthesis ) Do not forget!
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IN ADDITION TO THE ORIGINAL QUESTIONS REQUIRED

Let us pretend that the question wanted the text “6(F)” to be returned 
in cell D8. You should be able to copy the formula to cell range D9:D12. 
What formula would you have used?

Step 1: Identify the formula to be used: RIGHT

Step 2: Formula structure: =RIGHT(cell,num_chars)

Step 3: Write down your answer: =RIGHT(B8,4)

Step 4:  Will the formula be copied? Yes, the formula will be copied to cell 
D9:D12. The column stayed the same – that is, D and the rows 
changed from 9:12, which means you are copying down. Did you 
identify any cell references that should have contained an absolute 
reference? NO – the cell reference, B8, needs to change to B9, B10, 
etc, as you copy the formula down.

Structure The formula Explanation
Begins with = 
sign =

Function name RIGHT

You need to insert a formula into cell D8, based on information 
extracted from cell B8. The question wanted the formula to 
return 6(F) from the text 2(P):6(F) in cell B8. You therefore 
need to indicate to Microsoft Offi ce Excel to start “counting” 
from the right.

Opening 
parenthesis (

cell B8
This argument indicates to Microsoft Offi ce Excel from where 
information will be extracted, in this instance, from cell B8, as 
stated in the question.

num_chars 4

From the content of cell B8 (ie 2(P):6(F)), which character(s) 
do you want to be returned in cell D8? The modules failed, 
6(F). You need to physically count the number of characters 
to let Excel know how many characters from cell B8 should 
be returned in cell D8. The number of modules failed, which 
will be 6(F), the four characters from the right.

Closing 
parenthesis ) Do not forget!
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(c) Which spreadsheet formula was entered in cell E8 to calculate the module 
pass rate for student 4123456? The formula must round the module pass 
rate to two (2) decimal digits. Note: Your formula will be copied to cells 
E9:E12. (3)

Step 1: Identify the formula to be used: ROUND

Step 2: Formula structure: =ROUND(formula,number_of_digits)

Step 3: Write down your answer: =ROUND(C8/(C8+D8),2)

Step 4:  Will the formula be copied? Yes, the formula will be copied to cell E9:E12. 
The column stayed the same – that is, E and the rows changed from 
9:12, which means you are copying DOWN. Did you identify any cell 
references that should have contained an absolute reference? NO – the 
cell reference, C8 and D8, needs to change to C9 and D9, C10 and 
D10, etc, as you copy the formula down.

Let us now go through the process of arriving at the above answer:

Read the case study information carefully again – the clue is right there.

“A student’s module pass rate is calculated as the number of modules passed 
divided by the total number of modules taken to date.”

Remember we are now looking at the information for student number 4123456. 
As per cell C8, he passed two modules and, as per cell D8, he failed six modules.

Now we are ready to start with the maths!

=number of modules passed/total number of modules taken to date
=2/(2+6)  (Pay special attention to the use of brackets, which infl uences 

the order of operation.)

The order of operation is the sequence of computation a formula follows 
to arrive at an answer. Microsoft Offi ce Excel uses the same order of 
operations as mathematics and will therefore perform computations in the 
following sequence:

 •  First:  computations/calculations in parentheses/brackets, no 
matter where they are in  the formula

 •  Second: computations with exponents
 •  Third:  computations involving multiplication (*) and division (/) 

from left to right
 •  Fourth:  computations involving addition and subtraction from left 

to right

Let us now look at the spreadsheet again. Are there perhaps cells containing 
some of these numbers that are used in the calculation above?

Yes! Now substitute the numbers with the cell references.

=2/(2+6) thus becomes
=C8/(C8+D8)
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Great! You are almost there. There is a second requirement in the question:

“The formula must round the module pass rate to two decimal digits.”

It is not always necessary to round the answer of a cell in a separate cell. The round 
function can be used with a formula in a cell: =ROUND(formula,number_of_digits)

Structure The formula Explanation
Begins with = sign =

Function ROUND The question requires the following: “The formula must round 
the module pass rate to two (2) decimal digits.”

Opening parenthesis (

Formula C8/(C8+D8) As calculated to obtain the module pass rate for the student – 
remember the order of operation rules!

number_of_digits 2 The question specifi es that the number should be rounded to 
two decimal digits.

Closing parenthesis ) Don’t forget!

(d) Which spreadsheet formula was entered in cell F8 to determine the applicable 
interest rate per student based on the student’s module pass rate? Because 
DMP may change this rate in future it would be best to refer to the applicable 
cells instead of inserting the actual % in the formula. Refer back to the case 
study information. Note: Your formula will be copied to cells F9:F12. (5)

Step 1:  Identify the formula to be used: IF. How did we know this? Refer back to 
the case study information: “Students with a pass rate of less than 50% 
can borrow money at an annual interest rate of 20%, while students with 
a pass rate of greater than or equal to 50% can borrow money at an 
annual interest rate of 15%.” Remember that the IF function is used when 
one needs to decide between two alternatives depending on a specifi c 
condition. In this instance, the information gave two alternatives, that is, 
students with a pass rate of less than 50% borrowing at an interest rate 
of 20% OR students with a pass rate of greater than or equal to 50% 
borrowing at an interest rate of 15%. The interest rate is determined by 
their pass rate. This is the clue that the IF function needs to be used.

Step 2: Formula structure: = IF(Logical_test,value_if_true,value_if_false)

Step 3:  Write down your answer: As you can see below, there is more than one 
correct answer, which we will discuss in detail in the table below. The 
logical test determines which outcome will be the true statement and 
which outcome will be the false statement.

OPTION 1: =IF(E8<0.5,B$2,B$3) or =IF(E8<50%,B$2,B$3)

OPTION 2: =IF(E8>=0.5,B$3,B$2) or =IF(E8>=50%,B$3,B$2)

Step 4:  Will the formula be copied? Yes, the formula will be copied to cells 
F9:F12, which means you are copying DOWN because the column did 
not change – only the rows. Did you identify any cell references where 
you want to include an absolute reference? YES: B$3 and B$2. A clue 
has been included in the information: “The applicable interest rates 
were entered in cell B2 and cell B3 respectively.” And in the question: 
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“Because DMP may change this rate in future it would be best to refer 
to the applicable cells instead of inserting the actual % in the formula.”

OPTION 1

Structure The formula Explanation

Begins with = sign =

Function name IF

The case study provides two alternatives. The IF function is 
used in the case where one needs to decide between two 
alternatives depending on a specifi c condition. See step 1 
above.

Opening 
parenthesis (

logical_test

E8<0.5 

OR 

E8<50%

You want to evaluate whether the student’s pass rate is below 
50%. Note that expressing 50% as either 50% or 0.5 would 
have been accepted as the correct answer, but 50/100 would 
have been incorrect.

value_if_the logical 
test is true B$2

You want the interest rate of 20% to be returned. The interest 
rate is in cell B2. An absolute reference needs to be included 
because you want this cell reference to stay fi xed as you 
copy it DOWN – that explains why the row is an absolute 
reference. $B2 is incorrect.

value_if_the logical 
test is false B$3

You want the interest rate of 15% to be returned. The interest 
rate is in cell B3. An absolute reference needs to be included 
because you want this cell reference to stay fi xed as you 
copy it DOWN – that explains why the row is an absolute 
reference. $B3 is incorrect.

Closing parenthesis )

OPTION 2

Structure The formula Explanation

Begins with = sign =

Function name IF

The case study provides two alternatives. The IF function is 
used in the case where one needs to decide between two 
alternatives depending on a specifi c condition. See step 1 
above.

Opening 
parenthesis (

logical_test

E8>=0.5 

OR 

E8>=50%

You want to evaluate whether the student’s pass rate is equal 
to or higher than 50%. Note that expressing 50% as either 
50% or 0.5 would have been accepted as the correct answer, 
but 50/100 would have been incorrect.
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value_if_the logical 
test is true B$3

You want the interest rate of 15% to be returned. The interest 
rate is in cell B3. An absolute reference needs to be included 
because you want this cell reference to stay fi xed as you 
copy it DOWN – that explains why the row is an absolute 
reference. $B3 is incorrect.

value_if_the logical 
test is false B$2

You want the interest rate of 20% to be returned. The interest 
rate is in cell B2. An absolute reference needs to be included 
because you want this cell reference to stay fi xed as you 
copy it DOWN – that explains why the row is an absolute 
reference. $B2 is incorrect.

Closing parenthesis )

(e) Which spreadsheet formula was entered in cell H8 to calculate the monthly 
repayment/instalment amount? Refer back to the case study information. 
Note: Your formula will be copied to cells H9:H12. (4)

Step 1:  Identify formula to be used: PMT. Why? Refer back to the question: 
“Which spreadsheet formula was entered in cell H8 to calculate the 
monthly repayment/instalment amount?”

Step 2: Formula structure: =PMT(rate,nper,pv,fv,type)

Step 3: Write down your answer: =PMT(F8/12,B$5*12,G8,0,0)

Step 4:  Will the formula be copied? Yes, the formula will be copied to cells 
H9:H12, which means you are copying DOWN as the column did not 
change – only the rows changed. Did you identify any cell references in 
which you want to include an absolute reference? YES, B$5, because it 
contains the repayment period and will stay fi xed when the formula 
is copied.

=PMT(F8/12,B$5*12,G8,0,0)

Structure The formula Explanation

Begins with = sign =

Function name PMT The question requires that “the formula must calculate the 
monthly repayment/instalment amount” which is a payment.

Opening 
parenthesis (

rate F8/12

The interest rate is annual (yearly) and needs to be divided 
by 12 to change it to a monthly rate, because the question 
requires “the monthly repayment/instalment amount” to be 
calculated. The annual interest rate must be changed to the 
same period as the required interest rate – hence from a 
yearly to a monthly rate.

nper B$5*12 The period is a term in years and should be multiplied by 12 
to change the period to months.

pv G8 The present value of the loan amount. This is the amount 
you want to loan from the bank in order to fi nance the loan.
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fv 0
The future value of the loan. Because the loan will be fully 
paid by the end of the period, as indicated in the case study, 
the future value of the loan is R0.

type 0 The instalment is paid at the end of the month (paid in arrears).

Closing parenthesis )

(f) Which spreadsheet formula was entered in cell G14 to calculate the total 
amount loaned to students?  (2)

Step 1: Identify the formula to be used: SUM

Step 2: Formula structure: =sum(cell1:cell2)

Step 3: Write down your answer: =SUM(G8:G13)

Step 4:  Will the formula be copied? No – therefore no absolute references need 
to be included in the formula.

Structure The formula Explanation

Begins with = sign =

Opening 
parenthesis (

Function name SUM

This function is used to save time by not having to add all 
the individual cells. Note that even though you will obtain 
the correct answer by adding together all the cells, that is, 
=G8+G9+G10+G11+G12+G13, you will not earn any marks 
because this is not the best option when you have a large 
number of cells to add.

(cell1:cell2) G8:G13

The range of cells to which the specifi c function/formula is 
applied. In this case, the function adds all the values in the 
specifi ed range of cells. Be careful not to include text (eg 
the column heading in the cell range).

Closing parenthesis ) Do not forget!

(g) Which spreadsheet formula was entered in cell H15 to determine the 
average repayment/instalment amount of all students? (2)

Step 1: Identify the formula to be used: AVERAGE

Step 2: Formula structure: =average(cell1:cell2)

Step 3: Write down your answer: =AVERAGE(H8:H12)

Step 4:  Will the formula be copied? No – therefore no absolute references need 
to be included in the formula.
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Structure The formula Explanation

Begins with = sign =

Opening parenthesis (

Function name AVERAGE

AVERAGE calculates the average of the values in a specifi ed 
range of cells.

This function is used to save time by not having to add 
all the individual cells and dividing the answer by the 
total number of cells added. Note that even though you 
will obtain the correct answer by adding all the cells and 
dividing the answer by the total number of cells added, that 
is, =(G8+G9+G10+G11+G12+G13)/6, you will not earn any 
marks because this is not the best option when you have a 
large number of cells to add.

(cell1:cell2) H8:H12
The range of cells to which the specifi c function/formula is 
applied. In this instance, the function calculates the average 
of the values in the specifi ed range of cells.

Closing parenthesis ) Do not forget!

[21]

QUESTION 2  (step-by-step illustrated solution)

Note:  Where it is indicated that your formula will be copied to other cells, your 
formula must take absolute and relative addresses into account, but only 
where necessary!

(a) Which spreadsheet formula was entered in cell D9 to extract the sales price 
per product excluding VAT for LUIDKEELS from the LOB data provided in 
cell A9? Note: Your formula will be copied to cells D10:D14. (3)

Step 1: Identify the formula to be used: MID

Step 2: Formula structure: =MID(cell,start_num,num_chars)

Step 3: Write down your answer: =MID(A9,13,6)

Step 4:  Will the formula be copied? Yes, the formula will be copied to cells 
D10:D14, which means you are copying DOWN because the column did 
not change, only the rows. Did you identify any cell references in which 
you want to include an absolute reference? NO: The cell reference A9 
should change as you copy the formula down.
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Structure The formula Explanation

Begins with = sign =

Function name MID

Why did you decide to use the “mid” function instead of “left” 
or “right”? The question required you to extract the sales price 
per product excluding VAT from cell A9. From the content in 
cell A9, that is, 172LUIDKEELS150.00L, you only need to 
extract 150.00. That explains why you cannot use the “left” 
or “right” function because 150.00 is in the middle of the text 
string. You have therefore opted to use the “mid” function 
because it returns a specifi ed number of characters from the 
middle of a text string, given a starting position (start_num) 
and the length specifi ed (num_chars).

Opening 
parenthesis (

cell A9
This argument indicates to Microsoft Offi ce Excel from where 
information will be extracted, and in this instance, it will be 
from cell A9, as stated in the question.

start_num 13

This is where the main difference between the “mid” 
function and the “left” and “right” functions lies. With “left” 
and “right”, Microsoft Offi ce Excel already knows where to 
start “counting” in order to return the specifi ed number of 
characters. However, when using the “mid” function, you will 
need to tell Microsoft Offi ce Excel where to start counting – 
in other words, where the middle is. Note that this does not 
necessarily mean the actual mathematical middle, it simply 
means somewhere in the middle.

num_chars 6

From the content of cell A9, that is, 172LUIDKEELS150.00L, 
which character(s) do you need to be returned in cell D9? 
You need the sales price per product excluding VAT to be 
returned. Now you need to physically count the number of 
characters to let Microsoft Offi ce Excel know how many 
characters from cell A9 should be returned in cell D9. A 
character means every time you have touched the keyboard, 
which means a full stop also counts as one character since 
you have touched the space bar. In this instance, it will be 
the sales price per product excluding VAT, which will be 
150.00 – which comprises six characters.
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Closing parenthesis ) Do not forget!

(b) Which spreadsheet formula was entered in cell E9 to calculate the sales 
price per product including VAT for LUIDKEELS? Note: Your formula will 
be copied to cells E10:E14. (3)

Refer back to section 2 in study unit 4 regarding the order of operation (section 
2.2), percentages (section 2.4) and working with VAT % and gross profi t % 
and mark-up (section 2.5). It is essential that you use your mathematical and 
accounting knowledge and know the order of operations used by Microsoft 
Offi ce Excel to answer the above correctly.

The order of operation

The order of operation is the sequence of computation a formula follows to 
arrive at an answer. Microsoft Offi ce Excel uses the same order of operations 
as mathematics and will therefore perform computations in the following 
sequence:

 •  First:  computations/calculations in parentheses/brackets, no matter 
where they are in the formula

 •  Second:  computations with exponents
 •  Third:  computations involving multiplication (*) and division (/) from 

left to right
 •  Fourth:  computations involving addition and subtraction from left to 

right

Step 1:  Identify the formula to be used. Microsoft Offi ce Excel does not have a 
specifi c formula for calculating VAT, so you will need to create a formula.

Step 2: Formula structure:

 

The amount you need to calculate in rand = the amount you need to 
calculate in percentage divided by the amount you have in percentage 
multiplied by the amount you have in rand.
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We are working towards calculating the sales price including VAT, using the 
sales price excluding VAT and the VAT %.

You can use the above formula or any other formula you are comfortable with 
to help you with these calculations.

By using the required and case study information, we have the following information 
available in calculating the sales price including VAT for LUIDKEELS:

R % Microsoft Offi ce 
Excel underlying 

value

Selling price (excluding VAT) 150 100 1.00 The amount you have 
in % (1.00)

The amount you have 
in R (R150)

VAT 14 0.14

Selling price (including VAT) ? 114 1.14 The amount you need 
in % (1.14)

The amount you need 
in R (R?)

The amount you need in R = the amount you need in % / the amount you have 
in % X the amount you have in R.

 •  The amount you need in % = 1.14 (you need to calculate the sales price 
including VAT).

 •  The amount you have in % = 1.00 (you have the sales price excluding VAT).
 •  The amount you have in R = R150 (you have the sales price excluding VAT 

in rand).
 •  1.14/1.00 * R150 = R171

Let us examine the spreadsheet again. Are there perhaps cells containing some 
of these amounts or percentages used in the calculation above?

Yes, there are! Now substitute the amounts and percentages with the cell 
references and let us put the above maths into a formula:

=(1+B$6)/1*D9

Using maths rules, this formula can be simplifi ed to: 1.14 * R150 = R171

=(1+B$6)*D9
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Adding a 1 in a formula

Whenever you are working with VAT and or gross profi t percentages or 
mark-up margins, you will usually identify the VAT and or gross profi t 
percentages/mark-up margins in the case study information as well as on 
the spreadsheets provided.

Using the above formula as an example, we have identifi ed a cell containing 
the VAT percentage of 14% or 0.14. Thus, when including the 14% in your 
formula, use the applicable cell reference (ie B$6). As per the formula, 
we need to use the including VAT amount being 114% or 1.14.

The way of arriving at the 114% or 1.14 as stated above is by adding a 1 
manually in the formula to the 14% VAT – hence 1+B$6.

Note where and how the brackets were used with reference to the 
order of operation used by Microsoft Offi ce Excel.

Step 3:  Write down your answer:

  =(1+B$6)*D9

Step 4:  Will the formula be copied? Yes, the formula will be copied to cells 
E10:E14, which means you are copying DOWN because the column 
did not change – only only the rows. Did you identify any cell references 
where you want to include an absolute reference? YES: B$6, because 
this contains the VAT percentage and will stay fi xed when the 
formula is copied.

You can also use you calculator to recalculate and check your formula, 
but only if you have time to spare.

OTHER CORRECT FORMULA THAT COULD ALSO BE USED

The sales price including VAT = the sales price excluding VAT + VAT.

 •  The sales price excluding VAT = R100 (you have the sales price excluding 
VAT in rand)

 •  The VAT amount calculated on het sales price excluding VAT:

 – For this you will need the VAT % = 14%
 –  = R150 * 14% = R21

 •  R150 + (R150 * 14%) = R171

Let us look at the spreadsheet again. Are there perhaps cells containing 
some of these amounts or percentages used in the calculation above?

Yes there are! Now substitute the amounts and percentages with the cell 
references and let us put the above maths into a formula:

=D9+(D9*B$6)
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(c) Which spreadsheet formula was entered in cell G9 to extract the imported 
(I) or local (L) indicator for LUIDKEELS from the LOB data provided in cell 
A9? Note: Your formula will be copied to cells G10:G14. (2)

Step 1: Identify the formula to be used: RIGHT

Step 2: Formula structure: =RIGHT(cell,num_chars)

Step 3: Write down your answer: =RIGHT(A9,1)

Step 4:  Will the formula be copied? Yes, the formula will be copied to cell 
G10:G14. The column stayed the same – that is, G and the rows changed 
from 10:14, which means you are copying down. Did you identify any 
cell references which should have contained an absolute reference? 
NO – the cell reference, A9, needs to change to A10, A11, etc., as you 
copy the formula down.

Structure The formula Explanation
Begins with = sign =

Function name RIGHT

You need to insert a formula into cell G9, based on the 
information extracted from cell A9. The question wanted 
the formula to return imported (I) or local (L) indicator for 
LUIDKEELS from the LOB data provided in cell A9. You 
therefore need to indicate to Microsoft Offi ce Excel to start 
“counting” from the right.

Opening parenthesis (

cell A9
This argument indicates to Microsoft Offi ce Excel from where 
information will be extracted and, in this instance, it will be 
from cell A9, as stated in the question.

num_chars 1

From the content of cell A9 (ie 172LUIDKEELS150.00L), 
which character(s) do you want to be returned in cell G9? You 
require the imported (I) or local (L) indicator for LUIDKEELS 
from the LOB data provided in cell A9. Now you need to 
physically count the number of characters to let Excel know 
how many characters from cell A9 should be returned in cell 
G9. A character means every time you touch (press a key 
on) the keyboard, which means that a space also counts as 
one character because you have touched the space bar. The 
imported (I) or local (L) indicator, which will be L, is only one 
character from the right.

Closing parenthesis ) Do not forget!
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(d) Which spreadsheet formula was entered in cell I9 to calculate the total cost 
price including VAT for LUIDKEELS? Note: Your formula will be copied 
to cells I10:I14. (3)

Refer back to section 2 in the previous study unit 4 regarding the order of 
operation (2.2), percentages (2.4) and working with VAT % and gross profi t 
% or mark-up (2.5). It is essential that you use your mathematical and 
accounting knowledge and know the order of operations used by Microsoft 
Offi ce Excel in order to answer the above correctly.

GROSS PROFIT

Basic principles:

 •  Gross profi t or mark-up = sales – cost of sales.
 •  Sales = cost of sales + gross profi t or mark-up.
 •  Mark-up margin (%)= mark-up /cost of sales.
 •  Gross profi t margin (%) = gross profi t/sales.

NOTE

As per the information given in the question, the mark-up margin is as follows:

20% on Local (L) CDs and 25% on Imported (I) CDs.

Step 1:  Identify the formula to be used. Since Microsoft Offi ce Excel has no 
specifi c function for performing calculations relating to mark-up to 
calculate the total cost price including VAT, you will need to create a 
formula.

Step 2: Formula structure:

 

The amount you need in rand = the amount you need in % / the amount 
you have in % X the amount you have in rand.

We are working towards what is required, namely to calculate the total cost price 
including VAT using the total sales price including VAT and the mark-up margin.

You can use the above formula or any other formula you are comfortable with 
to help you with these calculations.

By using the required and case study information, we have the following 
information available to calculate the total cost price including VAT for 
LUIDKEELS:
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R % Microsoft 
Offi ce Excel 
underlying 
value

Total cost price (including 
VAT)

? 100 1.00 The amount you need 
in % (1.00)

The amount you need 
in R (R?)

Mark-up 20 0.20

Total sales (including VAT) R29,412 120 1.20 The amount you have 
in % (1.20)

The amount you have 
in R (R29,412)

The amount you need in R = the amount you need in % / the amount you have 
in % X the amount you have in R.

 •  The amount you need in % = 1.00 (you need to calculate the total cost of 
sales including VAT).

 •  The amount you have in % = 1.20 (you have the sales, which includes the 
20% mark-up margin for LUIDKEELS).

 •  The amount you have in R = R29,412 (you have the total sales price 
including VAT in rand)

 •  1.00/1.20 * R29,412 = R24,510.

Let us look at the spreadsheet again. Are there perhaps cells containing some 
of these amounts or percentages used in the calculation above?

Yes there are! Now substitute the amounts and percentages with the cell 
references and let us put the above maths into a formula:

=1/(1+H9)*F9

Using maths rules, this formula can be simplifi ed to: R29,412/1.20 = R24,510

=F9/(1+H9)

Note where and how the brackets were used with reference to the 
order of operation used by Microsoft Offi ce Excel.

Step 3: Write down your fi nal answer:

  =F9/(1+H9)
  =1/(1+H9)*F9 is also correct

Step 4:  Will the formula be copied? Yes, the formula will be copied to cell I10:I14. 
The column stayed the same – the rows changed from 10:14, which 
means you are copying down. Did you identify any cell references which 
should contain an absolute reference? NO – the cell reference, F9 and 
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H9, needs to change to F10 and H10, F11 and H11, etc, as you copy 
the formula down.

You can also use your calculator to recalculate and check your formula, 
but only if you have time to spare.

(e) Which spreadsheet formula was entered in cell J17 to determine the 
highest total profi t including VAT, of all products?  (2)

Step 1: Identify the formula to be used: MAX

Step 2: Formula structure: =MAX(cell1:cell2)

Step 3: Write down your answer: =MAX(J9:J14)

Step 4:  Will the formula be copied? No – therefore no absolute references need 
to be included in the formula.

Structure The formula Explanation

Begins with = sign =

Opening 
parenthesis (

Function name MAX Determines the largest value in a specifi ed range of cells.

(cell1:cell2) J9:J14
The range of cells on which the specifi c function/formula 
is applied to. In this instance, the function determines the 
largest value in the specifi c range of cells.

Closing parenthesis ) Do not forget!

(f) Which spreadsheet formula was entered in cell J18 to determine the lowest 
total profi t including VAT of all products?  (2)

Step 1: Identify the formula to be used: MIN

Step 2: Formula structure: =MIN(cell1:cell2)

Step 3: Write down your answer: =MIN(J9:J14)

Step 4:  Will the formula be copied? No – therefore no absolute references need 
to be included in the formula.

Structure The formula Explanation

Begins with = sign =

Opening parenthesis (

Function name MIN Determines the smallest value in a specifi ed range of cells.

(cell1:cell2) J9:J14
This is the range of cells to which the specifi c function/
formula is applied. In this instance, the function determines 
the smallest value in a specifi ed range of cells.

Closing parenthesis ) Do not forget!

[15]
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QUESTION 3 (step-by-step illustrated solution)

Note:  Where it is indicated that your formula will be copied to other 
cells, your formula must take absolute and relative addresses into 
account, but only where necessary!

(a) Which spreadsheet formula was entered in cell B8 to include a 19 at 
the beginning of the two-digit birth year in cell B7, thereby changing the 
birth year for Bipin from a two-digit year in cell B7 to a four-digit year? 
Note: your formula will be copied to cells C8:F8. (2)

Step 1: Identify formula to be used: &

Step 2:  Formula structure. Using “&” will refl ect the contents of the cells/value/
text combined beside each other.

Step 3: Write down your answer: =19&B7

Step 4:  Will the formula be copied? Yes the formula will be copied to cell C8:F8. 
The row stayed the same, that is, 8, and the columns changed from C:F 
which means you are copying to the RIGHT. Did you identify any cell 
references which should contain an absolute reference? NO – the cell 
reference, B7, needs to change to C7, D7, etc, as you copy the formula 
to the right.

Structure The formula Explanation

Begins with = sign =

Formula 19&B7 Using “&” will refl ect the contents of the cells/value/
text combined beside each other.

IN ADDITION TO WHAT WAS REQUIRED IN THE ORIGINAL QUESTIONS

Let us pretend that the question wanted cell B8 to be displayed as “Bipin-1991”. You should 
be able to copy the formula to cell range C8:F8. How would the formula change?

Step 1: Identify the formula to be used: &

Step 2:  Formula structure: Using “&” will refl ect the contents of the cells/value/text combined beside 
each other.

Step 3: Write down your answer: =B5&“-”&19&B7

Step 4:  Will the formula be copied? Yes the formula will be copied to cell C8:F8. The row stayed the 
same, that is, 8, and the columns changed from C:F which means you are copying to the 
RIGHT. Did you identify any cell references which should contain an absolute reference? 
No– the cell reference, B7, needs to change to C7, D7, etc, as you copy the formula to the 
right.

Structure The formula Explanation

Begins with = sign =

Formula B5&“-”&19&B7 Using “&” will refl ect the contents of the cells/value/
text combined beside each other.
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(b) Which spreadsheet formula was entered in cell B11 to calculate Bipin’s monthly 
savings amount, based on the suggestions made by the investment company? 
The monthly savings amount must be a negative amount because it is an 
outfl ow of cash from the staff member to the investment company. Refer 
back to the given information Note: Your formula will be copied to cells 
C11:F11. (5)

Step 1:  Identify the formula to be used. IF. How did we know this? Refer back 
to the case study information: “The investment company suggested that 
staff members who are 50 years and older should save 10% of their 
monthly available income and that staff members younger than 50 years 
should save 5% of their monthly available income.” Remember that the 
IF function is used when one needs to decide between two alternatives 
depending on a specifi c condition. In this instance, the case study 
information gave two alternatives, namely that staff members who are 50 
years and older should save 10% of their monthly available income OR 
staff members younger than 50 years should save 5% of their monthly 
available income. This is the clue that the IF function should be used.

Step 2: Formula structure: = IF(Logical_test,value_if_true,value_if_false)

Step 3:  Write down your answer. As you can see below there is more than one 
correct answer. We will discuss this in detail in the table below. The 
logical test determines which outcome would be the true statement and 
which outcome would be the false statement.

OPTION 1:  =-IF(B9<50,B10*0.05,B10*0.1) or 
=-IF(B9<50,B10*5%,B10*10%)

OPTION 2:  =-IF(B9>=50,B10*0.1,B10*0.05) or 
=-IF(B9>=50,B10*10%,B10*5%)

Note the negative sign at the beginning of the formula. This is what 
was required in the question: “The monthly savings amount must be a 
negative amount because it is an outfl ow of cash from the staff member to 
the investment company.”

Step 4:  Will the formula be copied? Yes, the formula will be copied to cells 
C11:F11, which means you are copying to the RIGHT because the row did 
not change, only the columns. Did you identify any cell references where 
you wanted to include an absolute reference? NO – the cell reference, 
B11, needs to change to C11, D11, etc, as you copy the formula to the 
right.
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OPTION 1

Structure The formula Explanation
Begins with = sign =

Function name -IF

The case study provides two alternatives. The IF function is 
used in the case where one needs to decide between two 
alternatives depending on a specifi c condition. See step 1 
above.

As per what was required, the monthly savings amount must 
be a negative amount because it is an outfl ow of cash from 
the staff member to the investment company – hence the 
negative sign at the beginning of the formula.

Opening 
parenthesis (

logical_test B9<50 You need to determine whether the staff member’s age 
calculated in cell B9 is below 50 years.

value_if_the logical 
test is true

B10*0.05 or 
B10*5%

You want to calculate the monthly savings as 5% of the 
monthly available income as indicated in cell B10 for all staff 
members younger than the age of 50.

Note that both ways of expressing 5% would have been 
accepted as the correct answer. However, 5/100 is incorrect.

value_if_the logical 
test is false

B10*0.1 or 
B10*10%

You want to calculate the monthly savings as 10% of the 
monthly available income as indicated in cell B10 for all staff 
members who are not younger than the age of 50.

Note that both ways of expressing 10% would have been 
accepted as the correct answer. However, 10/100 is incorrect.

Closing parenthesis )

OPTION 2

Structure The formula Explanation
Begins with = sign =

Function name -IF

The case study provides two alternatives. The IF function 
is used in the instance where one needs to decide between 
two alternatives depending on a specifi c condition. See step 
1 above.

As per what was required, the monthly savings amount must 
be a negative amount because it is an outfl ow of cash from 
the staff member to the investment company – hence the 
negative sign at the beginning of the formula.

Opening 
parenthesis (

logical_test B9>=50 You want to determine whether the staff member’s age as 
calculated in cell B9 is 50 years and older.

value_if_the logical 
test is true

B10*0.1 or 
B10*10%

You want to calculate the monthly savings as 10% of the 
monthly available income as indicated in cell B10 for all staff 
members at the age of 50 years and older.

Note that both ways of expressing 10% would have been 
accepted as the correct answer. However, 10/100 is incorrect.
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value_if_the logical 
test is false

B10*0.05 or 
B10*5%

You want to calculate the monthly savings as 5% of the 
monthly available income for all staff members who are not 
at the age of 50 years and older.

Closing parenthesis )

OTHER CORRECT FORMULAS THAT COULD ALSO BE USED

OPTION 1

=IF(B9<50,B10*-0.05,B10*-0.1) or =IF(B9<50,B10*-5%,B10*-10%)

Or

=IF(B9<50,-B10*0.05,-B10*0.1) or =IF(B9<50,-B10*5%,-B10*10%)

OPTION 2

=IF(B9>=50,B10*-0.1,B10*-0.05) or =IF(B9>=50,B10*-10%,B10*-5%)

Or

=IF(B9>=50,-B10*0.1,-B10*0.05) or =IF(B9>=50,-B10*10%,-B10*5%)

Changing the sign of an amount/negative amounts

Note where you can place the minus sign to create a negative amount 
when using a formula. Any one of the amounts, cell references or 
percentages can be changed to a negative to provide a negative answer.

To change the sign of an amount from a positive to a negative or from a 
negative to a positive, the amount can be multiplied by -1: for example 
+50 * -1 = -50 and -100 * -1 = +100.

(c) Which spreadsheet formula was entered in cell B12 to calculate the 
investment term in years for Bipin? Refer back to the given information 
Note: Your formula will be copied to cells C12:F12. (2)

Step 1:   Identify the formula to be used: We will need to create a formula to 
calculate the investment term in years.

Step 2: Formula structure:

Let us go through the process of arriving at the formula:

Read the information carefully – the clue is right there.

“Joseph wants to show his co-workers what the possible amount is what they 
might receive at retirement if they start saving and investing now.”

and

“Normal retirement age is 65 years.”

As per the information provided in the case study, the normal retirement age is 
65. The question requires the calculation of the investment term in years if Bipin 
starts saving and investing now up to his retirement.
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Formula

=the investment term in years for Bipin
=retirement age – current age
=65–19

Let us have a look at the spreadsheet again. Are there perhaps cells containing 
some of these numbers used in the calculation above?

Yes there are! Now substitute the numbers with the cell references.

=$B2-B9

Step 3: Write down your fi nal answer: =$B2-B9

Step 4:  Will the formula be copied? Yes, the formula will be copied to cells 
C12:F12, which means you are copying to the RIGHT because the row 
did not change, only the columns. Did you identify any cell references 
where you want to include an absolute reference? YES. $B2 because 
this contains the retirement age and will stay fi xed when the formula 
is copied.

 B$2 is incorrect.

(d) Which spreadsheet formula was entered in cell B13 to calculate the expected 
value of Bipin’s total savings at the end of his investment term? Note: Your 
formula will be copied to cells C13:F13. (4)

Step 1:  Identify the formula to be used: FV. Why? Refer back to the question 
and what was required: “Which spreadsheet formula was entered in cell 
B13 to calculate the expected value of Bipin’s total savings at the end 
of his investment term?

  FV returns the future value of an investment based on constant payments 
and a constant interest rate.

Step 2: Formula structure: =FV(rate,nper,pmt,pv,type)

Step 3: Write down your answer: =FV($B3/12,B12*12,B11,0,0)

Step 4:  Will the formula be copied? Yes, the formula will be copied to cells 
C13:F13, which means you are copying to the RIGHT because the row 
did not change; only the columns. Did you identify any cell references 
where you want to include an absolute reference? YES, $B3, because 
this contains the investment return rate and will stay fi xed when 
the formula is copied.

=FV($B3/12,B12*12,B11,0,0)
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Structure The formula Explanation

Begins with = sign =

Function name FV The question requires you “to calculate the expected value 
of Bipin’s total savings at the end of his investment term”.

Opening 
parenthesis (

rate $B3/12
The interest rate is an annual (yearly) rate and needs to be 
divided by 12 to change it to a monthly rate because the 
savings payments are made monthly.

nper B12*12 The period is a term in years and should be multiplied by 12 
to change it to a period in months because you save monthly.

pmt B11
The payment amount you want to save each month. Note that 
the amount is negative (ie –R100) because it is an outfl ow 
of cash to an investment.

pv 0
The present value of your investment. Because you have 
not yet saved anything, the current value (present value) of 
your investment is 0.

type 0 You save at the end of each month.

Closing parenthesis )

IN ADDITION TO WHAT WAS REQUIRED IN THE ORIGINAL QUESTIONS

(e) SupaDebt, a short-term fi nance house also approached your branch. 
This fi rm is currently offering all employees loans at an interest rate of 
7% per annum over a fi ve-year fi nance term. Assume that all employees 
would rather use their monthly saving amounts, as calculated in 3.b. 
above, to obtain a loan from Supadebt. The instalments are payable 
quarterly, at the beginning of each period.

Which spreadsheet formula was entered in cell B14 to calculate the expected 
value of fi nancing that Bipin can obtain from SupaDebt? Note: Your formula 
will be copied to cells C14:F14. (4)

Step 1:  Identify the formula to be used. PV. Why? Refer back to the question: 
“Which spreadsheet formula was entered in cell B14 to calculate the 
expected value of fi nancing that Bipin can obtain from SupaDebt?” 
PV returns the present value of an investment/series of payments, 
that is, the total amount a series of total payments is worth today at 
a constant interest rate and over a constant period.

Step 2: Formula structure: =PV(rate,nper,pmt,fv,type)

Step 3: Write down your answer:

  =PV(0.07/4,5*4,B11*3,0,1) or =PV(7%/4,5*4,B11*3,0,1)

   The required and additional case study information states that the 
instalments are payable quarterly, at the beginning of each period.
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Step 4:  Will the formula be copied? Yes. The formula will be copied to cells 
C14:F14, which means you are copying to the RIGHT because the 
row did not change; only the columns. Did you identify any cell 
references where you want to include an absolute reference? NO. 
The cell reference, B14, needs to change to C14, D14, etc, as you 
copy the formula to the right.

  =PV(0.07/4,5*4,B11*3,0,1) or =PV(7%/4,5*4,B11*3,0,1)

Structure The formula Explanation

Begins with = sign =

Function name PV The question requires you “to calculate the expected 
value of fi nancing that Bipin can obtain from SupaDebt”.

Opening 
parenthesis (

rate 0.07/4 or 7%/4

The interest rate is expressed as an annual rate of 7% in 
the required part of the question. This annual rate needs 
to be changed to a quarterly rate, namely the same 
period as the instalment period. Remember, you need 
to compare apples with apples. Because there are four 
(4) quarters in a year, the annual rate needs to be divided 
by 4 to change the annual rate to a quarterly rate.

nper 5*4

The fi nance term is fi ve (5) years per what was required 
in the question. Nper is the total number of payments 
that will be made for the whole of the fi nance term. Since 
there are four (4) quarters in a year, the fi nance term of 
fi ve (5) years needs to be multiplied by 4 to calculate to 
the total number of payments to be made for the fi ve-
year fi nance term.

pmt B11*3

The instalments (payments) are payable quarterly. As 
per the case study information, the total monthly savings 
amount is, as the name indicates, MONTHLY. We need to 
calculate the payment amount per quarter, not per month 
because the payments are payable quarterly. There are 
four (4) quarters in a year, and a quarter comprises three 
(3) months each. Thus the quarterly payments need to be 
calculated by multiplying the monthly payment (monthly 
savings amount) by 3 to calculate the quarterly payment 
amount. Note that the amount is negative because it is 
an outfl ow of cash to an investment.

fv 0
The future value of the loan. Since the loan will be fully 
paid by the end of the period, the future value of the 
loan is R0.

type 1 The instalment is payable at the beginning of each 
period (payable in advance).

Closing parenthesis )

[17]
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11Spreadsheet security, risks and controls

96In this study unit

12

1 Introduction
In the previous study unit we showed you what a powerful tool Microsoft Offi ce Excel can 
be when it is used to perform calculations, present reports and charts and analyse data.

Spreadsheets have become an essential tool for numerous entities, many of whom cannot 
function without the use of spreadsheets. This is why spreadsheet security and control 
have become so important to ensure that spreadsheets, which organisations rely on, are 
not compromised, leading to incorrect calculations, reports, charts and data analysis, 
which in turn could lead to incorrect management decisions.

In this study unit we will focus specifi cally on spreadsheet security, risks and controls.

2 Spreadsheet risks
Many things can go wrong with spreadsheets. Unauthorised modifi cations or data input 
may occur, resulting in incorrect output, be it intentional or unintentional. There is also the 
possibility of errors contained in the formulas and functions used to perform calculations 
in spreadsheets.
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Thus to assess the risk potential for certain spreadsheets, the following factors have to 
be considered:

 •  Complexity. Spreadsheets containing complex calculations and functions, including 
the use of macros with multiple sources of input, present a greater potential risk owing 
to the complex calculations.

 •  Frequency of use and updating. Spreadsheets that are frequently used or updated 
pose a greater potential risk owing to the potential for incorrect input or updating of 
information or modifi cation of calculations.

 •  Number of users using a spreadsheet. Spreadsheets that are used by more users 
have a greater potential risk, especially if these users can enter data or change formulas 
and functions.

 •  Time in use. This relates to spreadsheets that are used for a long time (a year or 
longer). The potential risk increases because the initial data entered may be incorrect, 
potentially leading to subsequent data being negatively affected in future months.

Hence unauthorised modifi cations or data entry, or spreadsheets containing errors either 
because of incorrect data being entered or incorrect formulas or functions being used in 
calculations will lead to errors, with management making incorrect decisions.

Owing to the structural design of spreadsheets, a minor change in a formula or value or 
in any of their input cells may affect their overall output, where manual errors may also 
go undetected.

Because the user only sees the results on the face of the spreadsheet or printed report, 
these errors could easily go unnoticed.

Typical errors include

 •  accidental copy-paste
 •  omission of a negative sign
 •  erroneous range selection
 •  incorrect data input
 •  unintentional deletion of a character, cell, range, column or row
 •  sorting of only a portion of the data range

Another common error is the possibility of the user working on the wrong spreadsheet 
version.

The potential consequences of one or more of the above errors occurring or security 
being breached with unauthorised modifi cations to spreadsheets could result in

 •  fi nancial loss or bankruptcy of an organisation
 •  incorrect costing or budgeting
 •  public embarrassment, adverse news coverage or loss of reputation
 •  loss of investor confi dence
 •  loss of share value
 •  loss of fi nancial control
 •  career damage
 •  lawsuits

3 Spreadsheet controls
With the potential risks of a breach in security or the occurrence of an error in spreadsheets, 
management will need to implement controls to minimise the risks identifi ed.
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There are various ways of controlling spreadsheets. One is to make regular back-ups of 
spreadsheets and to audit working versions of spreadsheets from time to time to check 
any changes made to ensure that the spreadsheet still works as it was intended to.

Spreadsheet use also poses inherent risks. These risks can be lessened by reducing the 
number of spreadsheets in use. The use of tested and audited templates for frequently 
recreated spreadsheets can also decrease risks.

The following controls (including security controls) may be implemented for spreadsheets:

 •  Change control. Spreadsheet changes including changes in formulas and functions 
need written approval, review and acceptance in order to maintain data integrity.

 •  Access control. General IT controls should protect spreadsheets from unauthorised 
outside access.
 – Low-risk spreadsheets residing on a user’s computer system require password 

protection.
 – High-risk spreadsheets need to be stored on a server that has a secure fi le 

directory. Access rights to these folders need to be restricted to the authorised users.

 •  General security controls. General security controls relating to fi le access controls 
that may be implemented are as follows:
 – a password required for opening or reading workbooks
 – a password required to make changes to the workbook structure
 – a password required for changing the content in a sheet or cell

A password may encrypt the specifi c workbook, the structure or the cells in a 
spreadsheet. Note, however, that commercial hackers may use various programs 
available on the internet to obtain the password for a fi le – hence password protection 
alone may not be suffi cient.

The following steps should also be followed and communicated to the users of 
spreadsheets that are password protected to ensure that their passwords stay safe 
and that this is regarded as good practice for password protection:
 – Do not share the password with anyone.
 – Do not write the password down and place it where people can fi nd it.
 – Do not use an obvious password (eg birthdays or names) that someone could 

easily guess.
 – Use a combination of letters and numbers.
 – Include uppercase and lowercase letters, numbers and symbols in the password.
 – Use numbers to represent letters, for instance, 3 for your E and 1 for i.
 – Passwords should be eight or more characters in length.
 – Change passwords regularly if needed.

 •  Input control. Spreadsheet input data needs to be verifi ed to the original source data 
for accuracy. Another person also needs to trace inputs back to original source data.

 •  Logical inspection. An independent person other than the spreadsheet user should test 
the formulas and functions for correctness. Only one logical inspection per spreadsheet 
is required if the other controls are working effectively.

Another facet of logical inspection is the inclusion of fi xed values in formulas. A formula 
should never contain a fi xed (“hard-coded”) value. Even “permanently” fi xed components 
(eg tax rate) can change in the context of business operations. To prevent these types of 
mistakes you could separate the input components from the formulas by having a data input 
section in which you can easily identify the various inputs and assumptions on the face 
of the spreadsheet and update these without the need to change the detailed formulas/
functions. The use of control balances may also prove helpful to ensure the soundness 
of formulas or input on spreadsheets.

In so doing, the use of formulas and functions becomes much more fl exible, with a decrease 
in potential errors caused by the inclusion of an incorrect fi xed value.
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(a) Display formulas

You may be auditing formulas and you need to see all the formulas on the worksheet. You 
can use the following procedures to control the hiding or displaying of formulas:

There are two ways to switch between displaying formulas and their values on a 
worksheet:

 •  Using an icon/command:
 –  Click on the Formulas tab on the Ribbon.      
 –  In the Formula Auditing group, click on the Show Formulas icon.

or

 •  Using the keyboard:
 –  Press CTRL and ‘ (the grave accent) simultaneously.

4 Microsoft Offi ce Excel security controls
Microsoft Offi ce Excel provides various levels of security and protection, allowing you to 
control who can access and change the fi le’s data. To protect a workbook containing data 
you can do the following:

 •  Optimal security. Protect your entire workbook fi le with a password allowing only 
authorised users to view or modify the data.

 •  Additional protection of specifi c data. Protect certain worksheet or workbook 
elements, with or without a password. This will help to prevent users from accidentally 
or intentionally changing, moving or deleting data, formulas or functions.

We will now demonstrate how to do both.

4.1 Using passwords to help secure an entire workbook
You can secure an entire workbook

 •  by restricting who can open and use the workbook data
 •  by requiring a password to view or to save changes to the workbook

Password security will help protect your workbook from unauthorised access. You can set 
a password when you save the workbook. You can specify two separate passwords that 
users must use to do the following:

 •  Open and view the workbook. This password is encrypted to help protect the data 
from unauthorised access.

 •  Modify the workbook. This password is not encrypted and is only meant to give 
specifi c users permission to edit workbook data and to save changes to the fi le.

These passwords apply to the entire workbook. For optimal password security, always 
assign a password to open and view the fi le. To give only certain users permission to 
modify data, you may want to assign both passwords.

Before you start the next practical section, start/open the Microsoft Offi ce Excel Program.
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(a) To encrypt your workbook and set a password to open it

        

The use of Microsoft Offi ce Excel 2007 and 2010 is discussed separately in 
activity 6.1

Microsoft Offi ce Excel 2007:

 •  In an open spreadsheet, click the Microsoft Offi ce Button , point to 
Prepare, and then click Encrypt Document.

 •  In the Encrypt Document dialog box, in the Password box, type a password 
and then click OK. (Remember the rules for choosing an effective password.)

Type your 
password here
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 •  In the Confi rm Password dialog box, in the Reenter password box, type 
the password again, and then click OK.

Re-enter your 
password here

 •  To save the password, save the fi le.

          

Microsoft Offi ce Excel 2010:

 •  In an open spreadsheet, click the File tab.
 •  Click on Info.
 •  This will open the Info menu options.
 •  In Permissions, click on the arrow under Protect Workbook. The following 

options appear:

 •  When you select Encrypt with Password, the Encrypt Document dialog 
box appears.
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 •  In the Encrypt Document dialog box, in the Password text box, type a password 
and then click OK. (Remember the rules for choosing an effective password)

Type in your 
password here

 •  In the Confi rm Password dialog box, in the Reenter password box, type 
the password again, and then click OK.

Re-enter your 
password here

 •  To save the password, save the fi le.

4.2 Protecting specifi c worksheet or workbook elements
When you share a workbook with other users in order to work together on the data, you 
may want to protect data in specifi c worksheets or workbook elements to prevent it from 
being changed by other users. Passwords may be used to enable users to enter so that 
they can modify specifi c workbook and worksheet elements that are protected.

The difference between a workbook and a worksheet can be explained as follows:
 •  A workbook is the actual Microsoft Offi ce Excel fi le that stores all the entered data and 

information. Workbooks contain worksheets.
 •  A worksheet, also known as a spreadsheet, is the combination of cells that contain 

data, which the user can enter and manipulate.

NOTE

Workbook and worksheet element protection is not workbook-level password security. 
Element protection cannot protect a workbook from users with malicious intent.
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(a) Protecting worksheet elements

When you protect a worksheet, all cells on the worksheet are locked by default, and users 
cannot make any changes to a locked cell. For example, they cannot insert, modify, delete 
or format data in a locked cell. However, you can specify which elements users will be 
allowed to change when you protect the worksheet.

To protect worksheet elements

         

To protect a worksheet:

 •  Select the worksheet you want to protect.
 •  On the Review tab, in the Changes group, click Protect Sheet.

As noted above, all cells on the worksheet are locked by default.

 •  In the Password to unprotect sheet box, type a password for the sheet, 
click OK and then retype the password to confi rm it.

To unlock cell in a protected worksheet:

 •  To unlock any cells or ranges that you want other users to be able to change, 
do the following:

 –  Select each cell or range that you want to unlock.
 –  On the Home tab, in the Cells group, click on the drop down arrow right  

of the Format button and then select Format Cells.

 –  On the Protection tab, clear the Locked check box and then click OK.

To hide formulas in a protected worksheet:

 •  To hide any formulas that you do not want to be visible, do the following:

 –  In the worksheet, select the cells that contain the formulas you want to 
hide.

 –  On the Home tab, in the Cells group, click Format and then click 
Format Cells.

 –  On the Protection tab, select the Hidden check box and then click OK.
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 •  To unlock any graphic objects (such as pictures, clip art, shapes or Smart 
Art graphics) that you want users to be able to change, do the following:

 –  Hold down CTRL and then click each graphic object you want to unlock.

This displays the Picture Tools or Drawing Tools, adding the Format tab.

 –  On the Format tab, in the Size group, click the Dialog Box Launcher 
next to Size.

 –  On the Properties tab, clear the Locked check box, and if present, clear 
the Lock text check box.

To allow users to change selected elements in a protected worksheet:

 •  On the Review tab, in the Changes group, click Protect Sheet.

 •  In the Allow all users of this worksheet to list, select the elements you 
want users to be able to change.

 •  In the Password to unprotect sheet box, type a password for the sheet, 
click OK and then retype the password to confi rm it.

NOTE

The password is optional. If you do not supply a password, any user can unprotect the 
sheet and change the protected elements. Make sure that you choose a password that 
is easy to remember, because if you lose the password, you cannot gain access to the 
protected elements on the worksheet.

To protect workbook elements

        

 •  On the Review tab, in the Changes group, click Protect Workbook.

 •  Under Protect workbook for, do one or more of the following:

 –  To protect the structure of a workbook, select the Structure check box.
 –  To keep workbook windows in the same size and position every time the 

workbook is opened, select the Windows check box.
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 •  To prevent other users from removing workbook protection, in the Password 
(optional) box, type a password, click OK, and then retype the password 
to confi rm it.

NOTE

The password is optional. If you do not supply a password, then any user can unprotect 
the workbook and change the protected elements. Make sure you choose a password 
that you can remember, because if you lose it, you cannot gain access to the protected 
elements in the workbook.

To remove protection from a worksheet

        

 •  On the Review tab, in the Changes group, click Unprotect Sheet.

Note that the Protect Sheet option changes to Unprotect Sheet when a 
worksheet is protected.

 •  If prompted, type the password to unprotect the worksheet.

4.3 Protecting confi dential data in a workbook
Hiding, locking and protecting workbook and worksheet elements are not intended to 
secure or protect any confi dential information you keep in a workbook. This will only help 
obscure data or formulas that might confuse other users and prevent them from viewing 
or making changes to that data.

Excel does not encrypt data that is hidden or locked in a workbook. To help keep confi dential 
data confi dential, you may want to limit access to workbooks containing such information 
by storing them in a location that is available only to authorised users.

5 Summary
In this study unit we discussed and described spreadsheet risks and controls. We specifi cally 
discussed factors to consider when assessing the potential risk of spreadsheets, including 
the consequences of errors contained in spreadsheets. We looked at controls that can be 
implemented to minimise the risks identifi ed. Lastly, we focused on certain security and 
privacy controls that are included in Microsoft Offi ce Excel that you can use to protect 
your data, formulas and functions.

The next part will deal with various aspects of transaction processing.
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          

After working through this study unit, you should be able to answer the following:

(a) Jane is an accountant at a multinational organisation. She is responsible 
for all the monthly salary calculations. The fi nancial manager, John, to 
whom Jane directly reports, has previously emphasised the importance 
of keeping the company’s salary information confi dential. He insisted that 
Jane password protect the salary spreadsheets, of which only he and Jane 
know the passwords.

For every month’s salary calculation spreadsheet that Jane uses, she 
scribbles the passwords on a piece of paper and then sticks it on the front 
of her wall calendar at the applicable month. She uses the name of her pet 
parrot, Polly, together with the applicable month as the password for the 
monthly salary spreadsheets.

(i) Advise Jane on what good password practice is and what she should 
refrain from doing with reference to the case study above.

(ii) Advise Jane on whether she should usea password that is encrypted 
or not encrypted. Briefl y explain why.

(b) List and explain the factors to consider when assessing the potential risks 
of a spreadsheet.

         

Regarding question a.ii., Jane should use a password that is encrypted to protect 
the salary spreadsheets because the information contained is confi dential and 
of a sensitive nature. By using an encrypted password, the entire workbook will 
be secured by restricting who can open and view the workbook data.

Using a password that is not encrypted will not be adequate because users can 
still open and view the confi dential salary information. Using a password that 
is not encrypted will only prevent the unauthorised user from editing workbook 
data and saving changes to the fi le.
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KEY TERM LIST

KEY TERM / CONCEPT DEFINITION / EXPLANATION

ACCOUNTING INFORMATION 
SYSTEM (AIS)

An AIS collects an organisation’s day-to-day fi nancial and 
nonfi nancial transactions, processes them into valuable 
fi nancial information and stores and retrieves the data and 
fi nancial information

AIS AUDIT TRAIL An AIS audit trail tracks user activity on the AIS by recording 
the user name and access date and time as well as the actions 
performed by that user

APPLICATION 
PROGRAMMERS 

Application programmers are responsible for creating, 
maintaining, updating and managing the application and DBMS 
software which the end-users use to interact with the physical 
database

ATTRIBUTE An attribute, commonly known as a column, represents one 
unique characteristic of a single database table.

BATCH INPUT Batch input involves similar source documents being grouped 
together (batch) and then entered in the CIS periodically, say, 
daily, weekly or monthly.  

BATCH OUTPUT Batch output occurs when all requests for information (ie reports, 
queries, etc) are batched together and periodically extracted 
from the CIS. 

BATCH PROCESSING Batch processing occurs when transaction fi les (containing the 
captured data) are updated to the master fi les periodically, that 
is, daily, weekly or monthly. 

BILL OF MATERIALS (BOM) The bill of materials (BOM) specifi es, for each fi nished goods 
inventory item, the type and quantities of raw materials needed 
in the manufacturing.

BUSINESS INTELLIGENCE 
SOFTWARE (BIS)

Business intelligence software (BIS) is special software that 
combines information obtained from a data warehouse (cube 
structure), from all functional areas in the organisation and 
external sources to a lesser extent to generate reports required 
by top management. 

BIS DASHBOARD BIS can provide a “dashboard”, which gives access to all the 
required reports. The dashboard can be located on the computer’s 
desktop to give management access to the information with the 
click of a button. 

CENTRALISED DATABASE When using a centralised database, the database is physically 
stored in one central location (ie it is on one server). 

CHART OF ACCOUNTS (COA) A CoA is a list of accounts used in the organisation’s general 
ledger.

CLASSIFYING DATA Data is arranged into different groups (categories) using some 
of the data’s specifi c characteristics
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COMPUTER-AIDED 
MANUFACTURING (CAM)

CAM controls and coordinates all the machines used in the 
manufacturing process such as conveyor systems, cutting or 
welding machines and so forth

COMPUTER-INTEGRATED 
MANUFACTURING (CIM)

CIM is the automation and integration of the complete 
manufacturing process by using computers to control and/
or execute the process from product design right through 
manufacturing, to quality control, storage of raw materials, WIP 
and fi nished goods, and ultimately, the shipment of the fi nished 
products.

CONCEPTUAL LEVEL The conceptual level is a complete view of the entire database, 
that is, a view of all the data from which the user views can be 
derived.

DATA ADMINISTRATOR The data administrator, also called a database analyst, is 
responsible for managing and controlling the data in the 
organisation’s databases. 

DATA CONTROL LANGUAGE 
(DCL)

DCL controls the security and user access to the database objects 
and data in the database.

DATA DEFINITION LANGUAGE 
(DDL)

DDL is used to defi ne a database and includes commands to (1) 
create, modify and delete the database and database objects, (2) 
defi ne and describe the data structure of the database according 
to the database model used, and (3) create the data dictionary.

DATA DICTIONARY The data dictionary contains a record for each data fi eld in the 
database and this record gives a detailed description of that 
data fi eld. 

DATA FIELD A data fi eld contains a single data value and is the smallest unit 
of data that can be accessed in a database.

DATA MANIPULATION 
LANGUAGE (DML)

DML is used in the routine operation of the database to insert, 
delete, modify and maintain the data stored in the database.

DATA MART A data mart is a smaller data warehouse extracted from the main 
data warehouse and contains specifi c related data extracted 
for a specifi c organisational user group such as the fi nance 
department or the marketing department.

DATA MINING Data mining software is used to analyse data sets in order to 
uncover previously unknown trends, patterns and relationships 
between data.

DATA MODEL Databases can be classifi ed according to the theoretical data 
structure, referred to as a data model, on which it is based. 

DATA QUERY LANGUAGE Data query language is used to retrieve data from the database.

DATA RECORD A data record is a set of logically related data fi elds about a single 
member or item.

DATA VALUE A data value is a character (a single number, letter or special 
character) or a group of related characters used to populate the 
data fi eld. 

DATA WAREHOUSE A data warehouse is a database populated with current and 
historical data extracted from the organisation’s various databases.
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DATABASE A database can be defi ned as an organised collection of related 
data that is managed and stored electronically and can provide 
data to different application software in the organisation.

DATABASE ADMINISTRATOR The database administrator is responsible for managing and 
controlling the organisation’s databases.

DATABASE ENVIRONMENT The database environment consists of three components, 
namely the users of the database, database management 
systems (DBMS) and the physical database, which includes both 
the hardware it runs on and the data in the physical database.

DATABASE FILE A database fi le, also known as a database table, is an organised 
collection of related data records.

DATABASE LANGUAGES The database users (end-users, application programmers and 
database administrator) use different database languages to 
interact with the database.

DATABASE MANAGEMENT 
SYSTEMS (DBMS)

A DBMS is an integrated set of software programs that provides 
a user-friendly interface to the users for all data interactions 
between the user and the physical database – in other words, 
it enables the users to operate and interact with the database. 

DISTRIBUTED DATABASE When using a distributed database, there are several interlinked 
databases stored in several computers in the same (eg 
headquarters) or different locations (eg branches).

DUPLICATION OF A 
DATABASE

In duplication, the master (original) database is copied to the 
other locations, normally at a specifi c frequency and time, and 
will overwrite the data at the distributed locations.

END-USERS End-users capture data in the database and extract information 
from the database using database management system software.

EXTENSIBLE BUSINESS 
REPORTING LANGUAGE 
(XBRL)

XBRL is used when fi nancial information is exchanged in 
XML format and can be broadly be defi ned as the electronic 
communication of fi nancial and business information to all 
stakeholders.  

EXTERNAL LEVEL The external level, also called the user view, is the individual 
end-user’s view of the data and the database. 

FIELD NAME All attributes have a unique name known as a fi eld name, which 
labels the data stored in the attribute.

FINANCIAL TRANSACTION A fi nancial transaction is a business activity that generates or 
modifi es fi nancial data and can usually be expressed in monetary 
terms.

FLAT FILE ENVIRONMENT In a fl at fi le environment fi les are not related to one another and 
the users of data and information each keep their own data and 
information.

FOREIGN KEY When a primary data fi eld of a database fi le is entered into 
another database fi le to create a relation between the two 
database fi les, the primary data fi eld in the other database fi le 
is known as a foreign key.
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HIERARCHICAL MODEL This model was used in early databases and, as the name 
indicates, the data is structured in a hierarchical (upside down 
tree-like) structure. 

HISTORY FILE A history fi le contains data records about transactions completed 
in the past.

HUMAN RESOURCE 
MANAGEMENT (HRM) 
SYSTEMS

Personnel information systems, referred to as Human resource 
management (HRM) systems, is a specialised information 
system used for the management of personnel and the recording 
of their activities. 

INFORMATION Is obtained by processing raw data ie processed data.

INTERACTIVE OUTPUT Interactive output occurs when users are directly connected to the 
CIS and can request certain information and receive it immediately

INTERNAL LEVEL The internal level, also called the physical view, is the low-level 
view of how the data is physically stored on a storage device 
such as a magnetic hard drive disk.

MANAGEMENT INFORMATION 
SYSTEMS (MIS)

MIS can provide both fi nancial and nonfi nancial information 
to users, according to their needs, by extracting information 
from the appropriate TPS, including the accounting information 
system (AIS).

MANUFACTURING RESOURCE 
PLANNING (MRP II)   

Manufacturing resource planning (MRP II) software is an 
extension of MRP software and is used for short- and long-term 
planning and control of the manufacturing process. It integrates 
all the aspects (people, materials, machines, money, etc) of the 
manufacturing process. 

MASTER FILE A master fi le contains data records of a relative permanent 
nature (ie they do not change regularly) about the organisation’s 
resources and subjects (ie customers, suppliers, inventory, 
employees, etc). 

MASTER PRODUCTION 
SCHEDULE

A master production schedule is a detailed plan of which product 
must be manufactured, when and the quantity involved.

MATERIAL RESOURCE 
PLANNING (MRP)

MRP is specialised planning and control software that can help 
to determine the raw material quantities needed and the timing 
of the purchases.  

MULTIDIMENSIONAL MODEL A multidimensional model is similar to a relational model, but 
whereas a relational model stores data in a two-dimensional 
table, a multidimensional model stores data in a three- or more 
dimensional table, creating a cube-like data structure. 

NETWORK MODEL The network model supports many-to-many relationships, that 
is, data may be accessed by following several paths

NONFINANCIAL 
TRANSACTION

A nonfi nancial transaction is a business activity that generates 
or modifi es nonfi nancial data but which is of such a nature that 
it will directly infl uence the processing of fi nancial transactions

OBJECT-ORIENTED MODEL In an object-oriented model, the data and the operations to be 
performed on the data are both stored in the database. This 
database model can furthermore store and process a wider range 
of data types than only text and numerical data – it also stores 
and processes images, audio and video data.
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ONLINE ANALYTICAL 
PROCESSING (OLAP)

Online analytical processing (OLAP) software enables users to 
interactively and rapidly analyse large data sets from various 
viewpoints (ie OLAP can handle multidimensional queries). 

ONLINE INPUT Online input involves data being immediately captured into the 
CIS at the point where the activity occurs.

PARTITIONED DATABASE A partitioned database is split into smaller portions (partitions) 
and the part applicable to the user is made available on the 
location closest to the user.

PERFORMING CALCULATIONS Arithmetical or logical calculations can be performed on data.

PRIMARY DATA FIELD Each fi le has a unique data fi eld (known as the primary data 
fi eld) that can be used to uniquely identify each data record in 
a data fi le.

RAW DATA Data captured on manual documents (hard copy) as well as data 
entered in the CIS and not yet processed is called raw data. 

REAL-TIME PROCESSING Real-time processing is the immediate update of the transaction 
fi les to the master fi les as the transaction occurs.

REFERENCE FILE A reference fi le is a semipermanent fi le containing data 
records referenced to by the transaction fi le in order to complete 
a transaction.

RELATIONAL MODEL In a relational model, data is stored in two-dimensional rows and 
columns (ie tables). 

REPLICATED DATABASE In a replicated database, the whole original database is copied 
to the different locations, that is, the database is replicated at 
each location.

SORTING DATA Data is organised (sorted) in an orderly sequence based on 
specifi c criteria.

SUMMARISING DATA This process condenses the data by extracting only specifi c data 
based on criteria provided by the user.

SYNCHRONISATION OF 
A DATABASE

Synchronisation (also referred to as replication) is more complex 
and time consuming and involves a two-way updating of the 
master database and the distributed databases (ie the master 
database can update the distributed database and the distributed 
database can update the master database).

TRANSACTION FILE A transaction fi le contains data records relating to the daily 
individual activities of the organisation (eg the organisation’s 
sales). A transaction fi le changes regularly as additional 
transactions are processed.

TRANSACTION PROCESSING 
SYSTEM (TPS)

A TPS collects an organisation’s daily business transactions, 
processes them into valuable information and stores and retrieves 
the data and information when required.

TRANSFORMING DATA Data is processed by transforming the format or medium of the 
original data into another format or medium.




